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License Agreement

Banner Blue Software Incorporated is the owner
of this Software. You are granted a license to use
it. By using the Software you accept the terms of
this License Agreement. If you do no accept the
terms you may return the package for a refund.

This Software is protected by United States and
International Copyright Law. It is a Federal crime
to copy or reproduce any part of the Software or
Documentation except for back-up purposes.

This means you must treat the Software like a
book. You may take it with you to another
computer, provided there is NO POSSIBILITY
another person might be using it on another
computer at the same time. You may loan it to
another person, provided YOU do not use it
while it is on loan. Like a book that cannot be
read by two different people in two different
places at the same time, the Software cannot be
used by two different people in two different
places at the same time. There is only one excep-
tion to this rule. You may make two (2) copies of
the Software for the sole purpose of backing-up
the Software to protect your investment from loss
or damage.

In addition, you may not reverse assemble,
reverse compile, translate, or make alterations to
the Software. You cannot transfer or make the
Software available electronically over a
timesharing service, network of computers, or
similar system that provides access to multiple
users. You may not distribute, rent, sub-license,

or lease the Software or Documentation to others.

A separate agreement is available for using the
Software on a network. Contact Banner Blue for
details.

The License and your right to use the Software
automatically terminate if you fail to comply with
any provision of this License Agreement. Upon
termination, all items must be returned to
Banner Blue, or destroyed.

Warranty

Banner Blue warrants that the Software
substantially conforms to the Documentation and
published specifications, provided it is used on
the hardware and software for which it is de-
signed. This warranty is in effect for a period of
one (1) year following the date of purchase.

Banner Blue also warrants that the physical
diskette and Documentation is free from defects
in material and workmanship under normal use
for a period of one (1) year. Banner Blue will
correct substantial Software errors or replace
defective diskettes or Documentation at no
charge. If this is not possible, Banner Blue will
refund the license fee. With respect to the two
warranties above, your exclusive remedy, and
Banner Blue’s entire liability, will be the replace-
ment of the diskette at no charge or refund of the
license fee.

Except as described earlier, Banner Blue makes
no other warranty, express, or implied, with
respect to this Software or Documentation. This
includes, but is not limited to, performance,
merchantability, or fitness for any purpose.
Banner Blue and anyone else involved in the
creation, production, or delivery of this Software
and Documentation will not be liable for any
direct, indirect, incidental, or consequential
damages such as, but not limited to, loss of
anticipated profits or benefits resulting from the
use of the Software or arising out of any breach
of any warranty.

This License Agreement and Warranty will be
governed by the laws of the state of California.
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Chapter 1:

About this program

Fast chart creation

Click the Subordinate
box tool 4 times...

...then click the

Introduction

Thank you for buying Org Plus for Macintosh.

This chapter introduces you to the basic features of Org Plus and
gives a summary of the information in this manual.

Org Plus helps you create professional looking organization charts
quickly and easily. You can create almost any type of tree diagram.
You can also chart virtually any information that you can put into
outline form. Check the Samples folder on your Org Plus Help &
Learning disk.

Click a box tool at the top of the chart window, then click where you
want the boxes. Org Plus automatically draws them, spaces them
evenly, and precisely lays out the connecting lines. See Figure 1-1.

Untitled-1 B——————[T|

T
B |T |;f-‘,_,|5ubordinateICo-worker:E”El |Manager:|E| |Assistant:|E|l
/

/

manager's box
once...

Untitied-1

T ;‘f—a,|5ubordinate:@ ICo—worker: El EI |Manager:|§l-_| |Assistant:E| l

...to create
4 subordinate
boxes

Isize: 100%[3

Figure 1-1. Creating boxes and lines

Chapter 1: Introduction 1




To enter your data, you click in the boxes and type. Org Plus auto-
matically positions the text and grows or shrinks your boxes as you
type — you don’t have to worry about resizing them, as you would
with a general purpose drawing program.

You can also change box borders, apply shadows, and change the
thickness and style of lines with simple menu selections.

Flexible, automatic Rearrange any group of boxes instantly with a single menu selection.
formatting Select the boxes you want to rearrange, then choose a style from the
Styles menu. Any group of boxes can have any style (see Figure 1-2).

( & File Edit Styles Text Bowes Chart Help ]
Choupletiley. T |&]Subordinate:|§] | Co-worker: IEI EI IManager:@ |Assistant:E| | I
¥

] [ |
[ R ]
L]
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Figure 1-2. Arrange boxes however you want
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You can even create your own styles by using the hidden boxes
feature. You have control over virtually every aspect of your chart’s
appearance.
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Fast updating

Compact charts

Make Fit...

Size to Window
50% of Actual
v Actual Size

ent n

Charts are easily updated to keep pace with changing organizations.
You can cut and paste boxes anywhere in your chart. You can also
drag them to any location.

You can easily rearrange the information, too. For example, you can
place name above title when you create your chart, then later decide
you want title above name. Simply reverse the order of the labels in
the Label Setup dialog box (Figure 1-3), and the order is reversed
throughout the entire chart.

JITIT]

You can type additional Apply to: ORIl boxes @ Selected boxes

labels in any dotted area, or [
cut & paste to move them. |

Labels in chart:

Name K> [«Name>
fitle [] <Title>

0|

( #igelabel [ Add Tabel aress & dividers... |<d] 53

( Addiabel ] (Cancel )

Figure 1-3. The Label Setup dialog box

]
]
]

[ { haage isbet

No matter what changes you make, Org Plus automatically preserves
uniform sizing and spacing. Any you always see exactly what the
chart will look like when printed!

Most people want to see as much of an organijzation on one page as
possible. Compact charts are also much easier to copy and distribute.

Org Plus arranges boxes to save as much space as possible. It even
has a special feature, the Make Fit command, that can make your
chart fit on one page in a single operation.

Tell Org Plus how many pages on which to fit your chart and Org
Plus does the rest automatically. And if Org Plus can’t make it fit, it
tells you precisely how much more you need to reduce it to make it
fit. You can then use the reduction feature on the Macintosh (at the
Page Setup dialog box) or on a photocopy machine.
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Custom touches Some charting effects can’t be created automatically, even by Org
Plus. For example, you might want to include your company logo in
the upper corner, or create a special boxed legend, or draw extra
lines to separate different groups within the company. Org Plus
provides a special set of drawing tools so that you can get precisely
the effect you want.

Paste in your -1 A Allen Manutacturing
company's logo
Chief Executive o
Draw lines, ————————— Executive Staff
boxes, and .,..r.:.........] {u..........,....” H ”
type text
anywhbere you Line Manag t
waJ;n X B ] (] ) ==
\ Hamdr ] Hemsm] Hamss] Hame] H=E
e | o] Hoome] osw] Yoass |
]

Figure 1-4. Chart with custom touches
For more information about the special drawing tools, see “Special

effects through manual drawing,” page 153. See also the unique
Picture Index at the back of this manual (page 233).
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What’s in this manual

This manual contains the information you need to create profes-
sional looking organization charts using Org Plus. The following
table presents an overview of the major sections of the manual.
Use it to help you find the information that is most important to

you.

To do this...

Turn to this section...

Find out what this program can do
for you

Find out what you need to do to
start using the program

Learn the basics

Get step-by-step instructions for
each command

Get a brief description of every
menu command, icon, or other
object that you see on the screen

Get answers to a range of ques-
tions such as how to create
professional looking charts, how
to use the keyboard to save time,
and so on

Get definitions for the most
commonly used terms

Look at examples of special effects
that you can create with Org Plus

Find any particular item of infor-
mation in the manual

About this Program, page 1

Getting Started, page 7

Tutorial, page 21

Using Org Plus, page 73

Reference, page 177

Appendixes A-E,

pages 207-228

Glossary, page 229

Picture Index, page 233

Index, page 239
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Chapter 2:

What you should know

If something goes
wrong

Step 1:

Getting Started

This chapter takes you through the basic steps necessary to start
working with Org Plus.

This manual assumes you're familiar with basic Macintosh techniques
such as selecting, dragging, and double-clicking. If you aren't, please
refer to your Macintosh owner’s manual before continuing.

You'll see the word “application” throughout this manual. You can

think of it as a synonym for “program”.

We want your first experience with Org Plus to be a successful one,
so it’s important that you follow the installation steps on the next page
carefully.

In the event that you run into a problem and can’t figure out what to
do, please call our Technical Support department:

415-794-6850 (ask for Technical Support)

A trained technician will help you.

Installation

This section takes you through the five steps necessary to start
working with Org Plus.

Check the system requirements

The following is the minimum hardware and system software you
must have in order to use Org Plus:

[ | A Macintosh Plus, Macintosh SE, or Macintosh II series com-
puter

Chapter 2: Getting Started 7



Step 2:
Step 3:
About mailing lists

| At least 1 megabyte of RAM

[ A hard disk and at least one 800K floppy disk drive, or at least
two 800K floppy disk drives

[ Macintosh System version 4.1 or later

Your system must meet these minimum requirements in order for Org
Plus to install and operate properly.

Check your package contents

This package should contain:

[ Two Org Plus disks

[ | A registration card

= The Org Plus User's Manual (you’re looking at it now)

If anything is missing, contact your dealer for a replacement package.

Complete and mail your registration card

Please fill out and return the Registration Card now! Registration
entitles you to the following benefits:

| Free telephone support on using Org Plus

[ | Notification of program updates

[ Special discounts on upgrades and other products

[ | Notice of future products and services from Banner Blue

We currently do not provide our mailing list to other companies, and

have no intention of doing so. You can be assured that your name
and address will be kept confidential and used only by Banner Blue.

Chapter 2: Getting Started



Step 4:

With a hard disk

Make a working copy of the program

It is very important that you only use a working copy of the program
in case your disk is lost or damaged. You should never use your
original Org Plus Program disk for day to day use. Store it in a safe
place (Step 5) so that you'll have it to make additional working copies
if needed.

The write-protect tabs on your original Org Plus disks have been
adjusted to protect the documents on them from accidental erasure.
It's a good idea to leave them this way.

About copy protection: For your convenience, the Org Plus Program
disk is NOT copy protected. Your license entitles you to make two

working copies of the Org Plus Program disk for your own use. See
the license agreement inside the front cover for details.

To install Org Plus on a hard disk, copy the documents from both Org

Plus disks into a folder on your hard disk:

1.  Turn on your Macintosh and the hard disk, if necessary.
You should see a window containing the documents and
folders on your hard disk. If not, the hard disk isn’t open:
double-click the hard disk icon (probably in the upper right
corner of the screen) to open it.

2.  Choose New Folder from the File menu.

You should see “Empty folder” in the window.

3. Type Org Plus.

4.  Choose Open from the File menu to open the disk win-
dow.

5. Insert the Org Plus Program disk into the floppy drive.
The Org Plus Program disk window should appear on your

screen. If not, the disk isn’t open: double-click the Org Plus
Program disk icon.

Chapter 2: Getting Started 9
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Org Plus 1.0

With two 800K drives

6. Drag the Org Plus application icon from the Org Plus
Program disk window into the new Org Plus window.

The Org Plus application icon is shown to the left.

This puts a copy of the Org Plus application in the newly
created Org Plus folder.

7.  Drag the Org Plus Program disk over the trash can icon to
eject it.

Don't worry: This doesn't harm the disk in any way.

8. Insert the Org Plus Help & Learning disk into the floppy
drive.

The Org Plus Help & Learning disk window should appear on
your screen. If not, the disk isn’t open: double-click the Org
Plus Help & Learning disk icon to open it.

9. Drag everything from the Org Plus Help & Learning disk
window into the new Org Plus window.

See Figure 2-1 on page 12 for a picture of what should appear
in your new Org Plus window.

10. Drag the Org Plus Help & Learning disk over the trash can
icon to eject it.

You have now installed Org Plus on your hard disk. Skip ahead to
“What's on your disk,” page 12, to continue with the installation.

If you have a Macintosh with at least two 800K floppy disk drives and
no hard disk, you can use two disks to run the program:

| A System disk to start your Macintosh and to store your docu-
ments

[ A disk containing the Org Plus application

You should already have a System disk. Your Macintosh owner’s
manual tells you how to create additional System disks, if necessary.
You may want to create a copy of your System disk with the mini-
mum number of documents on it in order to have as much space as
possible for your Org Plus documents.
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OrgPlus 1.0

To make a working copy of the Org Plus Program disk, copy the
contents from the Program disk onto a separate floppy disk:

1.  Turn on your Macintosh.
2. Insert your System Tools disk into the internal drive.

On a Macintosh with two internal disk drives, you insert the
disk in the topmost or righthand drive.

3. Insert a blank initialized disk into the other floppy drive
and name the disk “Org Plus”.

4. Open the new Org Plus disk.

5. Eject your System Tools disk.

6. Insert the Org Plus Program disk in the internal drive.
The Org Plus Program disk window should appear on your
screen. If not, the disk isn’t open: double-click the Org Plus
Program disk icon to open it.

7. Drag the Org Plus application icon (see the figure to the
left) from the Org Plus Program disk window to the Org
Plus disk window you opened in step 4.

This puts copies of the Org Plus application on the new disk.
The new disk is your working copy.

8. Drag your original Org Plus Program disk icon over the
trash can icon to eject it.

Don't worry: this does not erase the disk or harm it in any way.
It's simply a convenient way to eject disks. You can use the
Eject command from the File menu, but dragging to the trash
clears the disk icon from the desktop and reduces the possibil-
ity of confusion in the steps that follow.

9. Insert your System Tools disk in the internal drive.

10. Click the Org Plus disk window to bring it to the front.

From now on, you should only use your working copy of Org Plus.

Chapter 2: Getting Started 11




If you intend to use the Org Plus on-line help feature, you must put a
copy of the Org Plus Help document on your System disk:

1. Drag your Org Plus disk (your new working copy) over
the trash can to eject it.

28 Insert the Org Plus Help & Learning disk.

3.  Drag the Org Plus Help icon from the Org Plus Help &
Learning disk window over the System Tools disk icon.

4.  Drag the Org Plus Help & Learning disk over the trash can
icon to eject it.

5. Insert your Org Plus disk (your new working copy) so
that you'll be ready to start the application.

You probably won'’t have enough room on your System disk to copy
all the other documents from the Org Plus Help & Learning disk.

What’s on your disk Figure 2-1 shows what you should see when you open the Org Plus
folder on a bard disk:

1B —=——=—=— Org Plus ==——+<70=
7 items 74,729K in disk 4,008K available

i
&

OrgPlus 1.0 Org Plus Readme TeachText

® 0 O O

Org Plus Help Tutorial Samples Stationery

2]

] [0

Figure 2-1. What'’s in your Org Plus folder on a hard disk

On a floppy disk, you'll see only the Org Plus application icon in the
Org Plus window. All the other documents and folders described
below are located on the Org Plus Help & Learning disk.
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Step 5:

That’s all, folks!

Here’s a list of the icons you should see in the window, and the
purpose of each:

Org Plus 1.0 is the application (the program). The number 7.0 is the
version number. It signifies that this is the first release of the pro-
gram. This is the only document you need to run Org Plus, unless
you want to use the Org Plus on-line help feature.

Org Plus Help contains the text used by the Org Plus on-line help
feature. For more information about this feature, see page 14.

Org Plus Readme contains last minute information that couldn’t be
included in the manual. After you complete step 5 below, you should
double-click this icon to see what information it contains.

TeachText is an application that lets you open the Org Plus Readme
document.

Tutorial is a folder containing charts used in the tutorial — Chapter 3
of this manual. You use these charts if you do the tutorial.

Stationery is a folder containing sample stationery charts for organi-
zations of different sizes. Stationery is a special type of chart contain-
ing a basic chart design that you can modify to suit your needs. You
can use any of these stationery charts for your own charts, or create
your own stationery.

Samples is a folder containing sample charts.

If you don't see all these icons on your hard disk, restart your system
and repeat the installation steps.

Store your original disks safely

Store your original Org Plus disks in a safe place. You can use them
to make additional working copies if the one you just made becomes
damaged.

That completes the installation. You’re now ready to start using Org
Plus to create your own organization charts. Take a look at the rest of
this chapter for other sources of help, then decide where to go from
there.
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On-line help

The Help menu

Command-H: instant
help

How to get help

In addition to this manual, you have three sources of help for using
Org Plus:

[ ] Org Plus’s on-line help feature
[ | On-line prompts and messages
[ Banner Blue’s telephone support

On-line help gives you help on the screen for almost anything you
may want to do. It’s like having a manual on the screen.
You can get help in three ways — by making a choice from the Help

menu, by pressing Command-H, or by pressing Command-?.

The Help menu (Figure 2-2) gives you immediate answers to some of
the most commonly asked questions about Org Plus.

r ® File Edit Styles Text Bowxes Chart iiN ]
Tutorial Part 1] Help Topics... %H

S———————
T |Q|Subordimte:|§| ICo—worker:E[—E‘ ]Mana Creating boxes...
Rearranging boxes...

mamans i .| | Spacing boxes...
Sizing boxes...
wriom|  Mobing boxes...

Emcutive

[ I I o
S Vo J e stoms | ENtering text...

Lyn Drewer
Chist Fimncie Officer

Vice Presiden ¥ice Presigan Hearranging te“t."
L

Awtomolive

Dkl aad

ey | Making it fit...

Paul Gtmmerd
Project Manager

s
Cathy Cloud ol Kaming G Van Hutmn
Cash Heneger Project Haneger Pruject Mmneger

Lort Bt. Joan Carvl Henter
Arcouniamt Progrem Henmgwr

Lisade Jong
Flenning

| Custom drawing...

Using stationery...
Time saving ideas...

iﬁe: 50% Kali

Figure 2-2. The Help menu

You can type Command-H (press and hold down the Command key
while you press "H") to view a window with an index of help topics.

You can drag the Help window to the side so you can consult it while
you work.
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Command-?: help
pointer

Helpful prompts and
messages

Customer assistance

You can type Command-? for a help pointer, then choose any menu
command or click any icon for which you want an explanation.

All help text is cross-referenced to the manual so you always know
where to go for more explanation.

Ever get frustrated because a menu command that you needed was
dim and couldn’t be selected? Whenever possible, Org Plus lets you
make the selection, and, if necessary, tells you what you need to do
to make the command work.

Feel free to experiment. Org Plus’s plentiful prompts and messages
often tell you exactly what you need to know in order to do what you
want.

If you have problems that you aren’t able to solve by using the on-
line help feature and by checking the index to this manual, call
Banner Blue Technical Support. Our hours are Monday through
Friday, 8:00 AM to 5:00 PM, Pacific time. Our telephone number is:

415-794-6850 (ask for Technical Support)

We can help you best if you call while you're at your computer.
Please have ready the following:

[ | Your Org Plus User’s Manual

[ ] The product name and version number of the applications
you're using at the same time as Org Plus (e.g., inits, desk
accessories)

= A description of your computer hardware and system software

configuration, including the version numbers of the System and
the Finder
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Thank you All of us at Banner Blue hope that Org Plus will become your favorite
Macintosh application. Please write us to let us know how we can
make it better. Our address is:

Banner Blue
Technical Support
P.O. Box 7865
Fremont, CA 94537

Where to go from here

At this point, you’re ready to start using Org Plus. You can plunge
right in and start making your own chart. If you get stuck, use the
on-line help feature (page 14) or refer back to this manual.

However, we recommend the following:

[ Go through the tutorial (page 21). This introduction to
the program takes you through the basic steps necessary
to create a chart.

[ | Browse through Chapter 5 to get an overview of the Org
Plus menus and dialog boxes.

| Take a quick look at some of the sample charts (in the
Samples folder).

[ | Start making your own chart. If you get stuck, use the on-
line help feature (page 14) or refer to Chapter 4 for step-
by-step instructions.

Happy charting!
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Personalize your copy
of the program

Starting the program

To start Org Plus and begin working on a chart, double-click the Org

Plus application icon in the Org Plus window.

If you're starting Org Plus for the first time, Org Plus displays a dialog

box so that you can personalize your copy of the program
(Figure 2-3).

ORG PLUS &5 l

( cancel ] [ oK ]

Figure 2-3. Enter your name and company’s name
Here’s how to personalize your copy:

1. Type your name and your company’s name. Press the
Tab key to go from one box to the other.

You only have to do this once. In the future, when you start

the program, this dialog box will be displayed momentarily
while the application loads into your computer’s memory.

2. Click OK to continue.

The Org Plus Startup dialog box appears (Figure 2-4 or 2-5).

Chapter 2: Getting Started
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Figure 2-4. The Startup dialog box on bard disk systems

Org Plus

iy Org Plus

3 pen

i

File formats: | Org Plus for Mac v |

Figure 2-5. The Startup dialog box on floppy disk systems

You can create new charts or open existing ones from the Startup
dialog. The tutorial also begins at the Startup dialog (page 21).
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Chapter 3:

Before you start

Learning Org Plus

This tutorial takes you step by step through the process of creating
and updating an organization chart. You'll learn many of the Org
Plus commands and options as you go.

The tutorial is divided into three parts:

u In Part I you'll create the boxes and lines for a mythical com-
pany: Allen Manufacturing.

[ | In Part II you’ll enter some information and finish the chart.

u In Part III you’ll update the chart to show changes in the
organization.

Each part takes about 20 minutes to complete. You can do them in
one sitting, or at different times. When you’ve finished, you’ll be
ready to make your own charts.

This chapter assumes a few things:

& You know basic Macintosh skills — how to click, drag, cut and
paste, and use the menus.

= Org Plus is already installed on your computer.
[ The Org Plus application has been started.

[ You have Geneva 9, 10, and 12 point fonts installed on your
system.

If you don’t know basic Macintosh skills, you might want to review
your Macintosh owner’s manual before continuing.

If you haven'’t installed and started Org Plus, go back and follow the
instructions in Chapter 2.

If you don’t have the indicated Geneva font sizes installed, you might
consider reinstalling them (they should have come with your com-
puter when you purchased it). See your Macintosh owner’s manual
for instructions. If you don’t install them, the figures in the tutorial

Learning Org Plus 21



Creating a new chart

will vary from what you see on your screen, but you'll be able to get
through the tutorial.

Part I: Creating a chart

In this part of the tutorial you'll create the chart shown in Figure 3-1.
You'll learn how to:

[ Create and delete boxes and lines
| Change the way boxes are arranged
[ ] See the entire chart in the window

—

I |

1|
L
-

U B [

UL

§
il

Figure 3-1. What you'll create in Part I

If you have just completed the installation and started the application
(as described on page 17), your computer screen should show the
Startup dialog box, shown in Figure 3-2 on page 23.

If not, start the application. (See “Starting the program,” page 17.)

If the application is already started but you don't see the Startup
dialog box (Figure 3-2), quit the application and restart, according to



the instructions in “Starting the program,” page 17. To quit the
application, choose Quit from the File menu.

. [ Samples {3+ @ My hard disk
bese;;?lder;wzll [ [0 Stationery
not appear i you [ Tutorial —
are working on a
floppy disk
[__Open ]
8
File formats: Ll]rg Plus for Mac v|
Figure 3-2. The Startup dialog box on a bard disk system
When you see the Startup dialog box (Figure 3-2) you’re ready to
begin:
1. Click the New button in the Startup dialog box, as shown
in the figure to the left.
Open The New Chart dialog box appears (Figure 3-3).

Cancel

What do you want in each box? (click one)

ok
i
o

Name Title
Oth
Title Name R

Cancel

Figure 3-3. The New Chart dialog box
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<Title>

Chris Phillips
President & CEOQ

24 Learning Org Plus

This dialog box lets you choose one of two different layouts
(Name above Title, or Title above Name). You can select the
third choice to create your own layout.

In this part of the tutorial, you'll use the first layout. You’ll
change it in Part II.

Click the OK button.
The dialog box goes away and you're ready to start typing.

The single box you see is the topmost box. All other boxes in
the chart are subordinate to this box.

As you do the next step, watch the screen. You can press the
Delete key to back up on a line and correct mistakes. The
Delete key is located a couple rows above the Return key. On
some keyboards it is called the Backspace key.

Type Chris Phillips.

As you can see, the box grows automatically to accommodate
the text as you type.

In general, you don’t have to worry about changing the size of
boxes. Org Plus takes care of it for you automatically.

Press Tab to highlight the next item — Title.

You can also press Return.

Type President & CEO.

The topmost box should now appear as shown in the figure to
the left. If not, use the Tab and Delete keys to move between
the two text values and make corrections.

You've now finished entering information in the topmost box. You
enter information in other boxes in the same way. You'll enter a little
more information in Part II of the tutorial.




Creating boxes In this section you'll see how to create all the boxes that you need for
the chart.

5 When you create your own chart: Although you can enter information
for each box as you create it, you might find it easier to create the
boxes first, then enter information later. That's what you’ll do in this
part of the tutorial.

Creating the assistant First, you'll create the box for the President’s assistant:

box
1. Click the Assistant box tool once, as shown in Figure 3-4.

(& File Edit Styles Text Bowes Chart Help )
Untitled-1

[Em———— =
k |T |¢-Z—.s|8ubordi nate:@lto—worker: E] E] IManaqer:E] IAssistant@‘
7~

The Assistant box tool

Chrig Phillips
President & CEO

Freate: 1

Figure 3-4. Clicking the Assistant box tool
2.  Click the President’s box.

The assistant is an assistant fo the President, so you click the
President’s box.

If your chart doesn’t look like the one in Figure 3-5 on page 26,
choose Undo from the Edit menu and repeat steps 1 and 2.
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(& File Edit Styles Test Boxes Chart Help ]

EI=————— ntited- =&=F———— N5

k lT |.;:3|Subordinate:|§| |Co—worker: E] @ |Manager:E| I Assistant: |

Chris Phillips
President & CEDE

ISize: 100% Ko

Figure 3-5. After creating the assistant

As you can see, Org Plus draws the assistant box and the
connecting lines automatically.

[ Key concept: Each box is attached to another box. When you
create a box, you have to click the box to which you want it
attached.

Creating other boxes In addition to his assistant, the President has an executive staff of four

people — called subordinates. You'll create their boxes next.

1. Click the Subordinate box tool once, as shown in
Figure 3-6.

2. Click the President’s box.

Your chart should appear as shown in Figure 3-7. If not,
choose Undo from the Edit menu and repeat steps 1 and 2.

Next, you'll create the other three executive staff boxes.
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The Subordinate box tool

[ € File Edit Styles Teut Boxes Chart Help

EN=——————— uUntitled-| ===}
h T I&%,]Subordi nate lCo-worker: EI E] IManager:@ IAssistant:El [ I

Chris Phillips
President & CEDE

! Size: 100% Ka

Figure 3-6. Clicking the Subordinate box tool

r & File Edit Styles Text Boxes Chart Help

[V lntitled-| 00—
|&|Subordlnate IE] Ito worker: IEHEI |Manager lAsswtant

llml
I

Chris Phillips
President & CEDEl

Size: 100% KAl

Figure 3-7. After creating the first subordinate
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The Co-worker After
box tool

Status area shows

28 Learning Org Plus

3. Click the second Co-worker box tool three (3) times, as
shown Figure 3-8.

If you click too many times, click the Selection Arrow tool in
the upper left corner of the window, then repeat step 3.

r & File Edit Styles Text Boxes Chart Help ]
e Untitled-1 =S ==—==x"—-""S T8

k [T |,§é|8ubord1nate E‘ ICo worker: @E|Manager E] IAssvstant E] I

bow mamny boxes
you will create \ \

Chris Phillips
President & CEDm

ICreate

Figure 3-8. Clicking the Co-worker After box tool

There are two Co-worker box tools: the Co-worker Before box
tool, and the Co-worker After box tool. The Co-worker Before
box tool creates a co-worker box to the left or above an
existing box in the chart. The Co-worker After box tool creates
a co-worker box to the right or below an existing box in the
chart.

4.  Click the highlighted box.

Your chart should appear as shown in Figure 3-9. If it doesn’t,
choose Undo from the Edit menu and repeat steps 3 and 4.



r ® File Edit Styles Text Boxes Chart Help

SF=—————————— Untitled-1 %E}EI
h T I&ISubordinate:@ ICo—worker: E] El lManager: IEI I Assistant: | I

Chris Phillips
President & [ZEDm

isize: 100% Ko

Figure 3-9. After creating the other three subordinate boxes

The highlight moves to the first of the newly created boxes.

Each of the four executive staffers also have subordinates.
You'll create their boxes next.

5. Click the Subordinate box tool five (5) times.

If you click too many times, click the Selection Arrow tool in
the upper left corner of the window, then repeat step 5.

6. Click the left-most subordinate’s box, as shown in the
figure to the left.

Your chart should appear as shown in Figure 3-10. If it doesn't,
I choose Undo from the Edit menu and repeat steps 5 and 6.
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File Edit Styles Text Boxes Chart Help

| Em

)

" ltitled" | Y—————=—o"=
R‘ ‘T Ia—EaISubordinate:IE] ]Co-worker: E' @ IManager:El |Assistant:E} | 1
T

Wsize:
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Figure 3-10. Chart no longer fits in window

The chart is now larger than the window. You can reduce the
chart so that it fits in the window.

Choose Size to Window from the Chart menu.

This command makes your chart fit in the window, but doesn’t
change the actual size of the chart. When you print your chart,
it will appear at full size.

Your chart should appear as shown in Figure 3-11. If you
created fewer than 5 boxes, click the Subordinate box tool once
for each additional box you need, then click the manager’s box
to add the additional subordinate boxes.

Notice that the new boxes — called a group — are arranged
horizontally. You can arrange groups in 20 different ways,
called group styles.

Charts get very wide if all the groups are arranged horizontally.
In the example, the chart is a little too large to fit on one page.
The page border line in Figure 3-11 shows that the chart spans
two separate, side-by-side pages. The status area shows that
you’re seeing the chart at 30% of its actual size.



r ® File Edit Styles Text Boxes Chart Help
H = — Untitled-l

k T O\ Subordinate:@ Co—worker:EIEl Manager:@ Assistant:El

Margins <~<

Page border

Percent of actual size

Figure 3-11. Viewing the entire chart

Changing group styles In this section you'll learn how to change group styles. You'll also
learn how to create a group with the style of your choice.

You'll start by changing the newly created group’s style so that the
boxes are arranged vertically instead of horizontally.

1. Double-click any of the bottommost boxes, as shown in

1) the figure to the left.
[ ]
O This should highlight — that is, select — the entire group of
. 7 - five boxes. If it doesn’t, click any box once and then press and
e T * s hold the Command key while you type G, for “Group”.

< About double-clicking: Some people find double-clicking very
tricky. If double-clicking doesn’t work well for you, use the
Command-G keystroke combination (described in the previous
paragraph) to select groups of boxes.
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5 Choose a single column group style from the Styles menu,
Group stules: as shown in the figure to the left.

=i
5
E

i

The precise number of boxes in each little square of
the Styles menu doesn’t matter. They are shown only
to illustrate the basic style.

Your chart should appear as shown in Figure 3-12. If it doesn't,
choose Undo from the Edit menu and repeat steps 1 and 2.

oo |8 0B o8 o2

Assistant styles:

=F=
e

(& File Edit Styles Test Bowes Chart Help ]
HLI=———————Untitled | —=———=————"1I¢

1)@ = |l 8| |

0 |-t m%mjm%

4 [

Co- manager style: %

Figure 3-12. After changing the group style

Your chart once again fits on a single page.
You never have to worry about adding or deleting pages. Org
Plus automatically creates only as many pages as necessary to

contain your chart.

Now you'll create the next group, but you’ll choose a group
style before creating the boxes in the chart.

3. Click the Subordinate box tool seven (7) times.
If you click too many times, click the Selection Arrow tool in

the top left corner of the window, then click the Subordinate
box tool again.
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4. Choose a two column group style, as shown in the figure
to the left.

5. Click the box of the second subordinate to the President,
as shown in the figure to the left.

Your chart should appear as shown in Figure 3-13. If it doesn't,
choose Undo from the Edit menu and repeat steps 3 through 5.

( & File Edit Styles Teut Bowes Chart Help )

Co-worker:lE”E] Man @ Assistant:El

Figure 3-13. After creating another group in a different style
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Deleting boxes This section shows you how to delete unwanted boxes. In this
example, you'll delete two boxes.

1. Click the first subordinate box of the first executive staff
box, as shown in the figure to the left.

2. Press and hold the Shift key while you click the second
box, as shown in the second figure on the left.

J |
[ h_1
This selection technique is called Shift-clicking. You can
] M
1 ] Shift-click to select boxes scattered throughout your chart.

3. Press the Delete key.

-

The Delete key is located a couple rows above the Return key.
On some keyboards it is called the Backspace key.

| ! | Your chart should appear as shown in Figure 3-14. If it doesn't,
choose Undo from the Edit menu and repeat steps 1 through 3.

r ® File Edit Styles Text Boxes Chart Help }

Figure 3-14. After deleting the two boxes
Notice that when the box is deleted, Org Plus redraws the

group so that there isn’t a gap left where the deleted boxes
were located.
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Finishing the chart In this part of the tutorial, you've learned the commands and
techniques necessary to create a basic chart design:

Create boxes by clicking once or multiple times on a box tool,
then clicking on the box in the chart to which you want to
attach the new box or boxes.

Change group styles by selecting the group, then choosing a
group style from the Styles menu. To select a group, double-
click any box in the group, or click any box in the group and
press Command-G.

Delete boxes by clicking on the box or boxes you want to
delete, then pressing the Delete key.

Use the skills you learned in this part of the tutorial to
finish the chart, as shown in Figure 3-15.

r & File Edit Styles Text Boxes Chart Help

I8

Untitled-1

Figure 3-15. The finished chart
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End of Part I You've now completed the first part of this tutorial.
To get ready for Part II, do the following:
1. Choose Close from the File menu.

Org Plus asks you if you want to save your chart, as shown in
Figure 3-16.

2.  Click the No button, as shown in Figure 3-16.

Save changes to "Untitled-1"7?

[ ves |
S

Figure 3-16. Close your chart without saving it

You don’t need to save what you've done in order to do the
next part.

If you want to quit now and do Part II later, you can choose
Quit from the File menu. If not, keep reading.
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Part II: Completing a chart

In this part of the tutorial youwll complete the chart for Allen Manufac-
turing (Figure 3-17). You'll learn:

How to change box shadows

How to show different information in different boxes

How to draw dividing lines inside boxes

How to change type styles

How to enter information

Allen Manufacturing

(= L, -
Emx riive S rubary
[ | | 1
Lags Brever Bacxd Smdwriing Larmy S Tim srmrm
Chisf’ Mmacisl (HT o Vs P reriderd Vi P reriient Chin' D rHorm O Ticer
— BT — Li—
L ‘ﬁ L L]
Crihy Clamd Zor Kanime & VanHrten _l o Land rminy (= Bl ] I
Coxl Marwger P ru) st Mermpr Praj st Marwpr P rugr m Maregar P
Larl . s Curwl Hater Pul Szsmrd Fearly Allan urwm Derlin
Aot P regrs m Maregar Praject Moy i riclan Hormen Becnroes
Lm im g Dwwie Hen Hxp Pax Jam 0%npio
Plrwing Pru)act Marmgr Bl ricln P rciectin
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Arsxh Awt
P rega n Mareger

Figure 3-17. What you'll create in Part I
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Getting started If Org Plus isn’t started, start it now. Click the Cancel button in the
dialog box that appears, and continue with step 1 below.

You'll start with a chart in your Org Plus Tutorial folder.
1. Choose Open from the File menu.

The Open dialog box appears, as shown in Figure 3-18.

Open chart

<My hard disk
[ Stationery _
0 Tutorial tjecd

fiipa

5 (Cancel )

File Formats: | Org Plus for Mac |

Figure 3-18. The Open dialog box
If you are working with a two floppy drive system: Eject the
System disk and insert the Org Plus Help & Learning disk.
(Your Macintosh will prompt you to put the System disk back in
the disk drive at the appropriate time later in the tutorial.)

2.  Double-click the Tutorial folder to open it.

The Open dialog box should now appear as shown in
Figure 3-19.
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Open chart

O Tutorial Part 11 {+| =My hard disk
O Tutorial Part 111

[_Open ]
5]

File Formats: | Org Plus for Mac |

Figure 3-19. After opening the Tutorial folder
3. Click the Open button to open the chart “Tutorial-Part I1”.
You'll see a chart like the one you started in Part I, with the

names and titles for all the individuals in the company filled in
(Figure 3-20).

[ % File Edit Styles Texut Boues Chart Help
S[=———— Tutorial Part ||

Figure 3-20. Allen Manufacturing with names and titles
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Changing box styles As it appears, the chart is very plain. To make it more interesting,
start by emphasizing the boxes of the President and his executive
staff:

% File Edit 1.  Click the Reduce/Enlarge tool in the upper left area of the
— window, as shown in the figure to the left.

You use the Reduce/Enlarge tool to magnify the chart when it is |
shown reduced, or to reduce it when it is shown at actual size —
the size it will appear when printed..

Subordin.

2. Click the President’s box to magnify it.

The President’s box should be clearly visible, as shown in
Figure 3-22.

r € File Edit Styles Text Boxes Chart Help

S(I=————— Tutorial Part | =="rcF————
h T I&'Subordinate:@ IDo-worker: E, |E] lManager:E' |Assistant:E| l I

>
Chris Phillips
President & CEO
Corinne Speer
Executive Secretary
l |
Becci Seuberling Larry Stevens
cery Yice President Vice President C

Figure 3-22. Magnifying the President’s box

Now you'll apply a box shadow to the President and his
executive staff.

is Phillips 3. Click the President’s box to select it.

sident
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While you hold the Shift key, double-click Becci
Seuberling’s box.

If you have trouble double-clicking, then click Becci’s box once
and press Command-G. Either technique selects all the execu-

tive staff boxes.

Your chart should appear as shown in Figure 3-23.

[ &

File Edit Styles Text Boxes Chart Help ]

Tutorial Part Il =—"—————-VI

I&ISubordinete:@ I Co-worker: EI EI |Manager:|E| IAssistant:El |

Corinne Speer
Executive Secretary

euberling Larry Stevens
Fresident e Yice President

Box Border » !
- — None I I
Line Thickness p i
Line Style » ] [—-I
Hide Position
Hide Branch |_| [_l
Spacing...

=

v Auto Width
v Auto Height
Manual Size...

Figure 3-23. Selecting the President and bis subordinates

Pull down the Boxes menu and highlight the Box Shadow
command, as shown in the figure to the left.

The Box Shadow submenu appears.

While you continue to press the mouse button, drag the
pointer to the right until it appears in the Box Shadow
submenu.

This is how you choose a command from a submenu.
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Drag the arrow over the third style down on the right, as
shown in the figure to the left.

Release the mouse button.

Making choices from submenus is tricky. You may need to
practice this a few times.

Click in the white area of the chart to better see the effect
of your selection.

Your chart should appear as shown in Figure 3-24. If it doesn't,
repeat steps 3 through 8 above.

f % File Edit Styles Text Boxes Chart Help

E=————— Tutorial Part I =——————TD1
T ]&&ISubordinate:E] |Co-worker: Ey—] [E] |Manager:|_£] | Assistant:@ I
Chris Phillips
President & CEO
| | Corinne Speer
Executive Secretary
[ I
Becci Seuberling Larry Stevens
ery Vice President Vice President
1 [
ISize:

Figure 3-24. After adding box shadows

You can change the box shadow or border of any box in your
chart (take a look at the Box Border submenu, located above
the Box Shadow command). You can also change the thick-
ness and style of connecting lines.

Box borders and shadows can give your chart a more profes-
sional appearance.



Changing the label

setup for selected
boxes

<Name>

<Title>

<Name>

<Title>

<Department>

Adding a label to the
setup

The labels for the information you enter into the boxes in your chart,
and the way they are arranged, is called the label setup. The label
setup is like a blueprint for the information you want in each box.

The label setup for the Allen Manufacturing chart is shown to the left.
Name appears above Title. You can have different label setups for
different boxes in your chart.

In this section you’ll add a label called “Department” to the label
setup of the President’s executive staff, as shown in the figure to the
left. This will allow you to enter department names into their boxes
in the chart. You'll also make the Department label bold and draw a
line above it to give it emphasis.

A key concept: You can change the contents and appearance of the
information in your chart by changing the label setup.

You can change the label setup at the Label Setup dialog box. You
start by selecting the boxes whose setup you want to change.
1.  Double-click Becci Seuberling’s box.
Or, click Becci’s box once, and then press Command-G.
Either technique selects all the executive staff boxes.
2.  Choose Label Setup from the Edit menu.

Org Plus displays the label setup for the selected boxes, as
shown in Figure 3-25.
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Figure 3-25. The Label Setup dialog box

The dotted rectangular areas are called label areas. The
blinking insertion point is in the Name label area.

Don’t worry about all the other things you see in this dialog
box.

Press Tab.
This moves the blinking insertion point to the Title label area.

Click the Add Label button, located in the bottom center of
the dialog box.

When you click this button, Org Plus creates a label area in
which you can type the new label (see figure to the left).

Type Department.

Don't type angle brackets. Org Plus adds those automatically
later.

Next you’ll add a dividing line above the department.

Position the pointer over the check box labelled “Add
label areas and dividers” (see Figure 3-25).



7o Click the check box.
This is how you select a check box item.
Org Plus displays additional buttons in the scroll bars (see
Figure 3-26). You'll use a button in the vertical scroll bar to
create a dividing line.
E] Label Setup
Tabels1nany dattedares,or  APPIY to: O All howes @ Selected boxes
L. cut & paste to move them. r e
Divider buttons R L %
| <Name>
<Title>
<Department>
Label area = :
e . ( Snaw jabel )
( tnangetsbet | [ Addlabel | (Cancel ] -
Figure 3-26. After displaying label area and divider buttons
8.  Click the second divider icon, as shown in the figure to
the left.
Look carefully. Org Plus has created a dividing line above the
Department label.
Now give Department a bold font style.
<Name> 9.  Click the Department label.

<Title>

Learning Org Plus

45



10. Pull down the Text menu, and choose Bold from the Style
submenu, as shown in the figure to the left.

Style

Choose this command the same way you chose a box shadow:

dPlain

........................................... Bold
6 point Iiatic pull down the Text menu, position the arrow over the Style
9 Underline command, and drag from the left into the submenu on the right.
10 Duiline

vi2 Shadomw
14 11. Click the Apply button to apply the new setup to the
18 executives’ boxes.
Other.
Left 12. Click the close box in the upper left corner of the Label
Right Setup dialog box (see Figure 3-25 on page 44).

v Center
Name b Your chart should appear as shown in Figure 3-27. If it
Wrap doesn’t, choose Undo from the Edit menu and repeat steps 2

through 12.

r & File Edit Styles Texwt Boxes Chart Help
Tutorial Part 11

T é%-é,lSut«:»rch'nate:|E| ICo-worker: E] El |Manager:El |Assistant:@ l I

=
[

Chris Phillips

President & CED

Corinne Speer
Executive Secretary

Figure 3-27. What your chart should look like

Notice that there is now room for you to type in department
names.
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Entering information This section shows you how to enter the department names.

1. Click below the words Vice President in Becci Seuberling’s
box.

You'll see the Department label you just created.

2. Type Aerospace.

Becci Seuberling Becci’s box should appear as shown in the figure to the left.
Vice President
Aerospace

Notice that “Aerospace” appears bold. That’s because you
made the Department label bold in the Label Setup dialog box.

You could enter department names for the other executives.
Click a box to select it, then click a second time to enter
information. However, there’s no need to do that now.

Annotating the chart You're almost finished. All you have to do is give the chart a title.

First, you need to move to the top center of the chart.

1.  Click the up arrow in the top right corner of the window
until the scroll box moves to the top of the scroll bar, as
shown in the figure to the left.

Next, you’ll make the top title area visible.

2.  Choose Show Page Lines from the Chart menu.

Your chart should appear as shown in Figure 3-28.
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EN=———— Tutorial Part I =—+—————"=|
hl&ISubordlnate @ [Co worker: E“El [Manager E”Asswtant Ell I

Top center title area —|

Chris Phillips
Presidertt & CEO

Corinne Speer
Executive Secretary

[

Becci Seuberlmg

[

Larry Stevens

Figure 3-28. Showing page lines

3. Click in the title area at the top of the window (see Figure
3-28).

4. Choose Bold from the Style submenu, located in the Text
menu.

5. Choose 18 from the Text menu.
6. Type Allen Manufacturing.
7. Choose Hide Page Lines from the Chart menu.

Your chart should appear as shown in Figure 3-29. If not,
choose Undo from the Edit menu and repeat steps 3 through 7.
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T |,;Z-&|Subordinate:|§| ll:o-worker: E] @ IManaqer:El lAssistant:IE] | I

Allen Manufacturing

Chris Phillips
President & CED

Corinne Speer
Executive Secretary

I

Figure 3-29. Creating a title

Org Plus automatically centers the title above your chart.

If you wanted, you could type additional information in other
title areas, as well as on the background of the chart. See

“Annotating your chart,” page 161, for more information when
you have finished the tutorial.
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End of Part I
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In this part of the tutorial, you've learned several commands and
techniques for changing the appearance of text and boxes in your

chart:

Change box shadows by selecting the boxes you want to
change, then choosing a shadow from the Box Shadow sub-
menu. You can also change box borders, line thickness, and
line styles by making choices from the appropriate menus in the
Boxes menu.

Change the label setup by selecting the boxes whose setup you
want to change, then choosing Label Setup from the Edit menu.

At the Label Setup dialog box, you can create new labels,
rearrange them, change their appearance, create dividing lines,
and much more. Whatever you do to the labels in the Label
Setup dialog box, Org Plus does to the information in the boxes
of your chart.

Title your chart by showing the chart’s page lines and entering
the titles into the title areas.

To get ready for Part III, do the following:

1.

Choose Close from the File menu.
Org Plus asks you if you want to save the chart.
Click the No button.

You don’t need to save what you've done so far in order to do
the next part.

If you want to quit now and do Part III later, you can choose
Quit from the File menu. If not, keep reading.



Part III: Updating a chart

In this part of the tutorial you'll update the chart to reflect changes in
Allen Manufacturing’s organization. You'll learn:

[ How to move boxes by dragging

| How to move boxes by cutting and pasting
| How to create special groupings called subgroups
[ How to make the chart fit on one page

Allen Manufacturing

Cortrwm 3
Exx riive S ety
l__Jﬁ ]
[ i =
Laps Brever Tira isrmrm B! San bt Ly Syves Mol A
Chinf' Mmacidl DV N Dyl o V1o Prerilerd Vim Prarierd Vi Prawident
Momcs » Mumcs a - p—n M Ashemitre Blactrion a
CrfyCmd Orid Mawrwn Sext Barvies i L riey
Cush Marwger Pttt Prujact Marwpr P ragrs n Marmgar
Lart 3. Jur wrmm Derelin & VenHrtan O G rion
Aoourtet Hermen Becuroo Pyt Marwpr Pruj s My
Um indang Jam 0 Carwl Hutar Brersh Part
Farwing Prod sction P regryn Mareger Pragran Mermgr
FMirian L Pl Sxamrd
Piwrwing P ru st Marw—r

Figure 3-30. What you'll create in Part III
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Getting started

Learning Org Plus

If Org Plus isn’t started, start it now. Click the Cancel button in the
dialog box that appears, and continue with step 1 below.

You'll start with a chart in your Org Plus Tutorial folder.
1. Choose Open from the File menu.

If you bave just started the application, the Open dialog box
appears as shown in Figure 3-31.

Dpen chart

o Samples {¢| ©= My hard disk
O Stationery _
0 Tutorial tjed

firtpe

5| (Cancel )

File Formats: | Org Plus for Mac |

Figure 3-31. If you just started the application
Double-click the Tutorial folder to open it.

If you are continuing directly from Part II, the Open dialog box
should now appear as shown in Figure 3-32.



Open chart

= Tutorial

O Tutorial Part 11
0O Tutorial Part 111

{r| = My hard disk

£iacl

fHive

5] (Cancel ]

File Formats: | Org Plus for Mac |

Figure 3-32. If you are continuing from Part II

If you are working with a two floppy drive system: Eject the
System disk and insert the Org Plus Help & Learning disk, then

double-click the Tutorial folder to open it.

Open the chart “Tutorial - Part III”.

You see a chart like the one that you created in Part II

(Figure 3-33).
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Moving boxes

54 Learning Org Plus

(& File Edit Styles Text Boxes Chart Help ]
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Chris Pillips
Presicani & CED
Carinm Gpaer
Ewxacutive Gecrelary

[ I T 1
Lunn Drewer Dacsl Sauberling Larmy Gtevens Tim Homurs

row
Chiaf Fimncie Officer ¥ice Prasidant ¥ice Presigan Chisr Opsretlom Officer
iy Aatomolive & Oporulives o

ki

.
Cathy Cloud ] I Scot Kamine G. van Hutesn atm Finersn

Je1 Lvineky |

Cach Neneger Project Menager Pruject Heneger Program Maneger Fellitine
Lort Bt. Jean Carol Helter Paul Gtenmrd Monty Allen Jamps Camdlin
Arcoumamt Prugram Meneger Pruject Menmger Elaciriclan Hurman Remourcas
Hugn Paz

Lissde Jong | |

Dabtis Hell
Flenning

Jena D Angelo
Elacirician Proguction

Elacirician

Dmn Gardan
Project Menager
Dramds Plant

Program Hmeger

.Size:

50% Ko

Figure 3-33. Allen Manufacturing

In this section, you'll make several changes to the Allen Manufacturing

chart:

Move one of the subordinates up to the level of the executive
staff.

Move other boxes to become subordinates of Monty.

Change the left-to-right order of the executives.

First you'll create a new division, Electrical, with Monty Allen as its

head.

1.

Position the arrow pointer over Monty Allen’s box.
Monty’s box is shown highlighted in Figure 3-34.

Press and hold the mouse button while you drag Monty’s
box over the right half of Tina Nomura’s box. Don’t
release the button until you see a right pointing arrow, as
shown in Figure 3-34.



Right pointing
arrow

Tina’s box

Monty’s box

LTy Gtevens . TimHomure [
¥ice Praridaml Ehiaf Opareiiaom 0P
Awtomolive . % al
| | detr Lovineky Y Catm Fineran
Prugram Henager Feclliting
Jamem Candlin
Human Rempurcae
Herk paine | 27 SRR
Elaciriclan
| | panGarmn L fiftam Lae
Project Meneger mning
Drarda Planl
Frugram Meneger

Figure 3-34. Dragging Mownty's box over Tina's box

The right arrow signifies that Monty’s box will be placed to the
right of Tina’s.

Monty and his subordinate should now appear next to Tina and
her subordinates, as shown in Figure 3-35. If not, choose Undo
from the Edit menu and repeat steps 1 and 2.
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Cathy Cloud Suot Kamine G ¥un Hulean Jeff Levineky Catir Fineran
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Lort Bt. Jean Carvl Helter Paul Gtenmard Dmn Gordan James Camdiin
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.Size:

50% Ka|

Figure 3-35. After moving Monty
Now you need to move two other employees into Monty’s
organization: Debbie Hall and Hugo Paz. Both currently report
to Becci Seuberling.
You could move them one at a time, as you moved Monty. But
you can move them both at the same time by cutting and
pasting.
Click Hugo’s box (see Figure 3-36).

Press and hold the Shift key while you click Debbie’s box,
immediately to Hugo’s right.

Their boxes are now both highlighted, as shown in Figure 3-36.
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Lunn Drewer Dactl Ssuerling LaTy Btevene Tim Homura Monty Allan
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Cathy Cloud Scol Kaming
Caeh Hensger Project Heneger

Merk Paine
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Hugo’s box
Debbie’s box

Figure 3-36. Hugo and Debbies’ boxes selected
5. Choose Cut from the Edit menu.

Org Plus puts Hugo and Debbies’ boxes on the Clipboard.
(The Clipboard is a temporary storage place in your Macintosh.)

6.  Click Monty’s box.
7. Choose Paste from the Edit menu.

Boxes on the Clipboard are pasted as subordinates to the
selected box — Monty’s box, in this case.

Figure 3-37 shows what your chart should look like. If not, you
may need to start Part III over again. Take care to follow the
instructions exactly as written here. To start over again, choose
Close from the File menu. Click No when Org Plus asks if you
want to save the chart, then start with step 1 on page 52.
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Figure 3-37. After pasting Hugo and Debbie

Changing the label Monty still has his old label setup — Name above Title. In this
setup section you'll use a special copy command to give him the same label
setup as the other executives.

1. Click Tina Nomura’s box, shown highlighted in
Figure 3-38.

2. Choose Copy Setup from the Edit menu, as shown in
Figure 3-38.
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Entering information

Teut Boxes Chart Help
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Figure 3-38. Copying the label setup from Tina’s box

Tina’s label setup — the way her information is arranged,
including the dividing line — is placed on the Clipboard.

3. Click Monty’s box.
4.  Choose Paste Setup from the Edit menu.

Tina’s label setup is pasted onto Monty’s box, giving him the
same setup.

To enter Monty’s new title and department name, follow the steps in
this section. This section doesn't teach anything new, however. If
you'd like to skip ahead, continue with “Creating subgroups” on page

61.

Monty’s box is really too small to see all his information, so you’ll
make it larger:

1. Click the Reduce/Enlarge tool in the upper left corner of
the window, as shown in the figure to the left.

2. Click Monty’s box.

You'll see Monty’s box the size it will appear when printed.
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3. Press Return to edit the information in the box.
4.  Press Tab to highlight his title.
5. Type Vice President.

6.  Press Tab to highlight his department.

Monty Allen 2o Type Electrical.

Yice President
Electrical

Monty’s box should appear as shown in the figure to the left.

- 8. Choose 50% of Actual from the Chart menu.

Click the left arrow in the horizontal scroll bar, as shown
in the figure to the left, three (3) times.

Your chart should appear as shown in Figure 3-39.
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Figure 3-39. After updating Monty’s information
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Creating subgroups

Left pointing arrow

The President of Allen Manufacturing likes to distinguish between the
chief officers and the vice presidents. There are now two chief

officers and three vice presidents.

In this section you’ll move the chief officers next to each other and

give them a separate group style.

1.

Drag Tina’s box over the left half of Becci’s box. Don’t
release the mouse button until Becci’s box is highlighted
and a left pointing arrow appears, as shown in

Figure 3-40.

o DAzl Sauberling |

I

Lamy Btevene Tim Homura ;
‘,_ ¥ice Faridanl ¥ice Praridam Chiaf Opareiiom OFFicer :
| Awumpwcw Awtomolive e i
Seol Kamine G. van:Hulmn Jeff Lewineky | | ©atm Fineran
Priject Menmger Project:Mmeger Program Menager Feallitine
G‘:_I'tﬂ Helter Pawl B:mnmrd Dmn Gardan | | Jemes Camdiin
Frogoam Meneger Pruject:Meneger Pruject Menager Human Rmpuras
% Bramda Plam || umepangeio
] Frugram Menager Froduction
2 Hiriam Lap
i Flanning

Figure 3-40. Dragging Tina’s box over Becci’s box

Tina’s box should be to the left of Becci’s, as shown in Figure

3-41. If not, choose Undo from the Edit menu and repeat

step 1.
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Figure 3-41. After dragging Tina’s box

2. Press and hold the Shift key while you click Lynn’s box,
immediately to Tina’s left.
Group styles: 3.  Choose the first horizontal group style in the Styles menu,
% =fe as shown in the figure to the left.

Lynn and Tina’s boxes should be drawn as shown in
Figure 3-42. If not, choose Undo from the Edit menu and
repeat steps 2 and 3.

ooy | 999 | o}

= | g
2| E
/\L\/

qiiTE
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Figure 3-42. Showing subgroups

The chief officers are put in a special group — called a subgroup —
by themselves. Notice that the vice presidents are now in their own
subgroup also. A subgroup is a natural division of boxes within a
larger group, as in the example.

Making it fit on one In this section you’ll learn some techniques for making your chart fit
page on a single page.

1.  Choose Size to Window from the Chart menu.
You can see the entire chart page area at a glance.
2. Choose Show Page Lines from the Chart menu.

Your chart should appear as shown in Figure 3-43.
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Figure 3-43. A two page chart
As you can see, it’s going to be a challenge to get this chart to

fit on one page. Since it is too wide, youll have to make it
narrower.

Changing group styles Changing the way boxes are arranged can have a significant effect on
the size of your chart.

1.  Double-click one of the boxes immediately below Becci’s
box, in the middle of the chart (see Figure 3-44).

If you have trouble double-clicking, click one of the boxes and
press Command-G.

Your chart should appear as shown in Figure 3-44. »
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Becci’s subordinates

Group styles:
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Figure 3-44. Selecting Becci’s subordinates

Choose the single column group style shown in the figure
to the left.

Your chart should appear as shown in Figure 3-45. If it doesn't,
choose Undo from the Edit menu and repeat steps 1 and 2.
This makes the chart narrower, but you’ll have to do more.

( ® File Edit Styles Text Boxes Chart Help ]
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Figure 3-45. After changing a group style
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Changing the page Since the chart is basically wider than it is tall, another thing you can
orientation do is change the page orientation.

1. Choose Page Setup from the File menu.
The Page Setup dialog box appears (Figure 3-46). The dialog

box you see on your screen may vary in some respects from the
one shown in Figure 3-46, depending on your printer.

LaserlWriter Page Setup 5.2

Paper: @ US Letter (O A4 Letter (O Tabloid
QO us Legal (O BS Letter

Reduce or Printer Effects:
Enlarge: %

[X Font Substitution?

Orientation X Text Smoothing?
Portrait t [ Graphics Smoothing?
L|ﬂ|J [ Faster Bitmap Printing?
Landscape 7

Figure 3-46. The Page Setup dialog box
2.  Click the second (landscape) orientation icon.
3.  Click the OK button.

Your chart should look like Figure 3-47.

( & File Edit Styles Test Bones Chart Help ]
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Using the Make Fit As you can see, it can take a while to get a chart to fit. That's why
command Org Plus has a special Make Fit command.

1. Choose Make Fit from the Chart menu.

The Make Fit dialog box appears (Figure 3-48).

Make Fit

Desired chart size:

Cancel

Pages: 2

Figure 3-48. The Make Fit dialog box
You use this dialog box to select the desired number of pages
for your chart. The two black squares indicates the chart
currently fits on two pages.
2.  Click the top left square.
This sets the desired chart size to one page.

3. Click the Options button.

The Make Fit Options dialog box appears, as shown in Figure
3-49.
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Make Fit Options

(I Names: | §. Last | [ Minimum margins

[0 wrap info: | Name v|

(] Point sizes: [ Bown by ¢ w| [ Cancel ]

Figure 3-49. The Make Fit Options dialog box

Use this dialog box to select options that make your chart
smaller.

Click the check box labelled “Minimum margins,” as
shown in the figure to the left.

This tells Org Plus to use the minimum margins allowable on
your printer if that will make the chart fit.

Click the check box labelled “Point sizes”.
Position your pointer over the “Point sizes” menu bar.
Press and hold the mouse button while you choose Down

by 2, then release the mouse button, as shown in
Figure 3-50.

Make Fit Options
[0 Names: | £, Last v| & Minimum margins
O wrap info: | Name v|
24| P o : Down by 1 Cancel
i h
Down by 3
Upbyl
Up by 2
Upby3

Figure 3-50. Choosing Down by 2




This tells Org Plus to reduce the point size of the text in the
boxes by two available point sizes. For example, 12 point text
will become 9 point (there is a 10 point size in between).

8.  Click the OK button in the Make Fit Options dialog box.
The Make Fit dialog box reappears.

9.  Click the OK button in the Make Fit dialog box.

Org Plus recalculates and redraws the chart. It should look like
Figure 3-51.

(& File Edit Styles Text Boxes Chart Help

Tutorial Part 111

T 0\ Subordinate:@ Co—wurker:@@ Manager Assistant:

Figure 3-51. Allen Manufacturing’s chart on one page

If you do not have Geneva 9, 10, and 12 point fonts installed on
your system, you may get a different result.

As you can see, using smaller point sizes can have a significant
effect on the size of a chart.
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A word about the Make
Fit command

Had Org Plus not been able to make the chart fit on one page, it
would have displayed a message telling you how much more to
reduce the chart to make it fit (Figure 3-52).

Your options have not reduced the chart enough

to make it fit.

However, the chart will fit if you print it on
letter size paper at 7?8 % of its full size.
/

Reduction factor

End of Part III

Learning Org Plus

You can change paper and % size at the Page
Setup for some printers. Or print the chart on
letter paper and reduce/enlarge it on a copy
machine.

( Page Setup | [ TryAgain |

Figure 3-52. Reducing the chart to make it fit

There are two basic ways to make your chart fit in a desired number
of pages. One way is to make your chart smaller by using any or all
of the methods described earlier in this tutorial. Another way is to
reduce the chart image by some percent, as you might on a photo-
copy machine. The Make Fit command helps you do both. See
“Using the Make fit command,” page 139, for more information.

In this part of the tutorial, you've learned several commands and
techniques for updating your chart:

Move boxes and their subordinates by dragging them over the
box you want to move them next to.

Move scattered boxes by cutting them and then pasting them
onto their new manager.

Create subgroups by selecting the boxes in the subgroup, and
then choosing a group style from the Styles menu.

Make the chart fit on one page by changing group styles,
changing the page orientation, and using the Make Fit com-
mand.



What to do next To leave the tutorial charts ready for someone else to use, do the
following:

1.  Choose Close from the File menu.
Org Plus asks you if you want to save the chart.

Don’t save the Allen Manufacturing chart under its current
name. That would make it hard for other people to do this
tutorial.

2. Click No when Org Plus asks if you want to save the chart.

Org Plus has many more commands and capabilities not covered by
the tutorial. Before starting your own chart, you might browse
Chapter 5, “Reference”. It contains a quick overview of the Org Plus
menu commands and dialog boxes. Then create your own chart.
Refer to Chapter 4, “Using Org Plus,” for step by step instructions as
needed.
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Chapter 4: Using Org Plus

This chapter gives you step by step instructions for creating a chart
and giving it exactly the appearance you want. The following table
summarizes the things you can do and the pages where you can turn
for more information:

To find out about... Turn to page...
Creating a new chart 74
Creating and deleting boxes 79
Entering information into your chart 84
Selecting boxes and lines 88
Viewing and moving around 93
Changing the label setup 96
Rearranging boxes in your chart 110
Moving boxes in your chart 115
Changing the distance between boxes 119
Making boxes larger or smaller 123
Changing text, lines, and box styles 127
Making your chart more compact 132
Working with multiple charts 145
Creating special effects through showing and 149
hiding

Creating special effects through manual 153
drawing

Annotating your chart 161
Printing your chart 166
Customizing Org Plus 167
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Creating a new chart

You can create a chart from scratch or open a template chart, called
stationery, and modify it to suit your needs.

Creating a chart from To create a new chart, do the following:
scratch
1. Start the Org Plus application.
See “Starting the program,” page 17, if you need help.

The Startup dialog box appears (Figure 4-1).

3 0rg Plus

[ Samples = My hard disk
O Stationery _
0 Tutorial fipet

frige

I

o __0pen ]
File formats: | Org Plus for Mac w |

Figure 4-1. The Startup dialog box
2.  Click the New button.

The New Chart dialog box appears (Figure 4-2).
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Using a predefined label
setup

What do you want in each box? (click one)

Name
Title

Title
Name

Other

Figure 4-2. The New Chart dialog box.

The information that you enter into each box in your chart must

have a label. Org Plus can create a chart with the predefined
labels Name and Title, or you can create your own labels.

The labels for the information in your chart and the way they
are arranged is called the label setup.

3.  Click the label setup that best suits your needs and click
the OK button.

If you only need to enter names and titles, choose the first or second

label setup in the New Chart dialog box. Org Plus starts your new

chart with a single box, with the label setup you selected (see Figure

4-3 on page 76).
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Creating your own label
setup

r ® File Edit Styles Text Bones Chart Help

[ED=—=——=—=—untitled-1

k | T IO\I Subordinate: @lCo-worker: E“EI|Manager:|E”AssistaM:E”

<Title>

ISize: 100% K3

Figure 4-3. A new chart with a predefined label setup

You can then start entering information. See “Entering information,”
page 84. You can change the label setup later if necessary. See
“Changing the label setup,” page 96 for more information.

If you need to enter more or different information, choose the third
label setup. The New Labels Setup dialog box appears (Figure 4-4).

New Labels Setup

Type the first
label bere...

‘You must type a label for
each item of infor mation
{Employee, Department,
and so forth) you want to
enter in each box in your
chart.

You can change these labels
later by choosing Label
Setup from the Edit menu.

...then click
bere to add
more labels
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@ ( cancel ] [ 0k ]

Figure 4-4. The New Labels Setup dialog box

In this dialog box you can type your own labels for the infor-
mation you want in each box.




Department

To create your own labels, do the following:

1.  Type the label for the first item of information you want
to enter in each box.

The label is automatically centered in the line. You can press
Delete to back up in the line and correct any mistakes.

28 Click the Add Label button and type labels for any addi-
tional information you want to enter in each box.

The figure to the left shows what the box would look like if
you typed “Department” and clicked the Add Label button.

To delete the label, press Delete when there is no text in the
row. To move from one row to another, press the Tab key.

3. Click the OK button.

Org Plus starts your new chart with the labels you created, and
ready for you to start entering your information (see Figure 4-5).
You can change the label setup later if necessary. See “Chang-
ing the label setup,” page 96 for more information.

See Figure 4-5 shows what a new chart with the labels Depart-
ment and Employee would look like.

( & File Edit Styles Teut Boxes Chart Help ]

Ee=—————————=— Untitled-| DDV08————————5

k] T iO\I Subordinate: @ | Co-worker: E E] | Manager: IE] ] Assistant: @|

Department
<Employee>

.Size: 100% Ka[f

Figure 4-5. A new chart with labels Department and Employee
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Using stationery to

create a chart

Using Org Plus

Stationery is a template for a chart. It's like a pad of preprinted
charts with empty boxes. When you open a stationery chart, you
“tear off” a chart from the pad. You can then modify the chart as
needed and save it with a name of your choosing.

The Stationery folder on your Org Plus Help & Learning disk contains
stationery for organizations of different sizes.

To use existing chart stationery to create your chart, do the following:
1.  Open the Org Plus application.
See “Starting the program,” page 17, if you need help.

The Startup dialog box appears (Figure 4-6).

[0 Samples = My hard disk
[ Stationery

0 Tutorial

I

5

i (_Cancel
File formats: | Org Plus for Mac w | —

Figure 4-6. The Startup dialog box
2. Open the Stationery folder.

You won't see the Stationery folder if you are using a floppy
disk system or didn't install the Stationery folder on your hard
disk. You must either create a Stationery folder or copy the
Stationery folder from your Org Plus Help & Learning disk to
your hard disk. See "Creating your own stationery," page 167,
or "Installation," page 7.

To open the Stationery folder, click it, and then click the Open
button. You can also double-click the Stationery folder.



manager

subordinate

You'll see a list of the predefined stationery charts in the Startup
dialog box.

)

\

3.  Open the stationery chart you want.

To open a Stationery chart, click it, and then click the Open
button. You can also double-click the stationery chart.

Org Plus creates an untitled copy of the stationery chart for you.
You can then enter information into the chart or modify it to
suit your needs.

See “Creating and deleting boxes,” below, and “Entering
information,” page 84 for information on how to continue.

To create a new stationery chart, see “Creating your own stationery,”
page 167.

Creating and deleting boxes

You create a new box by clicking on an existing box with a box tool
(see Figure 4-7 on page 81). Org Plus automatically draws the box in
the right place and lays out the lines connecting it to the existing box.
All boxes are subordinates to, co-workers of, assistants of, or managers
to existing boxes.

For example, you create a new subordinate to an existing manager by
first clicking the Subordinate box tool, and then clicking the
manager’s box. Org Plus draws a new subordinate box below the
manager’s box with a line connecting it back to the manager.

The table on the next page summarizes the various ways to create and
delete boxes. For more complete instructions, turn to the indicated

pages.
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Creating any type of
a box
80 Using Org Plus

To do this...

Do this...

Create a box of any type

Create multiple boxes of the

same type

Insert a box between subordi-

nates and their manager

Convert a box from one type

to another

Delete boxes

Click the tool for the type of box
you want to create, then, in the
chart, click the box you want to
attach it to, page 80 (below)

Click a box tool multiple times, or
press and hold the Option key when
you click a box tool, page 81

Select the boxes for which you want
to create a new manager, then press
and hold down the Command key
while you click the Manager box
tool, page 82

Drag the box so that it attaches to
another box as a co-worker or
subordinate, page 82

Select and cut the boxes you want
to delete, page 84

The basic steps for creating a box of any type are the same:

1.  Click the box tool icon for the type of box you want to

create.

The box tools are located in the tool palette. See Figure 4-7.
See “The tool palette,” page 178 for more information.

Your pointer changes to a symbol for the type of box you want

to create.

2. Click the box in your chart to which you want to attach

the new box.

Org Plus creates the desired type of box and reformats your

chart (see Figure 4-7).
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k‘ | T I,E.;l Subordinate: E”Co -worker: El E” | ist ‘:@I
/

Click the tool for the
type of box you want
to create (an assistant C. Phillips

in this example)... /
/ T. Nomura L. Stevens

...then click the box to
which you want to
attach the new box

ISize:

SEeE—"—————— lntitled-l ="——————-V"12
h lé-i‘-,,_,l Subordinate: E] | Co-worker: EI E” Manager: @[Assistant E’I

C. Phillips

Org Plus draws the -
box and the
connecting lines

T. Nomura L. Stevens

IGize
Figure 4-7. Creating boxes
Creating multiple Ordinarily, you use a box tool to create one box at a time. To save

boxes of the same type time, there are two different shortcuts you can use to create multiple
boxes of the same type.
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#1: Click a box tool
multiple times

“Create: 6

#2: Use the Option key

Inserting managers

Converting boxes
from one type to
another

82 Using Org Plus

Click a box tool multiple times, once for each box you want to create,
then click a box in your chart. For example, to create six subordi-
nates for a particular manager, click the Subordinate box tool 6 times,
then click the manager’s box.

The status area in the lower left corner of the window shows the
number of boxes that will be created as you click a box tool.

Hold down the Option key when you click a box tool. You can then
create boxes without having to click the box tool each time you want
to create a new box. When you are done creating boxes, click the
Selection Arrow tool in the top left corner of the window.

If you hold down the Option key after you click a box tool, but
before you click in the chart, you can continue creating boxes so long
as you hold the Option key down.

To insert a new manager between one or more co-workers and their
current manager, do the following:

1. Select the boxes for which you want to create a new
manager.

The boxes you select must belong to the same group and be
located next to each other. If not, you can move them next to
each other first. See “Moving boxes,” page 115 for information.

2. Press and hold the Command key while you click the
Manager box tool.

To convert a box from one type to another, you can drag it from its
current location and reattach it to another box in your chart as a co-
worker before, co-worker after, or subordinate. For example, to
convert an assistant box to a regular subordinate box, drag the
assistant box over a non-assistant box so that it becomes a co-worker
to that non-assistant box. For more information, see “Moving boxes
in your chart,” page 115.

To convert a non-assistant box to an assistant box, select it and
choose an assistant style. See “Changing assistant styles,” page 113,
for additional information.



Alternate ways to
create boxes

In addition to the techniques for creating boxes described eatlier in
this chapter, you can create boxes by selecting an existing box first,
then clicking a box tool or typing a Command key equivalent:

1.  Click the box to which you want to attach a new box.

2. Press and hold the Command key while you click a box
tool.

OR...

Press and hold the Shift and Command keys while you
type a letter for the type of box you want to create:

To do this... Press this...
Create a subordinate to the selected Shift-Command-S
box

Create a co-worker before (to the left Shift-Command-B

or above) the selected box

Create a co-worker after (to the right Shift-Command-A
or below) the selected box

Create a manager for the selected box Shift-Command-M

Create an assistant to the selected box Shift-Command-I

Org Plus creates the type of box you want and reformats your
chart.
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Deleting boxes

Entering new
information

sMarne:

<Title>
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To delete one or more boxes, select the boxes you want to
delete and choose Cut from the Edit menu.

You can also press Command-X.

Boxes that you cut are put in a special storage place called the
Clipboard so that you can then paste them someplace else if you
want. If you don’t want to cut them to the Clipboard, you can choose
Clear from the Edit menu, press Command-Y, or press Delete.

When you delete a box, its subordinates, if any, are automatically
promoted. If you don’t want this to happen, delete the text inside the
box, not the box itself.

Entering information

To enter information into a box, click the box once to select it, then a
second time to enter information.

To enter information associated with a particular box, but not visible
in the chart, see “Seeing and editing information not shown in your
chart,” page 86.

To enter information #ot associated with a particular box, such as the
title for your chart or other annotations, see “Annotating your chart,”
page 161.

To change the way information is arranged in a box, see “Changing
the label setup,” page 96.

Follow these steps to enter information into an empty box:

1.  Click once on the box whose information you want to
enter.

Org Plus highlights the box. The arrow pointer changes to an
I-beam when moved over an area where you can enter text.

2.  Click a second time in the box to activate it for editing.

You can also press Return or Enter.



Chrig
<Title>

Editing existing
information

The I-beam: |

Editing shortcuts

Org Plus shows the box with labels for the information you can

enter.

3. Start typing.

The label goes away and your text appears.

4.  Click any other label for which you want to enter informa-
tion, and then type the information.

Pay attention to the labels: Be sure to enter the information
called for by the label. That way you can easily move or

change the information later by moving or changing the labels.
See “Changing the label setup,” page 96.

To edit existing information, click the box whose information you

want to edit, then click with the I-beam pointer in the text you want

to edit.

To make changes to text throughout your chart, press and hold the

Option key while you click the Text tool in the top left corner of the
window. This gives you an I-beam pointer until you click the Selec-
tion Arrow tool (next to the Text tooD. You can then click directly on

any text you want to edit.

The following table summarizes the keystrokes that help you enter

information:

To do this...

Press this...

Select the next label in the box

Select the previous label in the box

Enter information for the next co-
worker, if any

Enter information for the previous co-
worker, if any

Tab, Return, Right Arrow,
Down Arrow

Shift-Tab, Left Arrow, Up
Arrow

Option-Right Arrow

Option-Left Arrow
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Entering people’s When entering people’s names, always type the person’s complete

names name. Org Plus has special commands for abbreviating or formatting
names any way you want, provided it knows the complete name to
begin with. See “Formatting people’s names,” page 108, for instruc-

tions.
Seeing and editing The edit panel lets you see and edit all the information for any box in
information not your chart. Use the edit panel when:
shown in your chart . ,

[ ] You want to see your chart at a reduced view, but still see and

edit the information in any box. (See “Viewing your chart at
actual and reduced sizes,” page 93.)

| Some of the information for a box is not currently visible in the
chart. You can hide information by hiding its label at the Label
Setup dialog box. (See “Hiding and showing labels,” page 104.)

You can also use the edit panel to speed data entry. See Appendix B,
“Time Saving Measures,” page 211.

To use the edit panel, do the following:

1.  Click the box whose full set of information you want to
see or edit.

2. Choose Show Edit Panel from the Chart menu.
You can also press Command-E.
Org Plus opens the edit panel, as illustrated in Figure 4-8.

3.  Click in the text you want to change, and make the
changes.

4. Select other boxes whose information you want to see or
edit.

5. When you’re done, choose Hide Edit Panel from the Chart
menu.

You can leave the edit panel open as long as you want, but it
slows down operation a bit.
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The edit panel

Salary is not shown
in the chart, but
appears in the edit
panel

Click bere to show
your edits in the
chart as you type
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Figure 4-8. The edit panel
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chart until you select a different box. To make it appear in the chart
as you type, select the check box labelled “Show changes in chart,”
located at the bottom of the edit panel (see Figure 4-8).
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Selecting a single
object

88 Using Org Plus

Selecting boxes and lines

In order to change a box or line, you must first select it. The following
table summarizes the various ways you can select things. For more
complete instructions, turn to the indicated pages:

To do this...

Do this...

Select a single object (box,
line, text, and so on)

Select multiple objects

Select all objects of the same
type

Select a group

Select a branch

Select all boxes in one or more
levels

Select all boxes

Click with the arrow pointer,
page 88

Shift-click* with the arrow pointer,
page 89, OR...

Drag an outline around the objects,
page 89

Choose a command from the Select
submenu, located in the Edit menu,
page 90

Double-click any box in the group,
page 90, OR...

Select a box in the group and press
Command-G, page 90

Select the topmost box in the branch
and press Command-B, page 90

Choose Select Level from the Edit
menu and type in the levels you
want, page 91

Choose All Boxes from the Select
submenu located in the Edit menu,
or press Command-A, page 92

* To “Shift-click,” hold the Shift key while you click with the mouse.

You can select any single object in your chart by placing the arrow

pointer over it and clicking.

Selected boxes are highlighted and selected lines are made gray.



Selecting multiple To select multiple objects, Shift-click them or drag an outline around
objects them with the arrow pointer (see Figure 4-9).

By Shift-clicking To select objects in scattered locations, press and hold the Shift key
while you click them. To remove any individual item from the
selection, click the selected object a second time while keeping the
Shift key pressed down.

By dragging an outline To select objects located next to each other, drag an outline around
them (see Figure 4-9).

[ € File Edit Styles Text Boxes Chart Help W
EI=——— ntitled-| —=———i o=
Click the Selection Amw—-RITIO\ISubordina‘e:EllCo—worker:E]@|Manager:@léssistant:@|+I_rl*\l[:]
tool to get the arrow (>

pointer, if necessary...
[
Carinm Gpaer Lunn Jrv«r LaTy Gtevens
L. 3 Exacutive Becrein Chiaf Fimancisl OFFicer, ¥ice Prasiden Vice Prasiden
...position the pointer l l
over one corner and | oo 8

press the mouse button...

P oo
Elnctrician
...drag to the opposite /
corner and release the
mouse button l51 o

Figure 4-9. Selection by dragging an outline around objects

Objects are highlighted when they are completely within the outline,
as shown in Figure 4-9.

To remove a box, line, or other unwanted object from the selection,
Shift-click it. (See "Shift-clicking" above.)
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Selecting all objects of

the same type

Selecting a group

Selecting a branch
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To select all objects of the same type, make a selection from the
Select submenu, located in the Edit menu (Figure 4-10).

Undo ¥2
Cut $H
Copy 8C
Copy Setup
Paste 1)
Clear ®ny
m All Boxes %A
Select Levels... All Assistants
All Managers
Label Setup... %L Al Non—Managers
Group Eq0
Preferences... Branch ®B

Lowest Level
Connecting Lines

Figure 4-10. The Select submenu

Why would I want to select all objects of the same type? You might
want to select all manager boxes in order to give them a shadow.

To select a group — all boxes reporting to the same manager —
double-click any box within the group.

You can also select any box within the group, then choose Group
from the Select submenu or press Command-G.

To select a branch — a manager box and all its subordinates — first
select the manager box then choose Branch from the Select submenu
or press Command-B.



Selecting all boxes at
the same level

The topmost box in your chart is at level 1. The boxes reporting
directly to it are at level 2. The boxes reporting to them are at level 3,
and so on. The black boxes in Figure 4-11 are at level 4.

W W W W W
EEN
N
W W W
A A

Figure 4-11. Levels in a chart

To select all boxes at the same level, choose Select Levels from the
Edit menu. Org Plus displays the Select Levels dialog box, pictured in
Figure 4-12.

Select Levels

Select all boses at levels: [[Jll] ) througn ®

Figure 4-12. The Select Levels dialog box

Enter the levels of the boxes you want to select and click the OK
button. For example, to select all the boxes at level 4, as shown in
Figure 4-11, you would enter "4" in both places in the dialog box and
click the OK button.
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Selecting all boxes
Keyboard shortcuts for
selecting boxes
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To select one level only, enter the same number in both text boxes
and click the OK button.

Why select all boxes at the same level? Boxes at the same level in an
organization generally have the same status. To show this, give them
the same visual features such as fonts, borders, and label setups.

See “Changing the label setup,” page 96, and “Changing text, lines,
and box styles,” page 127 for ways to change the visual characteristics
of boxes.

To select all the boxes in your chart, choose All Boxes from the Select
submenu, or press Command-A.

When a box is selected, you can use any of the following keystroke
combinations to select neighboring boxes:

To do this... Press this...

Select all boxes and lines Command-A

Select a group Select a box in the group, then press
Command-G

Select a branch Select the topmost box in the
branch, then press Command-B

Select the co-worker above or
to the left

Option-Left Arrow

Select the co-worker below or
to the right

Option-Right Arrow

Select the current box's
manager

Option-Up Arrow

Select the current box's first
subordinate

Option-Down Arrow

Org Plus has many other keyboard and mouse shortcuts for common
operations. See Appendix C, “Keyboard and Mouse Shortcuts,” page
215.



Viewing your chart at
actual and reduced
sizes

Viewing and moving around your chart

This section describes how you can view your chart and quickly move
around in it. You can use the scroll bars, or any of the Org Plus
special commands for this. You may find that the easiest way to
move around your chart is with the Reduce/Enlarge tool. See “Using
the Reduce/Enlarge tool,” page 94.

The following table summarizes the various ways you can view your
chart and move around in it. For more complete instructions, turn to
the indicated pages:

To do this... Do this...
View your entire chart in the Make a choice from the Chart menu,
window, at actual size, or at page 93

50% of actual size

Switch between reduced and Use the Reduce/Enlarge tool, page
actual size views of your chart 94

Move to the left, right, up, or Use the scroll bars, OR...
down in your chart
Use a keyboard shortcut, page 95

See any box in your chart at Press and hold the Control key
actual size while you click the box you want to

magnify, page 94

To change how much of your chart you can see at any one time,
make a choice from the Chart menu.

[ | To get a bird’s eye view of your chart, choose Size to Window.

u To see as much as possible while keeping the text as legible as
possible, choose 50% of Actual.

u To see how any part of your chart will look when printed,
choose Actual Size.

You can also press the Command key equivalents.
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Using the Reduce/
Enlarge tool

=
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See any box in your

chart
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Depending on the size of your screen and of your chart, there may be
little or no difference between Size to Window and 50% of Actual.

When you choose Size to Window, the status area (in the lower left
corner of the window) shows the percent of actual size. For example,
“67%” means that the chart has been reduced to 67% of its actual size
in order to fit in the window. No matter what percent is shown,
however, your chart always prints at its full size.

The Reduce/Enlarge tool is the third tool from the left in the top left
corner of your window. It shows either a magnifier or a little chart
symbol depending on the current level of magnification.

If your chart is shown at 50% of actual or sized to the window, you'll
see a magnifier (see the figure to the left).

If your chart is shown at actual size, you'll see a little chart (see the
figure to the left).

You can use the Reduce/Enlarge tool to switch between Size to
Window and Actual Size. Click the tool, then click in the area of your
chart you want to reduce or enlarge.

If your chart is at actual size, a click shows the entire chart.

If your chart is reduced, a click magnifies the area under your magni-
fier.

You don’t have to click the Reduce/Enlarge tool. You can also press
and hold the Control key (if your keyboard has one). This gives you
a convenient way to see any box in your chart:

If you can see the entire chart: hold the Control key and click the box
you want to see more closely.

If you can’t see the entire chart: hold the Control key and click
anywhere in your chart. You'll see the entire chart. With the Control
key still down, click the box you want to see more closely.



Moving left, right, up,
or down

Keyboard shortcuts for
viewing and moving

You can use the standard Macintosh scroll bars to scroll through your
chart. If you don’t know how to use the scroll bars, see your Macin-

tosh owner’s manual.

The following table summarizes the keystrokes that let you view and

move around in your chart.

To do this... On any keyboard Ext. keyboard
See your entire chart in Command-1 Command-I

the window (size it to

fit in your window)

See your chart at 50% Command-J Command-J

of actual size

See your chart at actual
(printing) size

See the part of your
chart above the window

See the part of your
chart below the window

See the part of your
chart to the left of the
window

See the part of your
chart to the right of the
window

See the topmost box in
your chart

See boxes at the bottom
of your chart

Command-K
Command-Up Arrow
Command-Down
Arrow
Command-Left

Arrow

Command-Right
Arrow

Option-Command-
Up Arrow

Option-Command-
Down Arrow

Command-K

Page Up

Page Down

Command-Page
Up

Command-Page
Down

Home

End

Org Plus has many other keyboard and mouse shortcuts for common
operations. See Appendix C, “Keyboard & Mouse Shortcuts,” page

215.
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Changing the label setup

The labels for the information you enter into the boxes in your chart,
and the way they are arranged, is called the label setup. The label
setup is like a blueprint for the information you want in each box.

When you created your chart, you either selected a predefined label
setup, like the one shown in the figure to the left, or you created a
new one.

You can change or add to the label setup at the Label Setup dialog
box (see Figure 4-13 on page 98). The label setup determines which
information appears in your chart and in what order. For example, to
enter department names in each box, you create a Department label
first in the Label Setup dialog box. To move the titles above the
names in your chart, you move the Title label above the Name label
in the Label Setup dialog box. In other words, whatever you do to
the labels in the Label Setup dialog box, Org Plus does to the informa-
tion in your chart.

You can create up to 24 different labels for your chart, and devise
almost any conceivable label setup at the Label Setup dialog box.
You can give each label its own type font, style, and size.

You can also create different label setups for different boxes. For
example, you can modify the label setup for non-manager boxes to
show names only, but show both names and titles in manager boxes.

The following table summarizes the ways you can change the label
setup. For more complete instructions, turn to the indicated pages:

To do this... Do this...
Create labels for the informa- Type the labels in any dotted area of
tion in each box in your chart  the Label Setup dialog box, page

100
Create areas in which to type Click Add Label button, or any of
labels the label area buttons, page 100
Delete label areas Click in the label area and click the

Del button, page 102




To do this...

Do this...

Move labels in the label setup

Hide or show labels

Create dividing lines

Change margins within a box

Rename labels

Delete labels

Format people’s names

Show labels before information
in your chart

Copy the label setup of one
box to other boxes

Cut a label, then paste it where you
want to move it, page 102

Click the label you want to hide,
then click the Hide Label button,
page 104

Click the dividing line buttons,
page 106

Drag the edges of the inside label
areas, page 107

Double-click the label you want to
rename, then type the new label
name at the Change Label dialog
box,  page 108

Double-click the label you want to
delete, then click the Delete button
in the Change Label dialog box,
page 108

Double-click the label you use for
people’s names, then click the
“Format...” check box in the Change
Label dialog box, page 108

Double-click the label you want to
show in your chart, then click the
“Show label...” button in the Change
Label dialog box, page 109

Select the box whose setup you
want to copy, choose Copy Setup,
from the Edit menu, then paste it to
the boxes you want to change,
page 109
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The Label Setup dialog You change the label setup for all or selected boxes at the Label
box Setup dialog box (Figure 4-13). You can get to the Label Setup dialog
box by choosing Label Setup from the Edit menu.

Set of boxes you want to Label areas—
change \
S=————=———label Setup
Close box /] . A .
You can type additional pply to: ORIl boxes @ Selected boxes

labels in any dotted area, or
cut & paste to move them.

The label setup

Labels in chart:
Name

K>
Yitie []

, S

List of labels in the | STIte> 1

chart. Any box can

show any or all of these -
labels S
)
)

( Hide jabol [J Add Tabel areas & dividers... [<a] 63

[ thenge tabet

( Addiabel ] [ Cancel | l i%m)i@;]

Figure 4-13. The Label Setup dialog box

The label setup is shown in the box to the right. Scroll this window if
the label setup gets larger than the window.

The dotted rectangles within the setup are called label areas. You
can type a label in any label area, whether it is inside or outside the
box. You can also create additional label areas. See “Creating
additional label areas,” page 100, for more information.

All the labels that have been created for your chart are shown in the
list on the left in the dialog box. When you create a label, Org Plus
automatically adds it to this list. You can move labels from the list
into the setup, or vice versa. See “Moving labels,” page 102.

The radio buttons at the top of the Label Setup dialog box let you
apply the changes you make in the dialog box to the currently
selected boxes only, or to all the boxes in your chart.

The other buttons and controls in the Label Setup dialog box let you

change labels and their setup. Their purposes are described in the
following pages.
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How to change the You can change the label setup for all boxes, or for selected boxes
label setup only:

1. Select the boxes whose label setup you want to change.
If you want to change the label setup for all boxes, press
Command-A. (If you don’t select any boxes, Org Plus assumes
you want to change all the boxes.)
2.  Choose Label Setup from the Edit menu.
The Label Setup dialog box appears (Figure 4-13 on page 98).
3.  Make the changes you want to make.

See the following sections for information about the various
changes you can make at the Label Setup dialog box.

4.  Click the Apply button.
If your screen is large enough, you can drag the Label Setup
dialog box to the side so that you can see both your chart and
the dialog box at the same time.
When you click the Apply button, Org Plus makes the same
changes to the information in your chart that you made to the

labels in the Label Setup dialog box.

5. Repeat steps 3 and 4 to make and apply additional
changes.

6. Click the close box to close the dialog box.

The close box is located in the upper left corner of the dialog
box.

You don’t have to click the close box to return to your chart.
Just click in the chart.
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Creating labels
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Creating additional label

areas
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You must create labels for new information before you can enter it
into the boxes in your chart. For example, if you want to enter
department names, you must create a “Department” label.

To create a label, click the Add Label button in the Label Setup
dialog box.

Org Plus creates a label area below the current one (the one with the
blinking insertion point). You can then type the new label. Don’t
type angle brackets (see note below).

You can type several labels in a single label area. Click in the begin-
ning of the label area and type the additional label. Do this if you
want to join separate pieces of information together on a single line,
such as City, State, and Zip.

You can create additional label areas and leave them empty or type
labels in them. See “Creating additional label areas,” below.

About angle brackets (<>): When you create a new label, Org Plus
automatically puts angle brackets around it. The angle brackets help
you distinguish between labels and the information you have typed in
your chart.

New labels appear in the boxes currently selected in your chart, but
can appear in any box in the chart: You can create up to 24 labels
for a single chart. Each box can contain all or some of those labels.
When you create a label, that label appears in the selected boxes
only, but you can make it appear in other boxes as well. See “Hiding
and showing labels,” page 104.

The dotted rectangles in the setup are called label areas. You can
type labels in label areas.

To create additional label areas, click the check box labelled “Add
label areas & dividers,” immediately above the Add Label button
(Figure 4-14). Org Plus reveals the label area buttons.



[[==——————— label Setup

You can type additional Apply to: OAIl bores @ Selected boxes
labels in any dotted area, or =
cut & paste to move them. =
@
Labels in chart: =
Nams > o
fitle ]
Click bere... N
[ Hide jahal ] HESHE o>
...to show the -
buttons for creating [ inange tabet (_ nAddisbel | [cancel ]
additional label
areas Figure 4-14. The label area buttons

Click a label area button to create a label area to the left, to the right,
above, or below the current label area (the one with the blinking
insertion point in it). Org Plus reformats the label setup automatically.

You can use the label area buttons to create almost any conceivable
arrangement of label areas (see Figure 4-15). You can create label
setups with multiple columns, or multiple rows for the exterior label
areas. You can type labels in any of the label areas.

Figure 4-15. Creating complex label setups
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Deleting label areas

Click in the label

To delete a label area, click in the label area, then click the Del button
next to the horizontal scroll bar, as shown in Figure 4-16.

Before... After...

<Name>

area you want to
delete...

...and click the

Del button

Moving labels

Using Org Plus

Figure 4-16. Deleting label areas

If the Del button isn’t visible, click the check box labelled “Add label
areas & dividers,” then click the Del button.

You can also delete an empty label area by clicking it and pressing
the Delete key.

When you delete a label area, you do not delete a label or any
information in your chart. If the area contains a label, Org Plus
moves the label to the list on the left in the dialog box. You can then
move the label back into a different label area in the label setup. See
“Hiding and showing labels,” page 104.

Why would you want to move labels? You move labels in order to
move the information that you've already typed into the boxes in your
chart.

For example, Figure 4-17 shows a chart with names located above
titles. Move the Name label into the bottom label area, and the Title
label into the top area, click the Apply button in the Label Setup
dialog box, and presto! — the information is reversed in your chart, as
shown in Figure 4-18.



<Mame>
<Title>

Reverse the order of
the labels in the
label setup...

<Title>
<Name>

...to reverse the order —

of the information in
the chart

Chris Phillips
President & CEO

I |

Lunn Brewer Larry Stevens Tina Nomura
CFO Vice President Coo

Figure 4-17. Name above title

President & CED
Chris Phillips

l—T

l _
CFO Vice President Coo
Lynn Brewer Larry Stevens Tina Nomura

Figure 4-18. Title above name

You can cut and paste to move labels within the label setup:

1.

2.

Click the label you want to move.
Choose Cut from the Edit menu.

The label is removed from the label setup and appears high-
lighted in the list of labels on the left in the dialog box.

Click in the label area where you want to move the label.
Choose Paste from the Edit menu.

Org Plus inserts the label at the insertion point.
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Hiding and showing

labels

104

Click the label

Why would you want to hide or show labels? Sometimes you may not
want to show certain information in your chart. For example, you
might want to show grade level information for some employees but
not for others. Or perhaps you want to print your chart with salary
information for the President of the company, and without salary
information for everyone else.

To remove a label from the setup, click the label you want to remove,
then click the Hide label button (see Figure 4-19).

S[[=——————— l abel Setup ﬁ”l

You can type additional fApply to: OAll bores @ Selected boxes
labels in any dotted area, or 75
cut & paste to move them. |

you want to
bide...

...then click the
Hide label button
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Labels in chart:
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[
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Figure 4-19. Hiding information
Figure 4-20 shows a chart before and after hiding the Salary label.

To move a hidden label back into the setup, click the label in the
label list and click the Show button (see Figure 4-21). The label
appears at the insertion point in the setup.

This button alternates between “Hide label” and “Show label” depend-

ing on whether the selected label appears or doesn’t appear in the
setup.



<Title>

President & CEO
: <Name> : Chris Phillips
i<Job Code> <Salarysi A101 123,000
l l
Hide the Salary label CFO Vice President coo
(remove it from the Lynn Brewer Larry Stevens Tina Nomura
label setup)... B101 67,000 B103 95,000 B104 78,000
<Title» President & CEO
: <Name> Chris Phillips
i<Job Code> A10T
I |
...in order to remove it CFO Vice President coo
from the chart Lynn Brewer Larry Stevens Tina Nomura
B101 B103 B104

Figure 4-20. Hiding salary information

=01

Label Setup

‘You can type additional
labels in any dotted area, or
cut & paste to move them.

Click where you want
to put the bidden
label...

...click the label you
want to show in the
chart...

...then click the
Show label button

Labels in chart:
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Apply to: OAll bores @ Selected boxes
<
R 5
N
itles
: <Na\@>
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|
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Figure 4-21. Showing information
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Creating dividing lines

106

....................................
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dividing line buttons
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You can draw horizontal and vertical dividing lines within a box to
separate information.

To draw dividing lines, click the check box labelled “Add label areas
& dividers,” immediately above the Add Label button (see Figure
4-22). Org Plus reveals the dividing line buttons.

= |=—=—=———=———-"label Setup
You can type additional Apply to: O ANl bokes @ Selected boxes
labels in any dotted area, or =
cut & paste to move them. l:IEI:'
Labels in chart: {m}
Nome i [<Name> W
fitle [] Title>
A\ o
( Hide label ] TALiv (Del 1] &
[ tnhange tabet ] ([ nAddiabel | [ Cancel | Boply

Figure 4-22. The dividing line buttons

Click a dividing line button to divide the box vertically or horizontally.
Click again to remove the line if you don't like it.

For example, to draw a dividing line between Name and Title, click
the first dividing line button, as shown in the figure to the left. A line
appears below Name. When you click the Apply button in the Label
Setup dialog box, Org Plus draws a line below the names in the
selected boxes (see Figure 4-23).

Chris Phillips
President & CED

| I

Lynn Brewer Larry Stevens Tina Nomura
CFD Yice President coa

Figure 4-23. Drawing dividing lines




Changing margins
within a box
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Changing labels

To create horizontal dividing lines, you must have at least two rows of
label areas inside the box. To create vertical dividing lines, you must
have at least two columns of label areas inside the box.

Org Plus draws the dividing lines below or to the right of the label
area containing the insertion point. If the insertion point is in the
bottom row or rightmost label area, however, it draws the line above
or to the left of the label area.

Box margins are the amount of space between the box border and the
labels within the box.

To change box margins, position your pointer over the edge of a label
area, as shown in the figure to the left. A special pointer appears
automatically. Drag the margin to the desired distance from the box
border. As you drag, Org Plus shows the actual width of the margin.
When you release the mouse button, the margin is set.

You can set top, bottom, left, and right margins. The margins are
preset to .05".

You can rename, delete, and make other changes to any label at the
Change Label dialog box (Figure 4-24). To make this dialog box
appear, click a label in the label setup or in the list of labels, then
click the Change label button in the Label Setup dialog box.

Change Label

Rename to:
| I Delete

[] Format people's names

[] show label before
information in chart

Figure 4-24. The Change Label dialog box

You can also make this dialog box appear by double-clicking the
label you want to change in the Label Setup dialog box.
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Renaming labels
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To rename a label, double-click the label you want to rename at the
Label Setup dialog box. The Change Label dialog box appears (Figure
4-24). Type the new label.

The label is renamed for every box in your chart, regardless of which
boxes are currently selected.

Why would you want to delete a label? Deleting a label is a quick way
to delete information in the boxes in your chart. When you delete a
label, Org Plus deletes all the information that has that label. For
example, if you delete the Department label, Org Plus deletes all the
departments in your chart.

To delete a label, double-click the label you want to delete at the
Label Setup dialog box. The Change Label dialog box appears (Figure
4-24 on page 107). Click the Delete button.

Org Plus warns you before deleting so that you can cancel the
operation if you want.

Deleting labels is very different from simply hiding them. When you
hide labels, you hide the information in the chart, but that information
is still in the chart document, although not visible in the boxes of the
chart. You can make it visible again. See “Hiding and showing
labels,” page 104. When you delete a label, you permanently remove
it and all the information which has that label.

Org Plus has special commands for formatting people’s names. These
commands are located in the Name submenu in the Text menu.

If you have people’s names in your chart, you can format them in any
of the ways shown in the Name submenu (see figure to the left).

In order to format names automatically, Org Plus needs to know
which label you use for people’s names. (This is usually the label
called “Name,” but you might have created a label called “Employee”
or “Prospect” or anything else for that matter.)

To format people’s names in your chart, double-click the label that
you use for names in the Label Setup dialog box. The Change Label
dialog box appears. Click the “Format people’s names” check box.
Thereafter, you can select any box in your chart with a name in it,
and then choose any name formatting command to reformat the name



Showing labels in your

chart

<Mame:

<hges

Tom Jones
25

Tom Jones
Age: 25

Copying the label

setup

automatically. See “Changing people’s name formats,” page 129, for
more information.

You can format only one person’s name per box.
When entering people’s names in your chart, always type the complete

name. You can change the format for it later. See “Entering people’s
names,” page 86 for more information.

When you click twice on an empty box in your chart, labels appear in
the box to show you what to type, as shown in the first figure to the
left.

Ordinarily, the labels disappear as soon as you have typed the
information.

In some cases, however, you may want to see the label along with the
information. For example, numbers are usually not self-explanatory.
You can tell Org Plus to show the label before the information, as
shown in the figure to the left.

If you want to do this, double-click the label that you want to show in

the Label Setup dialog box. The Change Label dialog box appears.
Click the “Show label before information in the chart” check box.

Remember: Showing labels in your chart may make your chart clearer
to others, but it may make the boxes — and therefore the chart —
wider as well.

You can copy the label setup from one box to any other box:

1. Select the box whose setup you want to copy.

2.  Choose Copy Setup from the Edit menu.

3. Select the box or boxes to which you want to give the
same setup.

4.  Choose Paste Setup from the Edit menu.

Org Plus copies the label setup along with the box border and
box shadow, if any.
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Rearranging boxes in your chart

All boxes belong to a group. A group consists of all the boxes
having the same manager, excluding assistant boxes, which form their
own group.. A chart is usually made up of many groups.

To rearrange a group of boxes, select the group you want to rear-
range and choose a group style from the Styles menu. You can also
create and rearrange subgroups and assistants.

The following table summarizes the various ways you can rearrange
boxes. For more complete instructions, turn to the indicated pages:

To do this...

Do this...

Rearrange the boxes in a group

Create and arrange a subgroup

Rearrange a subgroup

Merge separate subgroups back
into a single group

Change the way assistants are
arranged

Create a co-manager relation-
ship

Double-click any box in the group
and choose a group style from the
Styles menu, page 111

Select the boxes in the subgroup
and choose a group style,
page 111

Double-click any box in the
subgroup and choose a group
style, page 112

Select all the boxes in the sub-
groups and select a group style,
page 112

Select the assistants and choose an
assistant style, page 113

Select the co-manager boxes, then
choose the co-manager style,
page 114




Changing group styles

Group styles:
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Creating subgroups

You can arrange groups in 20 different ways, called group styles (see
figure to the left). Every group in a chart can have its own style.

To change the style for any group in your chart, double-click
any box in the group to select the group and choose a group
style from the Styles menu.

You can also select a group by clicking one box in the group and
pressing Command-G.

Org Plus reformats your chart automatically.

You can change the style of multiple groups simultaneously: press
and hold the Shift key while double-clicking on boxes in different
groups to select them; then choose a group style from the Styles
menu.

A subgroup is a grouping of boxes within a larger group. Figure
4-25 shows two subgroups.

( % File Edit Styles Text Boxes Chart Help

k I T |O\| Subordinate: EI [ Co-worker: EE} | Manager: E [Assistant:E” I

Subgroups

Figure 4-25. Subgroups

The boxes in both subgroups belong to the same group because they
have the same manager.
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Subgroups can have their own group styles (see Figure 4-20).
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!5123: 508 [Q
Figure 4-26. Subgroups with different styles

To create a subgroup, select all the boxes that belong to the |
same subgroup and choose a group style from the Styles menu.

You must put the boxes next to each other before you can make
them into a subgroup. They must have the same manager. See
“Moving boxes,” page 115 for instructions.

You change a subgroup’s style in the same way you change the style
for a regular group:

Double-click any box in the subgroup to select it, then choose a
group style from the Styles menu.

Some time after dividing a group into subgroups, you may want to
merge the subgroups back into a single group.

To merge subgroups into a single group, select all the boxes in
all the subgroups that you want to merge, and then choose a
group style from the Styles menu.




Changing assistant

styles
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If the subgroups have different managers, you must move the sub-
groups under the same manager. To put boxes from different groups
or subgroups into a single group, see “Gathering scattered boxes
under a single manager,” page 117.

An assistant provides administrative assistance, advice, or even
managerial assistance to its manager. Org Plus provides 8 different
ways for you to represent the role of an assistant, available in the
Styles menu.

The first three styles (see the figure to the left) are often used to show
assistants who provide administrative support, such as secretaries.

The bottom three styles are often used to show assistants who provide
advice, such as advisors. You can also use these styles to show a
board of directors.

The last two styles are often used for assistants who assume manage-
rial responsibility in the absence of the manager.

When you create an assistant using the Assistant box tool, it is auto-
matically given the preset style for assistants (see note below). You
can change this style as follows:

1. Select the assistant whose style you want to change.

2. Decide which style best communicates the role of the
assistant (your choice).

3. Choose the desired assistant style from the Styles menu.

You can also apply an assistant style to a non-assistant box. This
converts it to an assistant.

Changing the preset option: Starting out, the preset assistant style is

the top left one in the set of assistant styles. You can change the
preset style. See “Changing preset options,” page 169.
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Creating co-managers Co-managers are boxes who share responsibility for the same group
of subordinate boxes (Figure 4-27).

(& File Edit Styles Test Bowes Chart Help b
e niit- 1 =
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Co-managers share

responsibility for
the same group of
subordinates
fsize:
Figure 4-27. Co-managers
Co- manager style: ﬁ. To show that two or more boxes are co-managers, select the
boxes and choose the co-manager style from the Styles menu.

You must move the co-managers next to each other before you can
give them the co-manager style. They must have the same manager.
See “Moving boxes,” page 115 for instructions.
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Moving boxes

Moving boxes in your chart

To move boxes, you can drag them or cut and paste them.

The following table summarizes the ways you can move boxes. For
more complete instructions, turn to the indicated pages:

To do this...

Do this...

Move a manager along with
its subordinates

Move a manager but leave
his subordinates where they
were

Gather scattered boxes under
a single manager

Replace the contents of one
box with the contents of
another

Move the entire chart

Center the chart

Drag the manager box over its new
neighbor, page 115

Press and hold the Command key
while you drag the manager over its
new neighbor, page 116

Cut the boxes you want to move,
then paste them onto their new
manager, page 117

Press and hold the Option key while
you drag one box over another,
page 118

Drag the topmost box, page 118
Choose Center Up/Down or Center

Left/Right from the Chart menu,
page 118

You can move boxes in your chart simply by dragging them from one
place to another with the arrow pointer. You must drag a box over
the box that will be its new co-worker or manager:

1. If you don’t have an arrow pointer, click the Selection
Arrow tool, located in the top left corner of the window.

2. Decide which box will be the new co-worker or manager
of the box or boxes you’re moving.

3. Drag the box you want to move over its new co-worker or

manager.
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Drag over the top
left area of the
bighlighted box
to move before or
above it
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You must attach it to another box in your chart. You can’t
simply drop it next to another box because Org Plus then
doesn’t know whether you want it to be a co-worker or subor-
dinate of the box you drop it next to.

Org Plus scrolls the window automatically as you drag, if

necessary.

4.  Move the pointer until the arrow points to where you
want the box moved:

Drag over the top right area of the bighlighted
box to move after or below it
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Figure 4-28. Moving boxes
5. Release the mouse button.

Org Plus moves the box or boxes and reformats your chart
automatically. If you make a mistake or don't like the result,
choose Undo from the Edit menu immediately.

Moving a box without moving its subordinates: 1f you don’t want to
move the subordinates, press and hold the Command key while you

click and drag.



Gathering scattered
boxes under a single
manager

You can cut and paste to move boxes from one place in your chart to
another. This is the most convenient way to gather selected boxes
from scattered locations under a single manager.

You can also use this technique to cut or copy boxes from one chart
to another. See “Cutting and pasting between charts,” page 145.

The basic steps are:

1.

If you don’t have an arrow pointer, click the Selection
Arrow tool, located in the top left corner of the window.

Select the box or boxes you want to move.

To select multiple boxes, either (a) hold down the Shift key
then click the boxes you want, or (b) drag an outline around
the boxes you want to select, provided the boxes are next to
each other. See “Selecting boxes and lines,” page 88.

Choose Cut from the Edit menu.

You can also press Command-X.

The subordinates of cut boxes are automatically promoted a
level. This may cause your chart to look quite different when
the operation is finished! If you want to move a box without
promoting its subordinates, drag the box while you press and
hold the Command key.

Decide where you want to paste the selected box or boxes.
You can make them subordinates of any box in any other chart.
Select their new manager’s box.

Choose Paste from the Edit menu.

You can also press Command-V.

Individual boxes are pasted as subordinates of the selected box.

Using Org Plus 117




Replacing box con-
tents

Moving and centering
your chart
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You can replace all the contents of one box with all the contents of
another by pressing and holding the Option key while you drag a box
over the box whose contents you want to replace. The contents of
the original box — the one you drag — are moved, but not the box
itself. The box itself is left empty.

You can move the entire chart anywhere on the page (or pages) just
by dragging the topmost box. This can be handy if you want to move
your chart off center.

To center your chart horizontally between left and right mar-
gins, choose Center Left/Right from the Chart menu.

To center your chart vertically between top and bottom mar-
gins, choose Center Up/Down from the Chart menu.

Keeping your chart centered: Once you have selected either horizon-
tal or vertical centering, your chart remains that way until you turn
centering off or move the topmost box. To turn either type of
centering off, choose the centering command a second time.



Changing the distance between boxes

You can change the distance between boxes in all or selected groups
at the Spacing dialog box (Figure 4-29).

[ECJ==————=— spacing (in inches) —e—-—o-—=|

To set distances, —\ Apply to: O All groups @ Selected groups

enter numbers...
(§) bistance to manager: N

Distance to connecting line: %

-

@ Horizontal spacing: Dii:l or:

. . JRN S e
@ Vertical spacing between co-workers: ™~ 3 I
@ Distance between groups (applies to whole chart)

Figure 4-29. The Spacing dialog box

...or click the
arrow controls

You can also change the distance between boxes in horizontally
arranged groups by dragging individual boxes left or right (see
“Changing distances by dragging,” page 120).

Using the Spacing The Spacing dialog box lets you change the distance between the
dialog box boxes in all or selected groups in a single operation. You can
change:
u The distance between boxes in some or all groups
u The distance between some or all groups and their managers

u The distance between all groups in your chart

To change the distance between two individual boxes in a group, see
"Changing distances by dragging,” page 120.
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Here’s how to use the Spacing dialog box:

1.  Select the group or groups whose spacing you want to
change.

The easiest way to select a group is to double-click any box in
the group. You can also click one box and press Command-G.

(=¥ If you don't select any groups, Org Plus assumes you want to
change the spacing between boxes in all groups in your chart.

2. Choose Spacing from the Boxes menu.
The Spacing dialog box appears (Figure 4-29 on page 119).
3. Type the desired distances in the boxes.

You can also click the arrow controls to increase or decrease
the amounts already shown in the boxes (see Figure 4-29).

4.  To apply the changes and make additional ones, click the
Apply button.

If your computer screen is large enough, you can move the
dialog box and see the changes applied to your chart.

If the spacing still isn’t quite right, you can repeat these last two
steps until you're satisfied.

You can make changes to additional groups by making selec-
tions from the Select submenu, entering in the desired dis-
tances, and clicking the Apply button.

5. Click the close box to close the dialog box.

Changing the length When you change the spacing between boxes as described in the

of connecting lines previous section, Org Plus automatically lengthens or shortens their
connecting lines. You don’t change the length of the lines directly,
except by dragging boxes (see immediately below).

Changing distances You can change the distance between any group and its manager by

by dragging holding down the Shift key while you drag any box in the group up
or down. This technique is mostly used to make a chart more com-
pact. See “Drag groups down,” page 135, for more information.
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You can also change the distance between boxes in horizontally
arranged groups by holding down the Shift key and dragging indi-
vidual boxes left or right. For example, to increase the distance
between Mary and Jane’s boxes in the top part of Figure 4-30, press
and hold the Shift key while you drag Jane’s box to the right. A
dotted rectangle surrounds the boxes that will be moved.

f € File Edit Styles Text Boxes Chart Help
EDE Untitled-1

k l T |O\| Subordinate: IE_I | Co-worker: EE} | Manager: [ElAssistant:IE”

L/

[
i

Phil

Press and hold the
Shift key while you
drag Jane to the right

i51’ze: S50% Ko

( % File Edit Styles Teut Boxes Chart Help ]
EI=——————Untitled- =———————[=|

ke ] T rQI Subordinate: @ICo—worker: EE”Manager: [E I Assistant:E”

When you release the
mouse button, Jane
and the boxes to her
right are moved

Figure 4-30. Dragging boxes to increase distances
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When you release the mouse button, the boxes are moved. Don’t
worry about boxes overlapping — Org Plus will reformat everything
for you.



Making boxes larger or smaller

Org Plus automatically makes all boxes at the same level the same
width and height. No box is wider than its manager’s box. This is

called automatic sizing.

In general, automatic sizing ensures a nice balance between uniform
box sizes and compactness. Boxes toward the top of the chart tend
to be less numerous and wider. Boxes toward the bottom are more
numerous and narrower. If necessary, however, you can make any
box in your chart virtually any size.

The following table summarizes the ways to make boxes larger or
smaller. For more complete instructions, turn to the indicated pages:

To do this...

Do this...

Make boxes as narrow as
possible

Make boxes as short as possible

Make boxes as small as possible

Give a box a fixed size

Restore automatic sizing

Select the box or boxes which you
want to make as narrow as pos-
sible, then choose Auto Width
from the Boxes menu, page 124

Select the box or boxes which you
want to make as short as possible,
then choose Auto Height from the
Boxes menu, page 124

Select the box or boxes you want
to change and choose the Auto
Height and Auto Width commands
from the Boxes menu, page 124

Select the box you want to change,
then choose Manual Size from the
Boxes menu, page 124

Select the boxes you want sized
automatically, then choose Auto
Height and Auto Width from the
Boxes menu, page 126
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Making boxes as nar- To make a box as narrow as possible, select the box, then deselect
row as possible the Auto Width command in the Boxes menu.

If the box doesn’t get narrower, then it is already the preset minimum
width (1.25"). In this case, choose Manual Size from the Boxes menu
and enter a narrower width. See “Giving a box a fixed size,” below.

Making boxes as short  To make a box as short as possible, select the box then deselect the
as possible Auto Height command in the Boxes menu.

If the box doesn’t get shorter, then it is already the preset minimum
height (.5"). In this case, choose Manual Size from the Boxes menu
and enter a smaller height. See “Giving a box a fixed size,” below.

Making boxes as small To make a box as small as possible, select the box then deselect both
as possible the Auto Width and Auto Height commands in the Boxes menu.

If the box doesn’t get smaller, then it is already the preset minimum
size (1.25" wide by .5" high). In this case, choose Manual Size from
the Boxes menu and enter a smaller width and height. See “Giving a
box a fixed size,” below.

= Org Plus doesn't let you make a box smaller than needed to show its

information.
Giving a box a fixed You can make a box whatever size you want. However, Org Plus
size doesn’t let you to make the box smaller than needed to show its

information. If you add more information to the box, it may grow
larger than the size you specify at the Manual Size dialog box.

To give a box a fixed size, do the following:

1. Select the box or boxes whose size you want to manually
set.

2. Choose Manual Size from the Boxes menu.

Org Plus displays the Manual Size dialog box, shown in Figure
4-31.
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Enter box dimensions. ..

Manual Sizing (in inches)

Apply to: O All boxes (@ Selected boxes

N\

Height:
Width: &

... or drag the handle
to size boxes

Figure 4-31. The Manual Size dialog box

Type the height and width you want for the selected
boxes.

You can also click the arrows next to the boxes to increase or
decrease the amounts shown.

You can also drag the corner handle any direction to make the
box larger or smaller (see Figure 4-31).

The minimum allowable width is 25". The minimum allowable
height is .125". The maximum size is the size of your chart.

To apply the changes and make additional ones, click
Apply.

If your computer screen is large enough, you can move the
dialog box and see the changes applied to your chart.

If the size still isn’t quite right, you can repeat steps 3 and 4
until your chart looks the way you want.

You can also select additional boxes by making selections from
the Select submenu, entering in the desired sizes, and clicking

Apply.

Click the close box to close the dialog box.
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Restoring automatic To restore automatic sizing to boxes from which it has been removed,

sizing select the boxes and choose both Auto Width and Auto Height from
the Boxes menu. There should be a check mark in front of each
command when you're done.
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Changing text, lines, and box styles

This section describes how you change the appearance of text, lines,
and boxes in your chart. The following table summarizes how to do
this. For more complete instructions, turn to the indicated pages:

To do this...

Do this...

Change font, style,or size
of text

Change the alignment of
text

Change the way people's
names are formatted

Change box borders

Change box shadows

Change connecting line
thickness

Change connecting line

style

Select the text, then choose a font,
style, or size from the Text menu,
page 128

Select the text, then choose Left, Right,
or Center from the Text menu,
page 128

Select the names, then choose a format
from the Name submenu in the Text
menu, page 129

Select the boxes whose borders you
want to change, then choose a border
from the Box Border submenu in the
Boxes menu, page 132

Select the boxes whose borders you
want to change, then choose a shadow
from the Box Shadow submenu in the
Boxes menu, page 132

Select the connecting lines whose
thickness you want to change, then
choose a thickness from the Line
Thickness submenu in the Boxes menu,
page 132

Select the connecting lines whose style
you want to change, then choose a
style from the Line Style submenu in
the Boxes menu, page 132
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Changing text fonts,

styles, and sizes

Changing text align-

ment

Wrapping text across

lines

128
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To change the font, style, or size of text, select the text then
choose a font, style or size from the Text menu.

You can save time if you first select all the text you want to change
— everywhere in your chart — then chose a font, style, or size:

[ | To select all the text in a box, click the box once.

| To select all the text in multiple boxes, Shift-click the boxes, or
drag an outline around them.

See “Selecting all objects of the same type” for more informa-
tion, page 90.

To change the font, size, or style of some but not all information in
multiple boxes, change the label setup (see “Changing the label setup
in order to change text,” page 130).

To change the alignment of text, select the text, then choose
Left, Right, or Center from the Text menu.

You can save time if you first select all the text whose alignment you
want to change —everywhere in your chart — then choose Left,
Right, or Center:

] To select all the text in a box, click the box once.

[ | To select all the text in multiple boxes, Shift-click the boxes, or
drag an outline around them.

See “Selecting all objects of the same type” for more informa-
tion, page 90.

To change the alignment of some but not all text in multiple boxes,
change the label setup (see “Changing the label setup in order to
change text,” page 130).

Most information in your chart, such as names or titles, is usually kept
together on a single line. Some information, such as a job description
or general comments, may look better if wrapped — or split —
across multiple lines, as shown in Figure 4-32.



Moving text

Changing people’s
name formats

President

¥_P Research & Development

Responsible for all R&D
activities, including planning,
design, programming, and
quality assurance.

Figure 4-32. Wrapping long text items across lines

To wrap text, select the text, then choose Word Wrap from the
Text menu.

You can save time if you first select all the text items you want to
wrap, then wrap them:

] To wrap all the text in a box, click the box once, then choose
Word Wrap.

] To wrap all the text in multiple boxes, press and hold the Shift
key while you click the boxes, or drag an outline around them,
then choose Word Wrap.

To wrap some but not all information in multiple boxes, change the
label setup (see “Changing the label setup in order to change text,”
page 130).

You can move text in boxes by moving labels in the Label Setup
dialog box. See “Moving labels,” page 102, for more information.

To change the format of all the people’s names in your chart,
press Command-A to select all the boxes, then choose a desired
name format from the Name submenu, located in the Text
menu.

To change the format of the people’s names in some boxes, select the

boxes whose names you want to reformat, then choose a desired
name format from the Name submenu, located in the Text menu.
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Changing the label You can use the Label Setup dialog box to change the font, size, style,
setup in order to alignment, and wrapping behavior of the information in the boxes of
change text your chart. Whatever you do to a label, Org Plus does to the informa-

tion in your chart.

For example, the figure to the left shows the label setup for the boxes

<Name:> in Figure 4-33.
<Title>
Chris Phillips
President & CED
| I
Lynn Brewer Larry Stevens Tina Nomura
CFO Vice President Coo

Figure 4-33. Before changing the label setup

<Names> Make the Title label bold and italics, as shown in the figure to the left,

and all of the titles in the chart are changed accordingly (see Figure

cFitie> 4-34).

Chris Phillips
FPresiden? & CFO

I |

Lynn Brewer Larry Stevens Tina Nomura
CFaG Vice Fresident £ag

Figure 4-34. After changing the label setup

To change the characteristics of selected information in your chart, do
the following:

1.  Select the boxes whose information you want to change.
2.  Choose Label Setup from the Edit menu.

The Label Setup dialog box appears (Figure 4-35).
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Figure 4-35. The Label Setup dialog box

The Label Setup dialog box shows the labels that have been
created for your chart.

For more information about the Label Setup dialog box, see
“The Label Setup dialog box,” page 98.

Click the label for the information you want to change.
Make the appropriate choices from the Text menu.
You can change the font, size, or style of the information.

You can choose Left, Right, or Center to change the alignment
of the information.

You can choose Word Wrap to change the wrapping behavior
of the information.

Click the Apply button.
The change is made to the information in all selected boxes.

Click the close box to close the dialog box.

For more information about things you can do at the Label Setup
dialog box, see “Changing the label setup,” page 96.
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Changing box borders

and shadows

Changing line

thickness and style

132
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You can choose from among 12 box border styles and 8 shadow
styles.

To change the border or shadow style for boxes in your chart,
select the box or boxes whose border or shadow style you want
to change and choose the style you want from the Box Border
or Box Shadow submenu in the Boxes menu.

A hairline border is drawn with the finest line your printer is capable
of drawing. It appears thicker on your computer screen than it will
when it’s printed.

For more information about box border and shadow styles, see “Box
Border,” page 194, and “Box Shadow,” page 195.
Connecting lines connect the boxes in your chart.
To change their thickness or pattern, select the lines you want

to change and choose a line thickness or style from the Line
Thickness or Line Style submenu in the Boxes menu.

Making your chart more compact

This section describes techniques you can use to make your chart
more compact. If all else fails, you can reduce your chart on a laser
printer or a copier. Org Plus’s Make Fit command tells you exactly
how much you need to reduce it to make it fit on letter size paper.

Keep in mind that virtually everything you do has an effect on either
the width or height of your chart. With a few exceptions, changes
that make your chart shorter make it wider, while changes that make
it narrower make it taller. The goal is to find the optimum set of
changes which produce the most compact chart.

The table on the opposite page summarizes the things you can do to
reduce the size of your chart, and the effect they have on your chart’s
height or width. Refer to the indicated pages for more information.



To do this...

Do this...

Make your chart narrower

Make your chart shorter

Make your chart narrower and
shorter

Use a vertical group style,
page 134

Offset groups beneath their
manager, page 134

Increase the distance between a
group and its manager, page 135

Wrap comments or other long
text values page 136

Abbreviate names, page 136

Use a horizontal group style,
page 137

Rearrange information within
boxes, page 137

Use smaller font sizes, page 138

Use minimum chart margins,
page 144

Reduce spacing between boxes,
page 138

Use the Make Fit command,
page 139
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Making your chart If your chart is too wide, use some or all of the following techniques
narrower to make it narrower.

Use vertical group styles In general, you get the most compact chart by using horizontal styles
for groups at the top of your chart, and vertical chart styles for groups
at the bottom of your chart.

roup styles:

The figure to the left highlights the narrowest group styles. The
narrowest styles are the two list styles, indicated by the arrow.

To change group styles, double-click any box in the groups whose
style you want to change, then choose a narrow style from the Styles
menu. See “Changing group styles,” page 111 for more information.

Start with groups at the bottom of your chart and work your way up,
using the narrowest vertical styles at the bottom, and wider, horizontal
ones at the top.

Assistant styles:

Offset groups beneath In some cases, you can shift a horizontally arranged group of subordi-

their manager nates to save space. The four styles highlighted in the figure to the
left show the offsetting group styles. Figure 4-36 shows the effect of
using one of these styles.

(& File Edit Styles Text Bowes Chart Help ]
Eg[]% Untitled-1 1=
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Figure 4-36. Offsetting a group
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Drag groups down

To change the offset of a horizontal group beneath its manager,
double-click any box in the group and choose the appropriate
style from the Styles menu.

You can sometimes make a dramatic difference in the width of your
chart if you increase the distance between a group and its manager.
Figure 4-37 shows the difference this technique can make. In the

bottom chart, the highlighted groups have been dragged down to get
a more compact chart.

==

Press and bold the Shift
key while you drag any
box in the group down

When you release the mouse

button, Org Plus closes up
the space to make the chart
narrower

Figure 4-37. Displacing groups
To increase the distance between a group and its manager:

1.  Press and hold the Shift key while you drag any member
of the group downwards.

2. Release the mouse button to see the effect of the move.

3. Repeat steps 1 and 2 as many times as desired in order to
get the maximum compactness.

This technique can make your chart more compact but it also makes

the reporting relationships somewhat harder to see. It can also give
an inaccurate sense of status.
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Wrap text

Abbreviate names and

titles

Abbreviating names

Wide text items, such as job descriptions, will make your chart very
wide. You can make your chart narrower by wrapping extra-wide
text values across multiple lines.

For information about how to wrap text, see “Wrapping text across
lines,” page 128. See also “Using the Make Fit command,” page 139.

Abbreviate all information that doesn’t need to be spelled out. This
can significantly reduce the width of your chart, as shown in Figure

4-38.

Chris Phillips

President & Chief Executive Officer

[

"

Lynn Brewer

can make your chart
much narrower
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Larry Stevens
Vice President

Tina Nomura
Chief Operations Officer

\ Chief Financial Officer

C. Phillips
President & CEO

L. Brewer
CFO

L. Stevens
VP

T. Nomura
Ccoo

Figure 4-38. Abbreviating names and titles

To abbreviate names, select the boxes whose names you want to
abbreviate, then choose a style of abbreviation from the Names
submenu, located in the Text menu. See “Formatting people’s
names,” page 108, for more information. See also “Using the Make Fit

command,” page 139.

Org Plus doesn’t automatically abbreviate other kinds of information.

You must do this manually.




Making your chart
shorter

Use horizontal group
styles

Group styles:

Assistant styles:

Making your chart
narrower and shorter

Rearrange information

Your choice of group styles has a major effect on the height of your
chart.

You can make your chart shorter by using the shorter (but wider)
group styles.

The figure to the left highlights the shortest group styles. The shortest
is the standard horizontal style — the top left style in the menu.

To change group styles, double-click any box in the group whose
style you want to change, then choose a wider style from the Styles
menu. See “Changing group styles,” page 111 for more information.

Start with groups at the top of your chart and work your way down,
using the wider styles at the top and the narrower styles at the
bottom.

The following techniques reduce both the width and the height of
your chart.

You can rearrange information in and outside a box to make your
chart narrower or shorter, depending on your need.
To make a chart shorter, arrange information horizontally. To make a

chart narrower, arrange information vertically. See Figure 4-39 on
page 138.
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<Name>

<Title»

§<Department><Telephnne>§

Stack labels in the label
setup to make the chart

narrower

<Name>

<Title>

<Department>

<Telephone>

Use smaller fonts

Reduce spacing between

boxes
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Chris Phillips
President & CEQ
Corinne Speer
Executive Secretary
[ ]
Becci Seuberling Larry Stevens Monty Allen
Vice President Vice President Vice President
Aerospace Systems 799-2345 Automotive Systems 789-7821 Electrical Systems 799-2543

Chris Phillips
President & CEOQ
Corinne Speer
Executive Secretary

[ |

Becci Seuberling Larry Stevens Monty Allen
Vice President Vice President Vice President
Aerospace Systems Automotive Systems Electrical Systems
799-2345 789-7821 799-2543

Figure 4-39. Rearranging information

To make a chart both narrower and shorter, avoid placing information
outside the boxes in your chart.

You can rearrange the information by rearranging the labels in the
Label Setup dialog box. See “Changing the label setup,” page 96.
The point size of the fonts in your chart affect both the height and the

width of your chart. By using smaller fonts, you decrease both.

To make your text smaller, select the boxes whose text you want to
reduce, then choose a smaller size from the Text menu.

See also “Using the Make Fit command,” page 139.
You can reduce the amount of space between boxes at the Spacing

dialog box. See “Changing the distance between boxes,” page 119,
for instructions.




Using the Make Fit
command

There are two ways two basic ways to make your chart fit in a desired
number of pages. One way is to make your chart smaller by using
any or all of the methods described earlier in this section. Another
way is to reduce the chart image by some percent, as you might on a
photocopy machine. The Make Fit command helps you do both.

To use the Make Fit command, do the following:
1.  Choose Make Fit from the Chart menu.

Org Plus opens the Make Fit dialog box (Figure 4-40).

Make Fit

Desired chart size:

Cancel

Pages: 1

Figure 4-40. The Make Fit dialog box

The grid shows a maximum chart area of 10 pages by 10 pages.
Each square represents a page. The pages currently occupied
by your chart are shown by black squares. Figure 4-40 shows
how the Make Fit dialog box would appear for a chart which
spans two pages.

2.  Click in the square that indicates where you want the

lower right corner of your chart to be.

For example, if you want your chart to fit on one page, then
click the top left square. If you want your chart to fit on four
pages (two pages by two pages), position your arrow two
squares over and two squares down, then click. Org Plus
highlights all the rectangles above and to the left of the rect-
angle in which you click.
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You can make your

To select space-saving options, click the Options button.

See “Changing the Make Fit Options” later in this section for
more information.

Click OK to make your chart fit.

If Org Plus can’t make your chart fit in the desired number of
pages, you'll see one of the alert boxes shown in Figure 4-41.

!s Your options have not reduced the chart enough
to make it fit.

However, the chart will fit if you print it on
letter size paper at 7?8 % of its full size.
/

chart fit by reducing
it to the size shown
bere at the Page Setup
dialog box (see Figure
4-42)
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You can change paper and % size at the Page
Setup for some printers. Or print the chart on
letter paper and reduce/enlarge it on a copy
machine.

(_Page Setup ] [ TryAgain ) Iml

s Your options have not reduced the chart
enough to make it fit.

Figure 4-41. Make Fit message boxes
If you see the first alert box, you can:

u Click the Page Setup button to change the
reduction amount at the Page Setup dialog
box (see “Reducing to fit,” page 141), OR...

5 Click the Try Again button to return to the
Make Fit dialog box and change the Make Fit
Options (see “Selecting the Make Fit Op-
tions,” page 142), OR...

[ | Click the Done button to exit the Make Fit
command



Reducing to fit

Reducing on a printer

If your chart has to be reduced to less than 25% of its actual
size in order to fit, you'll see the second alert box in Figure
4-41. From this alert box you can:

& Click the Try Again button to return to the
Make Fit dialog box and change the Make
Fit Options (see “Selecting the Make Fit
Options,” page 142), OR...

] Click the Done button to exit the Make Fit
command

With some printers, as on some copiers, it is possible to “photo-
reduce” a document in order to make it fit in a smaller space. On
these printers, you reduce the document before you print it (see
“Reducing on a printer,” later in this section). On the copiers, you
reduce the document affer you print it (see “Reducing on a copy
machine,” later in this section). In either case, it is helpful to know
the precise percentage you need to reduce it in order to make it fit.
The Make Fit alert message (Figure 4-41) tells you this.

Reducing to less than 50% of actual size can make your text unread-
able: Depending on the fonts in your chart, reducing to less than 50%
of its actual size may make the text too small too read. In any event,
the Macintosh won'’t reduce a document to less than 25% of actual
size. Org Plus displays the second alert box in Figure 4-41 if more
reduction than that is necessary to make it fit.

If your printer can print reduced images, you can specify the amount
of reduction at the Page Setup dialog box (see Figure 4-42).

LaserlWriter Page Setup 52

Paper: @ US Letter (O A4 Letter (O Tabloid
QUus Legal (O BS Letter Cancel

Reduction factor

Reduce or Printer Effects:
Enlarge: %

[X] Font Substitution?
Orientation [ Text Smoothing?
1@ X Graphics Smoothing?
[X] Faster Bitmap Printing?

Figure 4-42. Reducing to fit
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Click the Page Setup button in the Make Fit alert box (Figure 4-41)
and type the number Org Plus showed in the alert message into the
Reduce or Enlarge text box in the Page Setup dialog box. Then click
the OK button in the Page Setup dialog box.

1= In order to compute the amount of reduction, Org Plus assumes
you're printing on letter size paper. If you aren’t, the amount of
reduction shown won'’t be correct. To make your chart fit, use a
different reduction amount, or select letter size paper at the Page
Setup dialog box, then type in the reduction amount supplied by Org
Plus. Then print on letter size paper. ’

Reducing on a copy If your printer can’t print reduced images, you won't see the Reduce

machine or Enlarge text box in the Page Setup dialog box (see Figure 4-42).
Nevertheless, you can print your chart, paste it together, and then
reduce it on a copy machine. If possible, set your copy machine to
reduce to the amount shown in the Make Fit alert box.

Selecting the Make Fit To select the Make Fit Options, click the Options button in the Make
Options Fit dialog box (Figure 4-40). The Make Fit Options dialog box
appears (Figure 4-43). |

Make Fit Options

[0 Names: | £, Last V| [ Minimum margins

[ wrap info: | Camments v|

[ Point sizes: | Bswn b5 ¢ w| [ Cancel ]

Figure 4-43. The Make Fit Options dialog box
Starting out, none of the Make Fit options are in effect. You can

select them, as described below. Org Plus does what you select here
when you press the OK button at the Make Fit dialog box.
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Abbreviating names

F. M. Last
Last
Last, F.
Last, F. M.

Wrapping text

Name

Title
Department

Job Description

You can make your chart significantly smaller by abbreviating
people’s names.

To abbreviate people’s names, do the following:
1. Select the Names check box.

2. Position the arrow pointer over the Names pop-up menu
bar (see Figure 4-43).

3. Press and hold the mouse button while you make a choice
from the pop-up menu, as shown in the figure to the left.

When you release the mouse button, your choice appears in the
pop-up menu bar.

This feature affects only the label that has been marked for automatic
name formatting. See “Formatting people’s names,” page 108, for
more information.

You can make a chart much narrower (but taller) by wrapping text.
Wrapped text flows from one line to the next, as does the text in this
paragraph. Many people don’t want information such as names to
wrap. But some information, such as a job description or comments,
often looks better that way.

To wrap some or all of the information in your chart, do the follow-
ing:

1. Select the Wrap info check box.

2. Position the arrow pointer over the Wrap info pop-up
menu bar (see Figure 4-43).

3. Press and hold the mouse button while you make a choice
from the pop-up menu, as shown in the figure to the left.

When you release the mouse button, your choice appears in the
pop-up menu bar.

See “Wrapping text across lines,” page 128, for more information
about wrapping.
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Using smaller fonts

Downby 1
Down by 2
Down by 3
Upbyit
Up by 2
Up by 3

Minimum margins

Using Org Plus

To make all the text in your chart larger or smaller, do the following:
1.  Select the Point sizes check box.

2. Position the arrow pointer over the Point sizes pop-up
menu bar (see Figure 4-43 on page 142).

3.  Press and hold the mouse button while you make a choice
from the pop-up menu.

When you release the mouse button, your choice appears in the
pop-up menu bar.

Many fonts are available in the following sizes: 9, 10, 12, 14, 18, and
so on. If you choose Down by 1, all text is resized to the next
smallest available point size. For example, 18 point text is made 14
point, 14 point text is made 12 point, and so on. Text with the
smallest available point size is reduced by the number in the menu
command. For example, if you choose Down by 2 and 9 point is the
smallest available size, 9 point text will be reduced to 7 points.

Click this item in the Make Fit Options dialog box (Figure 4-43 on
page 142) to set the margins to the minimum permissible on the
chosen printer. Org Plus will only use minimum margins if it makes
your chart fit in the desired number of pages. Minimum margins are
the non-printing area on laser printers such as the LaserWriter, and at
least 1/8th inch on the ImageWriter and other printers, depending on
the printer.



Cutting and pasting
between charts

Working with multiple charts

You can cut and paste to copy or move boxes from one chart to
another. You can also cut and paste to split larger charts into multiple
smaller charts, or merge smaller charts into single, larger charts.

If you're creating charts for a large organization, you can create a
basic chart stationery for your organization, then create a book of
charts.

The following table summarizes these procedures. For more complete
instructions, turn to the indicated pages:

To do this... Do this...
Transfer boxes from one chart Cut boxes from one chart and
to another paste them onto their manager in

another chart, page 145

Merge smaller charts into a Cut and paste branches from one

single, larger one, or break chart to another, page 145

larger charts into several smaller

ones

Create a book of charts Create and use Org Plus stationery,
page 148

To move boxes — including entire branches — from one chart to
another, do the following:

1. Select the boxes you want to transfer to another chart.
To select an entire branch, click the topmost box in the branch,
then choose Branch from the Select submenu, located in the
Edit menu. You can also press Command-B.

2. Choose Cut or Copy from the Edit menu.
The selected boxes, including their information and their labels,

are copied to the Clipboard (a temporary storage place in your
computer).
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Matching labels in
different charts

146

3.  Open the chart you want to move the boxes to.

If the chart is already open, choose it from the bottom of the
Chart menu.

4.  Click the new manager for the boxes on the Clipboard.

5. Choose Paste from the Edit menu. |
Boxes are pasted as subordinates of the selected manager.
If the labels in one chart do not match the labels in the other

chart, the Match Information dialog box appears. See “Matching
labels in different charts,” immediately below, for instructions.

The Match Information dialog box (Figure 4-44) lets you match the
labels for the information on the Clipboard with the labels in the chart
you’re pasting to.

Labels in the chart
you are pasting into

Labels for the boxes on
the Clipboard -- the
ones you are pasting

Using Org Plus

Match Information
L Drag labels up to match:
Telephone =
Department = d
Title = Title
Name = Name
‘ Salary
Phone number
Extension |
I |
<a] 1

Figure 4-44. The Match Information dialog box

The labels for the chart you're pasting to appear on the left side of the
dialog box. The labels for the information on the Clipboard appear
on the right. Org Plus automatically matches equivalent labels.

Labels that do not match appear on the right below the dotted line.



On Clipboard:

Tom Jones
794-6850
%1125

After pasting:

Tom Jones
794-6850 k1125

In the example (Figure 4-44), both charts have Name and Title, but
the chart has Telephone while the Clipboard has Phone Number. In
addition, the Clipboard has Salary and Extension, while the chart has
Department.

To match the labels, drag each label up until it is opposite its
equivalent label, then click OK.

Figure 4-45 below shows how you could match up the labels shown
in Figure 4-44 on page 146.

Match Information
Drag labels up to match:
Telephone = Phone number
Extension
Department =
Title = Title
Name = Name
 Salary
<a]

Figure 4-45. After matching labels

In the example, you would drag Phone Number up opposite Tele-
phone.

You can drag multiple labels up so that they are opposite a single
label. In Figure 4-45, Phone number and Extension have been
dragged up opposite Telephone. The telephone and extension
numbers, which are separate in the Clipboard’s boxes, will be joined
together when pasted, as shown in the figure to the left.

To paste information that doesn’t have an equivalent label, such as
Salary in the example, you must first create an equivalent label in the
chart you're pasting to. See “Creating labels,” page 100, for instruc-
tions.
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Creating books of

charts

Using Org Plus

You only have to match labels for the information that you want to
paste. You don’t have to paste all the information on the Clipboard.
Leave labels for information you don’t care about below the dotted
line.

A book of charts is a set of separate charts which, as a whole,
present the entire organization. Typically, each chart fits comfortably
within a single page and depicts a separate department or division of
the organization. Each chart in the book has the same basic design.
You create the basic design once and save it as chart stationery. Each
department or division uses the stationery when they need to create a
chart. The stationery helps ensure a common look to all the charts
created for your organization.

A book of charts is an effective and practical way to present a very
large organization.

To create a book of charts, do the following:
1. Create a stationery chart for your organization.
See “Creating your own stationery,” page 167.

2. Create new charts for your organization using your new
stationery.

See “Opening stationery,” page 168.

You're free to modify each chart as needed. Using stationery
simply helps you preserve a basic uniformity among all your
charts.

3. Save each chart under a different name.

To print a book of charts, select the charts at the Finder, then choose
Print from the File menu.

Before printing and distributing a book of charts, you might want to
devise a scheme for sequencing and numbering the charts. As with
any book, your book of charts might have a table of contents, or an
index.



Showing/hiding boxes

Special effects through showing and
hiding

You can produce special effects by selectively showing or hiding
boxes and branches in your chart. You can also preview your chart
as it will appear when printed by hiding all non-printing screen
elements.

The following table summarizes how to get these special effects. For
more complete instructions, turn to the indicated pages:

To do this... Do this...

Create custom group styles Create a hidden manager box,
page 149

Show one group while hiding Hide the branches you don't want

others in your chart, page 150

Preview your chart as it will Hide branch symbols, page 203,

appear when printed and page lines, page 152

You can create and then hide a box in order to create special group
styles. Some sample styles created by this technique are shown in
Figure 4-46 on page 150.

To hide a box, select the box you want to hide and then choose
Hide Box from the Boxes menu.

Hidden boxes are just like other boxes, except that they don’t appear
in your chart. You can select them, type into them, change their
styles, and anything else that you could do with visible boxes —
except print them.

To show a hidden box, click it, or drag a rectangle around the

general area where you know it's located, and then choose
Show Box from the Boxes menu.
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Blue boxes show the
location of some of
the bhidden boxes
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Showing/hiding
branches

Before:

After:
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Figure 4-46. Sample group styles created by means of bidden boxes

You can show or hide any branch in your chart. Figure 4-47 shows a
chart with all branches hidden except Tina Nomura’s. You can hide
all the branches except the ones you're interested in. This makes it
easier to focus on them. Hiding branches can also save you time.
See “Time saving measures” on page 212.

To hide a branch, select the topmost box in the branch and
then choose Hide Branch from the Boxes menu.

Org Plus hides all of the subordinates of the selected box and refor-
mats your chart.

To show a hidden branch, select the topmost box in the branch
and then choose Show Branch from the Boxes menu.

You can also click the branch symbol in the lower right corner of the
topmost box, as shown in the figure to the left. If the branch symbol
isn’t visible, choose Show Symbols from the Chart menu.

Click the branch symbol once to hide the branch, a second time to
show it again.



Tina Normura's branch

£ i Py
LE R Sk

|
il

L{-
i
[
ﬁ_

[ Ty
ks

Branches below these
managers are bidden

Showing/hiding
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Figure 4-47. Chart with bidden branches

The branch symbol never prints — it is only there to let you show or
hide the branch.

By hiding connecting lines, you can make boxes seem to float by
themselves — unattached to the rest of your chart, as shown in the
figure to the left.

To hide connecting lines, Shift-click the line segments you want
to hide and then choose None from the Line Thickness sub-
menu, located in the Boxes menu.

You can also drag an outline around the group of line segments you
want to hide.

To show a hidden line, drag an outline around the area contain-

ing the line and then choose any line thickness other than None
from the Line Thickness submenu.
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Showing/hiding page
lines

Top margin ;
) Lo Ve s

Page lines give you additional information about your chart.

To show or hide page lines, choose Show (or Hide) Page Lines

from the Chart menu.

Title areas

Left margin

Page border

Previewing your chart

152 Using Org Plus

Figure 4-48. Page lines

Margin lines appear around the outer edges of the chart page area.
You can drag them to change the margins. See “Changing your chart
margins,” page 172.

Title area lines show special areas where you can type chart titles.
See “Creating titles,” page 162.

Page border lines show you where your chart crosses pages. They
also show you at a glance how many pages are needed to print your
chart.

Hide page lines (and symbols) for a true preview of your chart as it
will appear when printed. Even when they are shown, however,
page lines and branch symbols are never printed — they only appear
on your computer screen.



Special effects through manual drawing

Org Plus has four special draw tools that you can use to create effects
not otherwise possible with the standard box tools.

The following table lists some of the special effects you might want to
create. You might think of additional ones, as well. For complete
instructions, turn to the indicated pages:

To do this...

Draw a border around your
chart

Draw a rectangle around a
group of boxes

Draw lines to separate groups
of boxes in your chart

Draw lines to point to things in
your chart

Draw connecting lines between
two boxes in separate groups
(to show “dotted line” relation-
ships)

Use the Rectangle tool, page 155
Use the Rectangle tool, page 155
Use the Perpendicular Line tool,

page 156

Use the Diagonal Line tool, page
157

Use the Connecting Line tool, page
158
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Displaying the
drawing tools

About the drawing
tools
154 Using Org Plus

Starting out, the drawing tools are not displayed along with the other
tools. They should only be used for creating special effects like those
described in this section.

To show the drawing tools, choose Show Draw Tools from the Chart
menu. The drawing tools appear in the upper right corner of your
window (see Figure 4-49).

f & File Edit Styles Tent Boxes Chart Help ]
lE=————————— Untitled-l ———————[15|

Y | T lO\ | Subordinate: lE” Co-worker: E“El | Manager: [E I Assistant: E”+ | ~ l o | (]

Perpendicular Line tool 7
Diagonal Line tool

Connecting Line tool
Rectangle tool

Figure 4-49. The special drawing tools

To hide the tools when you’re finished with them, choose Hide Draw
Tools from the Chart menu.

Imagine that there is a transparency lying on top of your chart. When
you hand-draw objects with the special drawing tools, you draw them
on this transparency, not on the chart itself. To the eye, there is only
one drawing, but you really have fwo drawings: your chart, which is
drawn automatically by Org Plus, and a second, transparent overlay
containing your hand-drawn objects.

The two drawings are independent of each other. Org Plus moves
the boxes in your chart as you create or delete them, but your hand-
drawn objects stay where you draw them. Depending on how your
chart changes, it is entirely possible that its boxes and lines may end
up overlapping your hand-drawn objects.

You can move your hand-drawn objects if necessary, but you can
avoid the overlapping problem if you always use the special drawing
tools as the last step before printing your chart.



Using the Rectangle
tool

The Rectangle tool lets you draw rectangles (boxes) that are not
drawn automatically by Org Plus. The rectangles you create with the
Rectangle tool are transparent — you can see what is underneath

them.

Figure 4-50 shows a couple special effects you can create with the
Rectangle tool.

Draw a border
around your chart

Apollo
Task Force

Draw a rectangle
around a special

group

Figure 4-50. Creating extra boxes

You can draw rectangles anywhere in your chart:

1.

Choose Show Draw Tools from the Chart menu to display

the draw tools.

Click the Rectangle tool, as shown in the figure to the left.

Your pointer changes to a crosshair (like a plus sign).

Position the pointer over the exact place where you want
the top left corner of the rectangle to appear.

Press and hold the mouse button while you drag to the
opposite corner of the rectangle, then release the mouse

button.

Org Plus draws the rectangle.
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You can change the border or shadow of any rectangle by selecting
the rectangle, then choosing a border or shadow from the Box Border
or Box Shadow submenus, located in the Boxes menu. You can also
change the line style of the rectangle by selecting the rectangle and
choosing a style from the Line Style submenu, also located in the
Boxes menu.

For more information about box border and shadow styles, see “Box
Border,” page 194, and “Box Shadow,” page 195.

For more information about line styles, see “Line Style,” page 196.

"5 To select a rectangle, you must click on the rectangle border.

Using the The Perpendicular Line tool lets you draw vertical or horizontal lines
Perpendicular Line that are not drawn automatically by Org Plus. Figure 4-51 shows a
tool sample of how you can draw extra horizontal lines and text to make

your chart clearer to people.

Draw extra lines to

clarify groupings of CRiafExecutive ==
boxes Proeet & O |
N ==

Executive Staff

Tpmratioms Ty A me ,m‘ Emcirion Sgrines
\ | T - Romurs i Bex| Sesturiing i Larr g Hervers d :-::::q‘:_ 1
Project
Management e | Hemam
e
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i

Figure 4-51. Using extra lines and text

See “Annotating your chart,” page 161, for information about creating
extra text, as shown in Figure 4-51.

To draw a vertical or horizontal line, do the following:
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Using the Diagonal
Line tool
-+ -

Choose Show Draw Tools from the Chart menu to display
the draw tools.

Click the Perpendicular Line tool, as shown in the figure
to the left.

The pointer changes to a crosshair (like a plus sign).

Position the pointer over the exact place where you want
the line to begin.

Press and hold the mouse button while you drag to where
the line should end, then release the mouse button.

Drag up or down to create a vertical line; left or right to create
a horizontal line.

You can change the thickness and style of any line by selecting the
line, then choosing a line thickness or style from the Line Thickness
or Line Style submenus, located in the Boxes menu.

Use the Diagonal Line tool to draw diagonal lines in your chart. You
can use diagonal lines to draw the chart viewer’s attention to some
object in your chart, or to draw a polygon such as a diamond.

1.

4.

Choose Show Draw Tools from the Chart menu to display
the draw tools.

Click the Diagonal Line tool, as shown in the figure to the
left.

The pointer changes to a crosshair (like a plus sign).

Position the pointer over the exact place where you want
the line to begin.

Press and hold the mouse button while you drag to where
the line should end, then release the mouse button.

You can change the thickness and style of any line by selecting the
line, then choosing a line thickness or style from the Line Thickness
or Line Style submenus, located in the Boxes menu.
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Using the Connecting
Line tool

Use the Connecting Line tool to draw a connecting line between any
two boxes in your chart. You might do this to show a dotted line
relationship, as shown in Figure 4-52.

Draw connecting lines
to show special reporting
relationships

L=
i

158 Using Org Plus

Figure 4-52. Dotted line relationships

In general, you should rearrange your chart to position boxes with
connecting lines as close to each other as possible. This makes your
chart look less complicated, and reduces the chance the lines and
boxes will overlap. See “Rearranging boxes in your chart,” page 110,
and “Moving boxes,” page 115, for more information.

1.

Choose Show Draw Tools from the Chart menu to display
the draw tools.

Click the Connecting Line tool, as shown in the figure to
the left.

Position the pointer over the edge of the box from which
the line should extend.

Press and hold the mouse button while you drag the
pointer over the edge of the box you want to connect the
first box to, then release the mouse button.

The Connecting Line tool can draw lines with a maximum of
three angles. This is enough to connect any two sides of any
two boxes in your chart.



Adjusting connecting

lines

Drag line left or right to

reposition it

You may need to adjust connecting lines to prevent them from
overlapping boxes in your chart. Overlapping may occur when you
first create the line, or after Org Plus redraws the underlying chart.

You can only adjust connecting lines that have three or more
segments.

To adjust a connecting line with three or more segments, do the
following (see the example in Figure 4-53):

1.  Position the pointer over the line segment which needs
adjusting.
You can't adjust the lines which come out of a box.
2. Press and hold the mouse button while you drag the line
segment left/right or up/down.
The direction in which you can drag depends on whether the
line is vertical or horizontal. In Figure 4-53, the line is vertical,
so you can drag left or right.
3. Release the mouse button.
| |
Operzations Aerospace Systems
Tina Namura ez =N Becri Seuberling
Chief Qperations Officer ‘{']. Yice President
Jerm DAngelo 1Fel Stannard Connie Hes
| Production d'rujecl'. Merager Project Mermger
JamesCendlin [ 3
| Human Resaurces
[ 1
Operations Aerospace Sy=stems
Tina Namura N L Becri Seuberling
Chief Opervtiona Dfficer ‘u. Yice President
Jerm [FAngelo E Peul Stannard Connie Hessx
Production - Project Mermger Project Mermger
JamesCendlin | |
Hurmen Resaurces

Figure 4-53. Dragging a connecting line
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You can change the thickness and style of any line drawn with the
Connecting Line tool. Select the line, then choose a line thickness or
style from the Line Thickness or Line Style submenus, located in the
Boxes menu.



Sub

Annotating your chart

Annotations are extra text that you add to your chart to make it
clearer to the people who look at it. To create annotations, use Org
Plus’s Text tool, located in the upper left corner of the chart window

(see figure to the left).

The following table summarizes the techniques you can use to
annotate your chart. For more complete instructions, turn to the

indicated pages:

You can put annotations anywhere on your chart using the Text tool.
You should enter titles in the special title areas.

To do this...

Do this...

Create standard titles

Create miscellaneous annota-
tions such as explanatory
captions

Draw boxes around text annota-
tions

Enter text in the title areas, page
162

Use the Text tool, page 163

Select the text and choose a box
border or shadow, page 164
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Creating titles

162

Top left, center, and
right title areas

Bottom left, center,
and right title areas

Using Org Plus

Title areas appear within dotted lines below the top margin and above
the bottom margin, as pictured in Figure 4-54. If the dotted lines do
not appear in your chart, choose Show Page Lines from the Chart
menu.

r ® File Edit Styles Text Boxes Chart Help 1

Untitled-1

Figure 4-54. Title areas
There are six title areas:

Top left

Top center
Top right
Bottom left
Bottom center
Bottom right

To enter text into any title area, do the following:

1.  Choose Show Page Lines from the Chart menu.

2. Click in the area where you want to type.
Org Plus automatically aligns titles to the left in the top left and
bottom left areas; aligns titles to the right in the top right and

bottom right title areas; and centers titles in the top center and
bottom center title areas. You can change a title’s alignment by




Why use title areas?

Creating annotations

JAuthorized by: John Smitry

Resizing annotation
areas

I

clicking in the title area and choosing Left, Right, or Center from
the Text menu.

You can apply any font, size, or style to text in title areas.

Although you can enter text anywhere in your chart (as explained in
“Creating annotations,” below), the title areas are special:

[ Title areas expand and contract as your chart expands and
contracts; so the location of the titles relative to your chart
always remains the same.

[ | Title areas and the chart never overlap, no matter what you do.

You can place annotations anywhere in your chart: click the Text tool,
then click where you want to type and start typing.

When you click off of the annotation, handles appear at all four
corners of the area occupied by the annotation. You can resize that
area by dragging the handles. See “Resizing annotation areas,”
immediately below. You can also draw a box around that area. See
“Drawing boxes around annotations,” page 164.

You can apply any font, size, or style to any annotation.

Always create annotations as the last step before printing your chart:
Imagine that there is a transparency lying on top of your chart. When
you type text in any area other than the title areas and the boxes of
the chart, you are typing onto this transparency. If Org Plus has to
redraw your chart, the location of the annotation you type relative to
the rest of the chart may be different. You can avoid this problem
altogether if you always enter annotations as the last step before
printing your chart.

To resize an annotation area:

1.  Click the Selection Arrow tool in the upper left corner of
the window.

28 Click anywhere on the annotation area you want to resize.

Handles appear at the four corners of the annotation area.
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3.  Drag the handles to resize the annotation area.
You can make the annotation area larger or smaller. Org Plus

rearranges the annotation to make it fit in the annotation area.

Drawing boxes around To draw a box around an annotation area:
annotations
1.  Click the Selection Arrow tool in the upper left corner of
the window.

2.  Click the annotation you want to draw a box around.

3. Choose a box border from the Box Border submenu,
located in the Boxes menu.

Org Plus draws a box around the selected annotation area.
You can also choose box shadows from the Box Shadow
submenu, or a line style from the Line Style submenu, both

located in the Boxes menu.

For more information about box border and shadow styles, see
“Box Border,” page 194, and “Box Shadow,” page 195.

For more information about line styles, see “Line Style,” page

196.
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Pasting pictures into your chart

You can paste PICT formatted pictures anywhere in your chart. PICT
is a special graphic format used by many Macintosh applications. You
must first create the pictures using one of those applications.

1.  Copy the picture to the Clipboard in the other application.

See the manual for the application in which you create the
picture.

2.  Open the chart you want to paste the picture into.

3. Click in the exact place where you want the picture to
appear.

4. Choose Paste from the Edit menu.

The picture is pasted onto the chart. You can then drag it
wherever you want it.
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Printing your chart

Use the standard Macintosh Print command to print your charts.

The following table summarizes the various printing options:

To do this... Do this...

Print the current chart from Choose Print from the File menu
within the application and click the OK button

Print a chart from within the Select the icon for your chart and
Finder choose Print from the File menu

Print multiple charts from within  Select the icons for your charts and
the Finder choose Print from the File menu

See the section on printing in your Macintosh owner’s manual for
detailed instructions.



Creating your own
stationery

Customizing Org Plus

You can create stationery to make a basic chart for you or your
organization. This ensures a common look to all your charts while
minimizing the work you need to do when creating them.

You can also change Org Plus’s preset options to suit your own
needs.

Stationery is a special type of chart containing the basic design and
settings used routinely by you or your company. Stationery is like a
pad of preprinted charts with empty boxes. When you open a
stationery chart, you “tear off” a standard chart from the pad. You
type in information that is unique to your new chart without having to
redo the elements that are standard to all charts. Then you save the
filled-in chart with its own name.
Some predesigned stationery has been included on your System disk.
To create your own stationery, do the following:
1.  Choose New from the File menu.
2, Change the label setup for the topmost box in your chart.
See “Changing the label setup,” page 96, for instructions.
All other boxes that you create will then have the same setup.

3. Create a standard chart.

Create a template organization. Figure 4-55 on page 168 shows
an example.

Do not enter information in the boxes of the chart.

4. Add pictures, text, and other elements that are common to
all the charts that you intend to create.

5. Change the margins, dialog box settings, and menu
settings to those you like to use.

6.  Choose Save Stationery from the File menu.
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Opening stationery

Using Org Plus

We recommend you save stationery in a separate folder named
“Stationery,” in order to keep it separate from other non-
stationery charts.

Yo Type a name for the stationery.

8. Click OK.

A Allen Menufecturing

Figure 4-55. Stationery for the Allen Company.

When you open a stationery chart, Org Plus makes a copy of the
stationery chart for you to change as needed. You then save the chart
under a different name.

To open stationery:

1. Choose Open from the File menu.

2, Click the name of the stationery.

3.  Click Open.

Org Plus creates a new, untitled copy of the stationery chart.
You can now change this chart just like any other chart.



Changing preset
options

Changing the preset
options for new charts

Preset options are the initial menu and dialog settings used by

Org Plus when you start the application or open a chart. You can see
what they are by pulling down the menus and opening the dialog
boxes when nothing in your chart is selected. For example, click in
the background of your chart to deselect anything that may be
selected, then pull down the Text menu. Check marks appear next to
the preset point size and alignment commands. Choose Page Setup
from the File menu to open the Page Setup dialog box — you’ll see
the preset paper, orientation, and so forth.

You can change the preset options for all charts you may create in the

future, or change them for the current chart only. This section tells
you how.

To change the preset options for charts you may create in the future,
do the following:

1.  Open the application.

2. Choose Preferences from the Edit menu.

The Preferences dialog box appears. See Figure 4-56 on
page 171.

If you want to change the preset chart margins, first set the
margins to the desired sizes in the current chart, then choose
Preferences. (See “Changing your chart margins,” page 172, for
instructions.)

3. Change the options in the Preferences dialog box.

See, “The Preferences dialog box,” page 170, for details.

4. Open, change, and close the dialog boxes whose preset
options you want to change.

Dialog boxes appear when you choose a menu command that
has three trailing dots (for example: “Page Setup...” in the File
menu).

5. Choose the menu commands you want to preset.

For example, to change the preset group style, choose the
group style you want from the Styles menu.
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Changing the preset
options for existing

charts

The Preference dialog
box

170 Using Org Plus

To change the preset type font, size, and style for information
in your chart’s boxes, choose Label Setup from the Edit menu,
select the labels whose font, size, and style you want to change,
then choose commands from the Text menu.

6. Click the OK button in the Preferences dialog box.

To change the preset options for a chart that has already been cre-
ated, do the following:

1. Open the application.
2.  Open the chart whose preset options you want to change.

3.  Click on the background of the chart to deselect anything
that may be selected.

4.  Choose the menu commands you want to preset.

You can change the preset Styles and Text menu commands only.
Preset Text settings affect annotations and text in the edit panel only.

Your choices are stored with your chart when you save it, and are
used the next time you open it.

In addition to changing dialog box and menu options, you can
change three chart-wide options in the Preferences dialog box, as
shown in Figure 4-56.

The “unit of measurement” determines whether margins or box
dimensions are measured in inches or in centimeters. See “Changing
your chart margins,” page 172, and “Giving a box a fixed size,”

page 124.

The “overlap between chart pages” setting determines how much
overlap — or duplication of your chart — appears at the edges of the
pages when your chart is printed, as illustrated in Figure 4-57.



Overlap area is printed

Preferences

Unit of Measurement: @& Inches O Centimeters

Overlap between chart pages: @

Also, choices you make now from menus and
dialogs become preset options for new chart

documents.

Figure 4-56. The Preferences dialog box

Overlap printing makes it easier to tape together a chart printed on
multiple pages. It is valid only when your chart spans multiple pages.
If your chart spans multiple pages horizontally, Org Plus duplicates
the right edge of one page on the left edge of the following page. If
your chart spans multiple pages vertically, Org Plus duplicates the
bottom edge of the upper page on the upper edge of the lower page.
The overlap amount is the same in both directions. The number 0.00
indicates that there is no overlap printing. Figure 4-57 shows about
an inch of overlap printing.

on both pages to belp
‘you paste charts together
afterwards

|
]

Figure 4-57. Overlap printing
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Changing your chart
margins

172

Drag the margin
lines to set margins

Using Org Plus

Org Plus’s preset margins are set to an absolute minimum in order to
permit drawing on as much of the page as possible.

In general, you probably won’t need to change these margins; but if
you do, here’s how:

1.  Choose Size to Window from the Chart menu.

This step is optional. It allows you to see all the margins at the
same time. However, you can see portions of the margins and
still change them.

2. If the margin lines aren’t visible, choose Show Page Lines
from the Chart menu.

You have to make page lines visible in order to see and change
the margins.

3. Click and drag any margin line to where you want it.
There are four margin lines, one for each margin, as pictured in
Figure 4-58. When you move the pointer over any of these
lines, the pointer changes automatically to show you the
direction in which you can drag. As you drag, Org Plus shows
the actual width of the margin.

( & File Edit Styles Tent Bowes Chart Help )

Untitled-1

Figure 4-58. Changing margin lines
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If you own a laser printer. Laser printers can’t print within .25"
(roughly) of any edge of the paper. This is a limitation of the printer
hardware, not of the application. That unprintable border determines
the minimum margin for Org Plus charts.

Using Org Plus 173




Chapter 5: Reference

This chapter provides a description of every icon, control, and menu
command in Org Plus — everything you see while you’re using the
program.

For step-by-step instructions on how to do basic chart operations, see
Chapter 4, “Using Org Plus,” page 73.

The Chart window

The Chart window appears when you create a new chart or open an
existing one (Figure 5-1). You can open up to 16 charts at one time,
depending on how much memory your system has, and how many
other non-Org Plus windows are open.

Menu bar——{ [ & File Edit Styles Teut Bowes Chart Help
===—————————— Untitled-1 %E}

Bl
Toolpalette —[ h T |‘5§1|Subordi nate:@ ICo-worker: EI IE”Manager:@ | Assistant: l

Title areas

Topmost box Title>

Status area ——— uSize: 100% Ko

Figure 5-1. The Chart window for a new chart

The menu bar and the tool palette contain all the commands and
tools you need to create and update your charts.

You can enter chart titles in the title areas.
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The status area, located in the lower left corner of your window,
ordinarily shows the current level of chart magnification. In Fig-
ure 5-1, the chart is shown at actual size — the size it will appear
when printed.

The other controls you see are standard Macintosh items. See your
Macintosh owner’s manual for more information.

The tool palette The tool palette contains tools that you use to change your chart.

|
|

( ® File Edit Styles Text Boxes Chart Help ]

Ee———————— Intitled-| =—r———————1-}

Selection Arrow T |£§'-élSubordi nate:@ ICo—worker: @ @ IManager:EI lAssistam: |
Text tool / / // / / ;
Reduce/Enlarge tool ‘
= p i /.

Subordinate box tool

Co-worker Before box tool —

Co-worker After box tool ~ |

yd 2
- A

Manager box tool

.

Assistant box tool
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.Size:

100% Kaf

Figure 5-2. The tool palette

The Org Plus tool palette has eight tools:

The Selection Arrow tool for selecting and dragging objects,
choosing menu commands, and clicking window and dialog
box controls.

The Text tool for typing text into boxes and other areas of your
chart. The arrow pointer automatically changes to an I-beam
when you move it over text in a selected box.



e The Reduce/Enlarge tool for reducing your chart so that it fits
in the window, or for magnifying any part of your chart. A
magnifier appears if your chart is reduced. A chart symbol
appears if your chart is already at actual size. (See the figures
to the left).

| The Subordinate box tool for creating a subordinate to an
existing box.

= The Co-worker Before box tool for creating a co-worker
above or to the left of an existing box. Whether the box
appears to the left or above depends on the group style.

| The Co-worker After box tool for creating a co-worker below
or to the right of an existing box Whether the box appears to
the to the right or below depends on the group style.

u The Manager box tool for creating a manager to an existing
box.

¥ The Assistant box tool for creating an assistant to an existing
box.

To learn how to use the tools, see “Creating and deleting boxes,”
page 79, and “Viewing your chart at actual and reduced sizes,” page

93.
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The Apple menu

The Apple menu contains one Org Plus related command.

About Org Plus... Displays a box containing information about Org Plus. You can then
go directly to the Help dialog box.

Yersion 1.0
Copyright, 1990

o7 1 ‘[ s All rights reserved.
= T L Banner Blue Software Incorporated

Licensed to:

for Macintosh

Chris Phillips
Allen Manufacturing

Figure 5-3. The About Org Plus dialog box

For more information about the Org Plus on-line help feature, see
“On-line help,” page 14.
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New %N
Open... %0
Close 88[01
Save 3
Save as...

Save Stationery...
Revert to Saved...

Page Setup...
Print... %P
Quit 380
New
#EN

The File menu

The File menu contains standard commands for creating, opening,
saving, and printing charts, and for quitting a session with Org Plus.
These commands do the same things as in most other Macintosh
applications.

Creates a new chart and displays the New Label Setup dialog box,
shown in Figure 5-4. You can also press Command-N to create a new
chart.

r % File Edit Styles Text Bosxes Chart Help

EI=—————— intitled-| —F88————————
Assistant: El l I

k | T IO\ISubordinate: @I Co-worker: El @ [ Manager : @

What do you want in each box? (click one) ||

<Name> <Title>
ther
Titles <Name> Othe

ISize:

Figure 5-4. A new chart, with New Label Setup dialog box

The New Label Setup dialog box lets you choose or define the labels
for the information you want to enter in each box.

See “Creating a new chart,” page 74 for more information.
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Open...
%0

Click bere to change
Jfolders

Click bere to open a
Sfile with a different
format

Displays the Open dialog box, shown in Figure 5-5, from which you
can retrieve a chart from disk and display it in a window. You can
also press Command-O to display the Open dialog box.

Open chart

Org Plus
{€9 Org Plus | S

O samples 10,276K available
O Stationery

O Tutorial

i jpot

{Iipe

i

]

Cancel

File formats: | Org Plus for Mac v |

Org Plus for Mac
0Org Plus for I1BM
File formats:| Text
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Figure 5-5. The Open dialog box
At the Open dialog box, you can:

B Change folders by choosing a folder from the pop-up menu
located above the scrolling list (see figure above).

[ ] Find a chart in the list by scrolling the list or by typing the first
letter of the chart’s name.

[ | Open an Org Plus chart by clicking the chart name then clicking
the Open button, or by double-clicking the chart name.

5] Open a document created by anotber application by choosing a
file format from the pop-up menu located below the scrolling
list, then finding and opening the document (see figure above).

[ | Open Org Plus stationery by double-clicking the Stationery
folder, then double-clicking the stationery chart name. (See
“Creating your own stationery,” page 167.)

| Open a chart on another disk drive by clicking the Drive button
until the disk name appears (or by inserting the disk containing

the chart), and then by opening the appropriate chart.

® Eject a disk by clicking the Eject button.



Close
B W

Save
#S

Save As...

Closes the current (frontmost) chart without quitting the application.
You can also press Command-W.

Saves the current chart on your disk. You can also press Command-S.

While you save a chart, Org Plus shows the percent saved in the
status area (the lower left corner) of the window. (See Figure 5-1 on
page 177).

When you save a chart for the first time, Org Plus displays the Save As
dialog box so that you can give the chart a name. (See Figure 5-6.)
Thereafter, the chart is always saved with that name unless you
choose Save As from the File menu. See "Save as..." below.

Save your chart frequently! Your chart is stored in the computer’s
electronic memory while you're working on it. If you should lose
power while working on a chart, all changes you have made since
you last saved it will be lost.

Displays a dialog box that lets you save the current chart under a
different name. It also lets you save the chart with a different file
format.

Save chart

DY fipolio Bocumenladl,,
0y sipolio LIPS Haew 0.2,
Dy fipalio £PS Bep 1.6
0y fipolio £PY H-foupy
[0 Samples

[0 Stationery

¢ = Banner Blue

firet

e

Save chart as:

[untiteas |

Click bere to save your
chart with a different file
format

File formats: | Org Plus for Mac |

Figure 5-6. The Save As dialog box

Reference 183




Save Stationery...

Revert to Saved...

Reference

At the Save As dialog you can:

[ Save the current chart under a different name by typing the
name and clicking the Save button.

[ Save the current chart with a different file format by choosing a
format from the pop-up menu located below the document list,
then clicking the Save button.

[ Save to a different disk drive by clicking the Drive button until
the drive’s name appears, then clicking on the Save button.

[ Save to a floppy disk by inserting the disk in the drive, then
clicking on the Save button.

Saves the current chart as stationery.

Stationery is a special type of chart that can contain the basic chart
design and settings used routinely by you or your company. Station-
ery is like a pad of preprinted charts with empty boxes. When you
open a stationery chart, you “tear off” a standard chart from the pad.
You type in information that is unique to your new chart without
having to redo the elements that are standard to all your company’s
charts. Then you save the filled-in chart with its own name.

You can have as many different stationery charts as you like.
Throws away all the changes you've made since you last saved your
chart.

Org Plus asks if this is really what you want to do before it does it.



Page Setup...

Displays a dialog box that lets you change the page size, orientation,
and special printing effects for your chart.

Laserllriter Page Setup 5.2

Paper: @ US Letter (O A4 Letter O Tabloid
QO US Legal (O BS Letter

Org Plus can tell you
what this number should
be in order to make your
chart fit on a single page

=

Print...
*P

Quit
®Q

Reduce or Printer Effects:
Enlarge: %

[< Font Substitution?
Orientation X Text Smoothing?

e X Graphics Smoothing?
B =00
: i ] Faster Bitmap Printing?

Figure 5-7. The Page Setup dialog box for the LaserWriter

Org Plus can tell you what the Reduce or Enlarge number should be
in order to make your chart fit on a page. See “Using the Make Fit
command,” page 139.

The Page Setup dialog box varies for different printers. See your
Macintosh owner’s manual or the manual that came with your printer
for more information about the page setup options for your particular
printer.

Displays the Print dialog box, from which you can print the current
chart. You can also press Command-P to see this dialog box.

LaserWriter Plus |'

52
l:opies:l_L__l Pages: @ All O From: To: l:l
Cover Page: @ No O First Page O Last Page

Paper Source: ® Paper Cassette (O Manual Feed

i

Figure 5-8. The Print dialog box for the LaserWriter

The Print dialog box varies for different printers. See your Macintosh
owner’s manual or the manual that came with your printer for more
information about the print options for your particular printer.

Closes all open charts and quits the application. If you’ve made
changes to any charts since you last saved them, Org Plus gives you
an opportunity to save the changes. You can also press Command-Q.
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Undo 82

Cut BH
Copy ®C
Copy Setup

Paste %8y
Clear %Y

Select »
Select Level...

Label Setup... 8L

Preferences...

Undo
¥Z

Cut
¥’ X

Copy
®C

Copy Setup

186 Reference

The Edit menu

The Edit menu contains standard commands for undoing your last
operation, and cutting, copying, pasting, or clearing objects in your
chart. It also contains commands for selecting objects in your chart,
changing labels, and changing preset options.

Undoes, or reverses, your last operation. Words are added to “Undo”
to tell you exactly what will be undone: for example, “Undo cut”.

To undo an operation, you must choose Undo before you do any-
thing else.

Deletes whatever is selected and places it on the Clipboard.

When an object is cut to the Clipboard, it replaces whatever was there
before it. So if you want to paste from the Clipboard, you should do
so before you cut something else.

Your chart is usually reformatted when you cut text or boxes.

Creates a copy of whatever is selected and puts it on the Clipboard.

When an object is put on the Clipboard, it replaces whatever was
there before it. So if you want to paste from the Clipboard, you
should do so before you copy something else.

Creates a copy of the label setup for the current box and places it on
the Clipboard. You can then paste that setup onto other boxes to
give them the same setup. Copy Setup also copies the box border
and shadow for the current box.



Paste
¥V

Clear
¥Y

Select

When a label setup is cut or copied to the Clipboard, it replaces
whatever was there before it. So if you want to paste from the
Clipboard, you should do so before you cut or copy something else.

See “Changing the label setup,” page 96, for more information.

Places a copy of whatever is on the Clipboard into your chart.
Text objects are pasted at the insertion point.

To paste boxes, you must first select the manager of the boxes on the
Clipboard, then paste. Boxes are pasted as subordinates to the
selected box.

When you paste a label setup, Org Plus pastes the label setup plus the
box border and shadow.

Deletes the selected objects from your chart. Cleared objects are not
placed on the Clipboard. If you change your mind about clearing an
object, choose Undo from the Edit menu immediately.

Displays a submenu from which you can select a variety of objects in
your chart (Figure 5-9).

Undo ¥2
Cut #H
Copy ®C
Copy Setup
Paste 1)
Clear ®xY
m All Boxes %A
Select Level... All Assistants
All Managers
Label SB'UD... 8L Al Nnn-Managers
Group ®6
Preferences... Branch %®B

Lowest Level
Connecting Lines

Figure 5-9. The Select submenu

See “Selecting boxes and lines,” page 88, for more information.
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Select Levels... Displays a dialog box from which you can select all the boxes in a
range of levels.

Select Levels

Select all boxes at levels: EI E] through @

Figure 5-10. The Select Levels dialog box

The topmost box in your chart is at level 1. The boxes reporting
directly to it are at level 2. The boxes reporting to them are at level 3,
and so on.

See “Selecting all boxes at the same level,” page 91, for more informa-

tion.
Label Setup... Displays a dialog box at which you can change the setup of informa-
®EL tion for the selected boxes.
S=———— label Setyp=—~———| )
You can type additional Apply to: OAIl bores @ Selected boxes '
Tabels in any dotted area, or
cut & paste to move them. 1
Labels in chart: | = ..
Name K [<Name>
Hitle ]
O] L
: 4
( Hide label ] [CT Addabel areas & dividers... |<a] >
( thengetabet | ( Addlabel | [cancel ] [ #opiy ||

Figure 5-11. The Label Setup dialog box
At the Label Setup dialog box, you can:
[ ] Create new labels for new information in your chart, page 100

[ | Create and delete areas in which to type labels, page 100
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Preferences

Move labels, page 102

Rename and delete labels, page 108
Hide or show labels, page 104
Create dividing lines, page 106

Change margins within a box, page 107

See “Changing the label setup,” page 96, for instructions.

Displays a dialog box at which you can change the Org Plus preset
options.

Preferences

Unit of Measurement: @& Inches O Centimeters

Overlap between chart pages: @

Also, choices you make now from menus and
dialogs become preset options for new chart

documents.

Figure 5-12. The Preferences dialog box

From this dialog box, you can change the preset options for new
charts. You can also change the preset option for existing charts.

See “Changing preset options,” page 169, for more information.
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The Styles menu

The Styles menu lets you change the arrangement of boxes in your
chart.

The top set of styles lets you change the arrangement of boxes in a
group. Double-click any box in a group to select the entire group,
then choose a style. See “Changing group styles,” page 111, for more
information.

The bottom set of styles lets you change the arrangement of assistant
boxes with respect to their manager. Select an assistant box, then
choose one of these styles. See “Changing assistant styles,” page 113,
for more information.

Use the last style in the Styles menu to show co-managers — manag-
ers who share responsibility for the same group of subordinates.



| Tent

Font 4
Style 4

6 point
9
10

vi2
14
18
Other...

Left
Right
v Center

Name >
Word Wrap

Fonts

Style

The Text menu

The Text menu contains commands that let you change the appear-
ance and behavior of text in your chart.

The Font command displays a submenu from which you can choose
any of the fonts installed in your system.

The Style command displays a submenu from which you can select a
style (Figure 5-13).

Font 4

+ Plain
Bold
fislic
Underline
0[ujtiliinle]
Shadom

Figure 5-13. The Style submenu

You can give any character, word, or phrase in your chart any style or
set of styles.
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Text sizes The point sizes let you change the size of your text. You can give
any character, word, or phrase in your chart any one of these point
sizes.

A check mark appears next to the size of the currently selected text; if
no text is selected, the check mark shows the preset text size.

Other... Displays a dialog box from which you can choose a point size that is
different from those shown on the menu.

Point size: @

Figure 5-14. The Point Size dialog box

Left, Right, and Center  Centers the selected text, aligns it to the left, or aligns it to the right.

See “Changing text alignment,” page 128, for more information.
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Name

Word Wrap

Displays a submenu from which you can choose a way to format the
people’s names in your chart (Figure 5-15).

| Text

Font | 2
Style 2
6 point
g9
10
vl2
14
18
Other... Vs typed
Left First Last
Right First M. Last
v Center First Mid Last
F. M. Last
M F. Last
Word Wra Last
Last, First
Last, First M.

Figure 5-15. TheName submenu

As typed shows the selected names exactly as you originally typed
them.

See “Formatting people’s names,” page 108, and “Changing people's
name formats,” page 129, for more information.
Wraps — or splits — selected text across multiple lines. (The text in

this paragraph is wrapped across two lines).

See “Wrapping text across lines,” page 128, for more information.
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- oxes The BOXCS menll

Box Border
Box Shadow

The Boxes menu contains commands that let you change the size,
spacing, and appearance of boxes and lines in your chart. It also
contains commands to hide and show boxes and branches.

Line Thickness

14
>
>
Line Style 4

Hide Box
Hide Branch

Spacing... 1]

v Auto Width
v Auto Height
Manual Size...

Box Border Displays a submenu (Figure 5-16) from which you can choose a
border for the currently selected boxes. The current choice in the
submenu is shown with a gray border.

Boxes
Box Border . ) Hair-
Box Shadow ) None line
Line Thickness b | [~ r
Line Style >
Hide Box r r
Hide Branch
spacing.. %0 I | ™
v Auto Width
«Auto Height r | r
Manual Size...
r | r

Figure 5-16. The Box Border submenu

None hides the box border completely.

Hairline produces the finest line your printer can draw.
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Box Shadow

Line Thickness

Displays a submenu (Figure 5-17) from which you can choose a
shadow for the currently selected boxes. The current submenu
selection is indicated by a gray border.

Box border | 4
Bo ado

None

Line Thickness )

Line Style » I—|
Hide Box
Hide Branch [ ]

Spacing... %D

1]
v Auto Width D D

v Auto Height
Manual Size...

Figure 5-17. The Box Shadow submenu

Displays a submenu (Figure 5-18) from which you can choose a
thickness for the currently selected lines.

Boues

Box Border 4
Box Shadow 4

me None
Line Style b | Hairline
V1 pt
Hide Bon 2 pt
Hide Branch 3 Pt —
4 pt  ————
Spacing... B0 5 pt e—
«Auto Width 6 pt =—
v Auto Height
Manual Size...

Figure 5-18. The Line Thickness submenu

None hides the selected lines completely.

Hairline produces the finest line your printer can draw.
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Line Style Displays a submenu (Figure 5-19) from which you can choose a style
for the currently selected lines:

B(mes

Box Border »
Box Shadow >

Line Thickness p
tine styie ) RN
notted ......

Hide Box Dashed ---
Hide Branch

Spacing... %D

v Auto Width
v Auto Height
Manual Size...

Figure 5-19. The Line Style submenu

Show/Hide Box Lets you hide the selected box or make it visible again. Org Plus
automatically redraws connecting lines so that no gaps are left in your
chart.

Hiding boxes lets you create special drawing effects. See “Showing/
hiding boxes,” page 149, for more information.

Show/Hide Branch Lets you hide the selected manager’s branch or make it visible again.
(You can also do this by clicking the manager’s branch symbol — a
little zoom box — in the lower right corner of the box.)

Hiding all branches except the ones you’re working on improves the
application’s performance and allows you to keep your chart simple
and uncluttered while you work. You can show all the hidden
branches when you’re ready to print, or just print the visible branches.

See “Showing/hiding branches,” page 150, for more information. Also
see “Time saving measures” on page 211.
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Spacing...
#D

Auto Width

Displays the Spacing dialog box, from which you can change the
distance between boxes in all or selected groups. You can also press
Command-D to see this dialog box.

[[E————— spacing (in inches)

Apply to: O All groups @ Selected groups

[g] Distance to manager:
@ Distance to connecting line:

[§] Horizontal spacing: Dil: or:

. . R e e T
@ Uertical spacing between co-workers: =~ 3 $
@ Distance between groups (applies to whole chart)

Figure 5-20. The Spacing dialog box

See “Changing the distance between boxes,” page 119, for more
information.

Lets you turn automatic width sizing on or off for the selected boxes.
A check mark appears next to the command if automatic sizing is in
effect for the selected box.

Starting out, all boxes at the same level have the same width. No box
is wider than its manager’s box.

Automatic width sizing gives boxes with the same status the same
width. If, however, you need to make a box as narrow as possible,
select the box and choose this command to turn off automatic width
sizing. To turn it back on, select the box and choose the command
again. See “Making boxes larger or smaller,” page 123, for instruc-
tions.
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Auto Height

Manual Size...

198

Enter box dimensions...

Lets you turn automatic height sizing on or off for the selected boxes.
A check mark appears next to the command if automatic height sizing
is in effect for the selected box.

Starting out, all boxes at the same level have the same height.
Automatic height sizing gives boxes with the same status the same
height. If you need to make a box as short as possible, select the box
and choose this command to turn off automatic height sizing. To turn
it back on, select the box and choose the command again.

See “Making boxes larger or smaller,” page 123, for instructions.

Displays a dialog box at which you can give the selected boxes a
fixed size.

[[==———=— Manual Sizing (in inches)

fipply to: O All bokes @ Selected boxes

e

Height: ®
Width: @

...or drag bandle to
size boxes

Reference

(CCancer ) (_eery )

Figure 5-21. The Manual Size dialog box

At this dialog box you can:

2l Change the size of the selected boxes by typing in their height
and width (or by clicking the arrow controls next to the text
boxes).

&) Change the size of the selected boxes by dragging the handle in
the lower right corner of the box inside the dialog box.

[ | Apply the changes without closing the dialog box. (You can drag
the dialog box to the side of your screen so that you can see

the effect of your changes.)

See “Giving a box a fixed size,” page 124, for instructions.



% The Chart menu

Size to Window 881
50% of Actual %J

v Actual Size 8K . q
The Chart menu contains commands that affect your entire chart and
Show Edit Panel %E working environment.
Show Page Lines
Hide Symbols
show Draw Tools %T The bottom of the menu shows the names of the currently open
charts. A check mark appears next to the name of the current chart
Center Up/Down . N o
«~Center Left/Right — the one whose window is in front. You can go directly to any

open chart by choosing its name from the bottom of this menu. You

e Untitied: od can also type the document’s Command key equivalent.
Make Fit... Displays a dialog box from which you can select space-saving options
¥EM and find out how much to reduce your chart in order to make it fit in

a specified number of pages.

Make Fit

Desired chart size:

Pages: 1

Figure 5-22. The Make Fit dialog box
At the Make Fit dialog box you can:

[ | Select the number of pages you want your chart to fit on by
clicking one of the squares.

[ | Specify what options you want Org Plus to use to make your

chart fit by clicking the Options button, and making selections
at the Make Fit Options dialog box (Figure 5-23).
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Make Fit Options

[0 Names: | £, Last V| [J Minimum margins

O wrap info: | Camments |

[ Point sizes: | 8swn by ¢ w| [ Cancel ]

Figure 5-23. The Make Fit Options dialog box
At the Make Fit Options dialog box, you can:

| Abbreviate people’s names in your chart by choosing a style of
abbreviation from the Names pop-up menu.

e Wrap (split) selected information (such as comments) across
several lines by choosing the label for the information from the
Wrap Info pop-up menu.

u Make all the text in the boxes of your chart larger or smaller by
choosing an item in the Point Sizes pop-up menu.

When you click OK at the Make Fit Options dialog box, the Make Fit
dialog box reappears. When you click OK at the Make Fit dialog box,
Org Plus implements your space-saving options and, if they aren’t
enough to make your chart fit, tells you how much to reduce your
chart (Figure 5-24).




Reduce to this
percent of full
size

!s Your options have not reduced the chart enough
to make it fit.

However, the chart will fit if you print it on
letter size paper at 78 % of its full size.

Size to Window
) |

50% of Actual
#J

Actual Size
¥K

You can change paper and % size at the Page
Setup for some printers. Or print the chart on
letter paper and reduce/enlarge it on a copy
machine.

(_PageSetup | [ TryAgain |

Figure 5-24. The How to Fit message
See “Using the Make Fit command,” page 139 for more information.
Displays the entire chart in the current window. You can also press
Command-I, or use the Reduce/Enlarge tool in the tool palette.
See “Viewing your chart at actual and reduced sizes,” page 93, for
more information.
Displays your chart at 50% of its actual size. You can also press
Command-J.
See “Viewing your chart at actual and reduced sizes,” page 93, for

more information.

Displays your chart at actual size — the size at which it will print.
You can also press Command-K, or use the Reduce/Enlarge tool in
the tool palette.

See “Viewing your chart at actual and reduced sizes,” page 93, for
more information.
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Show/Hide Edit Panel Shows or hides the edit panel. See “Seeing and editing information
¥E not shown in your chart,” page 86, for more information.

The edit panel shows all the information for the selected box, as
shown in Figure 5-25.

(& File Edit Styles Tent Bones Chart Help

E[I==————— fllen Manufacturing ="—————V
T lO\ISubordinate:LE_l ICo—worker: El El lManager:[EI IAssistant:lEH

Larry Stevens ﬁ Iﬂl

See and edit all Vice President Prosioam & GO,
the information Automotive P —
Jfor a person bere, $89,000 Emotve Sserviery
inCluding infor_ Lmnblnmr Dacxl Gullnlr‘llnn Lamy Gtevenr

. . Chist Fimnciel Ofier Vice Prasidem ¥ice Pracioam
mation which Fwwey oo — awtomative
may not be visible Cathy Cloud Scol Keming G. Yan Hutean defY Lovineky
in tbe de,.t Caeh Hensger ] (Pnjut Heneger Project nmnr’ '{mnm Heneger

Lort Bt. Jean
Ammumian

Carol Helter Paul Gtenmerd Honty Allan
Prugram Meneger Praject Henmer Elaciriclan

Dmn Gardan
Project Meneger
Brama Plant
Frogram Mensger

Lisade Jong Hugn Pez Dabtin Hell
Flmning Elactrician Elaciriclan

Select this to show

- £ ] Show changes in ch _
new text in the chart &l |f§i Isize: 50% Ka

as you type it into
the edit panel

Figure 5-25. The chart window with the edit panel open
Use the edit panel when you want to:
[ | See and edit information not visible to you in a box in your

chart. (See “Seeing and editing information not shown in your
chart,” page 86.)

[ See and edit information when your chart appears at a reduced
size.
[ Enter information quickly. (See Appendix B, “Time Saving

Measures,” on page 211.)

Show/Hide Page Lines  Shows or hides the margins, title area lines, and page borders in your
chart. Choose Show Page Lines in order to change margins, enter
titles in the title areas, or see how many pages your chart covers.

See “Changing your chart margins,” page 172 for more information.
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Show/Hide Symbols

Show/Hide Draw Tools
BT

Center Up/Down

Center Left/Right

Shows or hides the manager’s branch symbol. Choose Hide Symbols
and Hide Page Lines to see exactly what your chart will look like
when printed.

Shows or hides the draw tools (Figure 5-26). You can also press
Command-T.

( & File Edit Styles Tent Bowes Chart Help )
=———— untitled  ——— |

EmE—
k l T |O‘| Subordinate: @ Il:o-worker: IE“EI I Managetr: |E] | Assistant:[@l—l— ] \I_J"ID!
Perpendicular Line tool //

Diagonal Line tool
Connecting Line tool

Rectangle tool

Figure 5-26. The draw tools
Use these tools to create extra lines and boxes in your chart.
See “Special effects through manual drawing,” page 153 for more
information.
Keeps your chart centered between top and bottom margins, no

matter what changes you make to your chart.

Choose the command to activate it; choose it a second time to deacti-
vate it. A check mark appears next to it when it is activated.

See “Moving and centering your chart,” page 118, for more informa-
tion.
Keeps your chart centered between left and right margins, no matter

what changes you make to your chart.

This command has a check mark next to it when it is active. Choose
the command to deactivate it; choose it a second time to reactivate it.

See “Moving and centering your chart,” page 118, for more informa-
tion.
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Help Topics...

%H

Creating boxes...
Rearranging boxes...
Spacing boxes...
Sizing boxes...
Moving boxes...

Entering text...
Rearranging test...

Making it fit...
Custom drawing...
Using stationery...
Time saving ideas...
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The Help menu

The Help menu commands give you help for the most common
operations.

Each command displays the Help dialog box, opened automatically to
the desired topic. From the Help dialog box, you can choose other

topics.

See “On-line help,” page 14, for more information.



Appendix A:

Keep your chart
simple

Keep your chart un-
cluttered

Keep your chart small

The Art of Charting

This appendix offers guidelines to help you create effective and
professional looking organization charts.

The secret to creating effective organization charts is to remember
their purpose: o grapbically communicate the basic structure of an
organization. Your chart should make it easy to determine who
reports to whom and what relationship one box or group of boxes
bears to another.

Well-designed charts convey this information quickly and accurately.
Poorly designed charts take a long time to figure out and can confuse
or mislead the viewer.

Some of these guidelines have been adapted from “Charting the
Company Organization Structure,” National Industrial Conference
Board, Inc., New York, N.Y., 1959.

The best use of an organization chart is to show how the organization
is structured — the basic organizational units and the chain of com-
mand.

An organization chart is not a very good tool for showing the many
indirect, informal relationships that exist in most organizations. In
practice, most organizations are extremely complex. Attempting to
show that complexity in the chart often produces complex and
unintelligible charts.

In general, the more information on the page, the more confusing the
chart.

Use extra lines or text sparingly. Use white space — empty space on
the page — rather than boxes or lines to show separations between
groups.

A reader can understand a smaller, less cluttered chart much more
quickly than a larger chart. You can communicate the essence of the
organization much more quickly. A smaller chart also has the impor-
tant advantage of fitting on a single page.
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Be consistent

Box sizes

Spacing between boxes

Font/Sizes/Styles

If you have a large organization chart, break it up into separate charts
by division or department. For instructions, see “Creating books of
charts,” page 148.

Sometimes you want the entire chart on a single page, even if that
makes it look crowded. See “Making your chart more compact,” page
132, for ideas on how to make your chart more compact without
compromising readability.

Think of your chart as an arrangement of groups of boxes. Treat
boxes with equal status in an equal and consistent way.

This rule applies to many elements of the chart design, as described
below.

Use the same size box, especially for boxes at the same level or in the
same group. The more box sizes vary, especially within a group, the
more uneven your chart appears.

In general the following rules work best:

Make all boxes at the same level the same beight and
width. Let no box be wider than its manager’s box.

Org Plus automatically sizes boxes according to these rules unless you
disable automatic sizing or manually change the size of the boxes.
(See “Making boxes larger or smaller,” page 123.)

Use consistent spacing throughout your chart.

Starting out, the preset options in the Spacing dialog box ensure that
the distances between boxes are consistent. If you change the
settings, change them for all boxes in your chart. (See “Changing the
distance between boxes,” page 119 for more information.)

If possible, limit yourself to one font and no more than three sizes for
all information in your chart. Use larger point sizes toward the top of
your chart and smaller ones toward the bottom. Use text styles
(boldface, italics, and so on) sparingly and consistently. (See “Chang-
ing text, line, and box styles,” page 127.)
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Label setups

Group styles

Chart designs

Label your chart
clearly

Date your chart

Authorized by: Chris Phillips
Created by: Corinne Speer
Date: Sept 9, 1990

Arrange information the same way in each box. If necessary you can
show less information the lower you go in your chart. That also helps
keep your chart as compact as possible. (See “Changing the label
setup,” page 96.)

Use the same or similar group styles for groups with the same status.
Sequence boxes of equal status according to some impersonal rule,
such as alphabetic order. (See “Changing group styles,” page 111.)

If you create many charts for your company, use stationery to ensure
a consistent design. (See “Creating your own stationery,” page 167).
Use the same group styles for equivalent divisions or departments
whenever possible. Place titles and other annotations in the same
place in each chart. (See also “Creating books of charts,” page 148.)

If you label and date your charts, you'll have a clear record of how
the organization has changed over time. People will more quickly
understand what your charts actually show.

Most companies prefer to place the title in the top right or top center
of the page.

If your chart shows a single unit of the total organization, the title
should make clear the relationship of that unit to the rest of the
company. To do this, you might include:

u The name of the company

u The name of the main organizational group (e.g., Finance)

[ The name of the organizational unit depicted in the chart (for
instance, Accounting)

Since organization charts present a snapshot of the organization at a
particular point in time, a date is very important. Dates give the
viewer a sense of the chart’s currency, and suggest when updates are
necessary. Many companies include the date below or near the title;
others place it in a corner of the chart.

Some companies also include authorization data — the name of the
individual who authorized and approved the chart — as well as the
name or initials of the person who made the chart. This establishes
authority and accountability, and helps control the creation and
distribution of charts.

(See “Annotating your chart,” page 161.)
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Appendix B: Time Saving Measures

This appendix reviews some of the features and techniques you can
use to shorten the time it takes to create and update a chart.

Use stationery If you create multiple charts for your organization, use the stationery
feature whenever possible.

When you use the stationery feature, you only have to create your
company’s basic chart once. The stationery chart is a template, like a
business form. When you open a stationery chart, you “tear off” a
standard chart from the pad. You then type in the information that is
unique to your new chart without having to redo the elements that
are standard to all charts. This not only saves time, but ensures that
your charts have a uniform appearance.

See “Creating your own stationery,” page 167, for more information.

Use keyboard Org Plus has many keyboard shortcuts for operations that otherwise
shortcuts instead of must be done with the mouse. Many people find that it’s faster to use
the mouse the keyboard than the mouse.

See Appendix C, page 215 for a summary of the Org Plus keyboard
and mouse shortcuts.

Use the The fastest way to move around a large chart is to use the Reduce/
Reduce/Enlarge tool Enlarge tool. (Scrolling with the scroll bar is perhaps the slowest
way!) See “See any box in your chart,” page 94, for instructions.

Minimize formatting Org Plus automatically calculates, formats, and draws your chart every

time time you change the number, size, or placement of boxes. With most
charts, such changes usually involve thousands of calculations and
operations. On slower machines such as the Macintosh Plus or
Macintosh SE, this can take several seconds. Use the methods de-

scribed below to save time.
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Hide branches you don’t
need

Create multiple boxes at
a time

Create boxes in actual

s1z¢

Use the edit panel

Hide branches that you aren’t working with until you’re ready to print.
Org Plus doesn’t reformat hidden branches. See “Showing/hiding
branches,” page 150.

Org Plus reformats your chart every time you create a box. It takes
just as much time to reformat your chart for one new box as it does
for multiple boxes. See “Creating multiple boxes of the same type,”
page 81.

Create boxes with your chart shown at actual size. Org Plus only
redraws the visible portion of your chart, and Actual Size displays the
least. The less that is visible, the faster the process.

You can enter information more quickly if you do it with the edit
panel filling the window (this hides your chart). Org Plus doesn’t
recalculate, reformat, or redraw your chart until you redisplay the
chart. Here’s what to do:

1. Create or select the box whose information you want to
enter or edit.

2.  Press Command-E to display the edit panel.

3. Drag the edit panel handle all the way to the right edge of
the window.

The edit panel handle is the little black bar located in the lower
right corner of the edit panel. If you drag it all the way to the
right, your chart won’t be visible, and the edit panel will fill the
window.

4. Create boxes and enter information.

To create boxes with the edit panel open, Command-click the
box tools in the tool palette. For example, to create a co-
worker to the right of the current box, Command-click the Co-
worker After box tool (the second Co-worker tooD.

See “Seeing and editing information not shown in your chart,”
page 86, for more information about using the edit panel.
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5.

Press Command-E to redisplay your chart.

You can do this every so often in order to see your chart or
move to boxes in different areas of the chart. Command-E
switches you between a view of the chart and a view of the edit
panel.

Use the keystrokes shown below to select the manager, co-
workers, or subordinates of the current box without
redisplaying the chart:

To select this... Press this...
The manager Option-Up Arrow
The co-worker before (to the left or Option-Left Arrow

above the current box, depending on
the group style)

The co-worker after (to the right or Option-Right Arrow
below the current box, depending on
the group style)

The first subordinate Option-Down Arrow

If you want to use the edit panel with your chart visible, make
sure “Show changes in chart” isn’t checked. When this item is
checked, text appears in the edit panel as well as in the chart
while you type — which takes time on slower machines. When
“Show changes in chart” is not checked, text appears in the
chart when you deselect the current box.
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Appendix C: Keyboard & Mouse Shortcuts

In addition to the Command key equivalents menu commands (visible
in the menus themselves), Org Plus has many other keyboard and
mouse shortcuts.

Creating boxes To create boxes by means of the keyboard, you can first select the
box to which the new box will be attached, then press the key
combinations shown in the following table:

To do this... Press this...
Create a subordinate Shift-Command-S
Create a co-worker before (to the left or Shift-Command-B
above the current box, depending on the

group style)

Create a co-worker after (to the right or Shift-Command-A

below the current box, depending on the
group style)

Create a manager Shift-Command-M

Create an assistant Shift-Command-I

You can also create boxes by selecting a box in your chart, pressing
and holding the Command key, then clicking a box tool.

Entering information To edit the first item of information in a selected box, press Return or
Enter.
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Viewing your chart

The following table summarizes the keystrokes that let you view your

chart.

To do this... On any keyboard Ext. keyboard !
|

See your entire chart in Command-I Command-I

the window (size it to

fit in your window) :

See your chart reduced Command-J Command-J

to 50% of actual size

See your chart at actual
(printing) size

See the part of your
chart above the window

See the part of your
chart below the window

See the part of your
chart to the left of the
window

See the part of your
chart to the right of the
window

See the topmost box in
your chart

See boxes at the bottom
of your chart

Command-K

Command-Up Arrow

Command-Down
Arrow

Command-Left
Arrow

Command-Right
Arrow

Option-Command-
Up Arrow

Option-Command-
Down Arrow

Command-K

Page Up,
Command-Up
Arrow

Page Down,
Command-Down
Arrow

Command-Left
Arrow, Command-
Page Up )

Command-Right
Arrow, Command-
Page Down

Home, Option-
Command-Up ’
Arrow ’

End, Option-
Command-Down
Arrow
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Selecting and editing
boxes

Making dialog box
selections

To select boxes next to a currently selected box, use the following

keystroke combinations:

To do this...

Press this...

Select the co-worker before (to the left or
above the current box, depending on the
group style)

Select the co-worker after (to the right or
below the current box, depending on the
group style)

Select the current box’s manager

Select the current box’s first (leftmost or
topmost) subordinate

Edit the currently selected box

Option-Left Arrow

Option-Right Arrow

Option-Up Arrow

Option-Down Arrow

Return or Enter

When a dialog box appears, you can press keys instead of clicking

the following buttons:

To select this...

Press this...

The OK button (or any other button with
the thick border)

The Cancel button

The Yes button

The No button

Return

C, or Command-Period
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Using the modifier

keys with the mouse

File operations

You can use the Shift, Control, Option, and Command keys to modify
many mouse operations, as follows:

To do this... Press & hold... While you...

Temporarily get the Control Click in the chart

Reduce/Enlarge tool

pointer

Move a box without Command Drag a box to its new

moving its subordinates location

Replace the contents of ~ Option Drag one box over

one box with the the one whose

contents of another contents you want to
replace

Temporarily keep a tool ~ Option Click a tool and use it

in the tool palette active

Drag any group up or Shift Drag any box in the

down, or drag a hori- group

zontal group left or

right

To create a box nextto ~ Command Click a box tool in

the currently selected
box in your chart

Copy a rectangular area
of your chart to the
Clipboard (as a PICT
formatted image) in
order to paste it to
another application

Option-Command

the top palette

Drag a rectangle
anywhere in your
chart

Whenever you see a dialog box that lets you select charts or other
documents (for instance, the Save and Open dialog boxes), you can
type the first letters of the document you want in order to highlight it.
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Appendix D: Operating Limitations

Minimum hardware Mac Plus

Minimum disk configuration Hard disk and 800K floppy
drive, or two 800K floppy
drives

Minimum memory (RAM) required 1 megabyte

Minimum system software System 4.1

Maximum charts open at one time 16

Maximum boxes per chart 2,000

Maximum number of levels 50

Maximum number of labels 24

Maximum number of characters per 3,000

item of information

Maximum number of characters per 32,000

box

Maximum number of boxes per 100

group

Minimum box size .25" wide by .128" high
Maximum box size 250" X 250"

Maximum chart size 250" X 250"
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Appendix E:

Opening Org Plus for
IBM documents

Using Org Plus with Other
Applications

This appendix presents detailed instructions on opening and closing
documents created with other applications. It also includes instruc-
tions for using the Clipboard to paste Org Plus charts into other
applications (such as a word processor).

Org Plus for Macintosh can open documents created by all IBM®
versions of Org Plus and Org Plus Advanced.

You must first transfer the IBM Org Plus document to your Macintosh.
You can do this on some types of networks. In addition, if your
Macintosh is equipped with the Apple SuperDrive, you can use the
Apple File Exchange utility to transfer documents on 3.5-inch IBM
formatted disks to your Macintosh. Consult your Macintosh owner’s
manual for further instructions.

You can open the IBM Org Plus document when it appears in a folder
on your Macintosh desktop. To open the document, do the follow-
ing:
1.  Start the Org Plus (for Macintosh) application.
2.  Choose Open from the File menu.

The Open dialog box appears.

3. Choose Org Plus for IBM from the File formats pop-up
menu.

Position your arrow pointer over the File formats box, press the
mouse button, then choose the item (see Figure E-1).
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Dpen chart

| Org Plus 1.0 |

0O Acne Supply Co.
[0 Banner Blue
0O Planetary Uplift Society

e Hard disk
10,276K available

tipet

Hiipe

ol

Org Plus for Mac
Org Plus for IBM

[Teat N

Figure E-1. Opening an Org Plus for IBM file

Cancel

File formats:

4. Locate and open the IBM Org Plus file.

Org Plus creates a new, untitled chart containing the informa-
tion in your IBM Org Plus file. All data and most chart format-
ting options are copied to your new chart.

You can change and save your new Org Plus chart as you can any
other Org Plus (for Macintosh) chart. Your IBM Org Plus file isn’t
affected in any way.

Differences between IBM  There are several differences between Org Plus for Macintosh and Org
and Macintosh versions  Plus for IBM.

| Org Plus for Macintosh version 1.0 does not support the cre-
ation of Tables and Reports.

| Org Plus for Macintosh imports numbers, but doesn’t consoli-
date them as in Org Plus for IBM.

| Org Plus for Macintosh gives you much more control over the
appearance of your chart. Any group can have any chart style.

| Org Plus for Macintosh is more sophisticated about the way it

arranges boxes on the page. It can create much more compact
charts than Org Plus for IBM.
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Saving as Org Plus for
IBM

Type a name for Sam—

your Org Plus for
IBM file...

Org Plus for Macintosh can save charts in a file format that can be
read directly by the following IBM versions of Org Plus and Org Plus
Advanced:

[ | Org Plus version 3.1
[ | Org Plus Advanced version 4.0
] Org Plus Advanced version 5.0

To save your Org Plus for Macintosh chart in a format readable by any
of these versions, do the following:

1. Choose Save As from the File menu.

2.  Choose Org Plus for IBM from the File formats pop-up
menu.

Position the arrow pointer over the File formats box, press the
mouse button, and choose the item (Figure E-2).

Save chart

(= _0rgPlus |

Dy fipolle Bocumeniati,,
Yy fipolia P Hep 4.2
Y fipolio £ HBep 1.8

0 fipalio £PY H-fouer L
OO B/W Overhead Tran...
O Background Libraries [}

3| = Banner Blue

iipnt

Hripea

i

Save chart as: Cancel
o Org Plus for Mac

...and choose the
Org Plus for IBM
file format

File formats:| Text

Figure E-2. Saving as an Org Plus for IBM file
3. Type a name for your file in the text box.

4. Click the Save button.
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Opening Text
documents

Once you have saved the file, you must transfer it to a disk on your
IBM or IBM-compatible system. You can do this on some types of
networks. In addition, if your Macintosh is equipped with the Apple
SuperDrive, you can use the Apple File Exchange utility to transfer
your file on your Macintosh disk to a 3.5-inch IBM formatted disk.
Consult your Macintosh owner’s manual for further instructions.

You can then open your chart with your IBM version of Org Plus or
Org Plus Advanced.

Org Plus can open text documents created by other applications, such
as data base or word processing applications.

Org Plus can open any text file that is in the tab delimited ASCII file
format. “ASCII” stands for “American Standard Code for Information
Interchange”. Check whether your application can save information
in that format.

In order to import a text document, the data values in the text
document must be separated by tabs. Each record — each
row — in your text document must have the same information
in the same order. See Figure E-3.

If your data records contain the name of the employee’s manager, Org
Plus can preserve the reporting relationships. If not, Org Plus creates
arbitrary reporting relationships that you can then change by moving
the boxes around. (See “Moving boxes in your chart,” page 115.)
For example, if your text document appears as shown in the top
window of Figure E-3, your chart will appear as shown in the lower
window. If, however, your text document appears as shown in the
top window of Figure E-4, the chart will appear differently.
To open a text file, do the following:
1.  Start the Org Plus application.
28 Choose Open from the File menu.

The Open dialog box appears.

3.  Choose Text from the File formats pop-up menu (located
in the lower left corner of the dialog box).
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With manager data

Chris Phillips+ President.&.CEO» Board of Directorsd
Lynn.Brewers Chief Financial Officers Chris Phillipsd
Larry.Stevenss Yice Presidents Chris Phillips®
Tina Nomuras CQOO» Chris Phillipsd
Cathi.Finerans Facilities» Tina Nomurad

Chris Phillips

President & CEO

l ]
Lynn Brewer Larry Stevens Tina Nomura
Chief Financial Officer Yice President Coo

Cathi Fineran
Facilities

hgize: 100% K3

Figure E-3. Preserving the reporting relationship

Without manager data

Chris Phillipss President.&.CEQq
Lynn. Brewers Chief Financial Officerd
Larry Stevenss Vice.President®

Tina Nomuras COOq

Cathi.Finerans Facilitiesd

Chris Phillips
President & CEO

l

[ [ |
Lynn Brewer Larry Stevens Tina Nomura Cathi Fineran
Chief Financial Officer Yice President coo Facilities

Figure E-4. An arbitrary reporting relationship

4.  Locate and open the text document.

A dialog box appears asking whether the text document
contains the name of each record’s manager.

If the text document doesn’t contain the name of the
manager, click No, and stop here. You don’t need to read
further. Org Plus creates a new, untitled chart, that you can
change and save as you would any other Org Plus chart.
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Use the vertical scroll
bar to see more data
in the current record,
if necessary

If the text document does contain manager data, click Yes.

The Text Import dialog box appears, as shown in Figure E-5.

Text import

Drag data up to match: \

Manager's name =
Employee's name

[

President & CEO
Board of Directors

Use the horizontal
scroll bar to see
other records in the
text file

= Chris
A,
Phillips

Cancel 0K

Figure E-5. The Text Import dialog box

The data in the first record of the text document appears in a
column at the lower right. Scroll down to see all of the data for
the current record if it’s not currently visible.

You can also scroll to the right to see the data for other records
in the text document.

Drag up the manager’s name until it appears after the first
equal sign (see Figure E-6).

Drag up the employee’s name until it appears after the
second equal sign (see Figure E-6).

If your text document has the name parts (first name, middle
name, last name) separated by tabs, the name parts will appear
on different rows in the Text Import dialog box. Drag all the
name parts up so that they are stacked up to the right of and
below the equal sign (see figure to left). Make sure you put
them in the right order (first name above middle name, middle
name above last name).

When steps 5 and 6 are complete, you should have a data value
opposite the two equal signs, as shown in Figure E-6.
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Saving as a text
document

Text import

Drag data up to match:

[

Board of Directors
Chris Phillips
\President & CED |

Manager's name
Employee's name

Figure E-6. Matching the data values

If each data record has the same data in the same order, the
match up will be correct for all records in the text file. You can
verify this by clicking the left and right arrows of the horizontal
scroll bar to view the other data records in the text document.

Click the OK button.

Org Plus creates a new, untitled chart that you can change and
save as you would any other Org Plus chart.

To save an Org Plus chart as a text document, do the following:

1.

2.

3.
4.

Choose Save As from the File menu.
Choose Text from the File formats pop-up menu.
Type a name for your text document in the text box.

Click the Save button.

Org Plus creates a text document containing all the data that you have
typed for each box in the chart. The text document is saved in tab
delimited ASCII format. Many applications have the ability to read
documents with data in this format.
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Copying and pasting

You can copy text from most Macintosh applications to the Clipboard
and then paste it into your chart wherever you see an insertion point

(the blinking bar).

You can copy pictures in many Macintosh applications directly to the
Clipboard and then, in Org Plus, paste them directly into your chart.
See “Pasting pictures into your chart,” page 165, for details.

You can also copy and paste a rectangular portion of your chart to the
Clipboard and then paste it into an application that accepts PICT
images. PICT is a special format for graphic images.

between applications
1.
2.
3.
4.
5.
228

Choose the level of magnification you want from the
Chart menu.

What you see in the chart window is exactly what you can copy
to the Clipboard.

To copy an image of the entire chart, choose Size to Window.
Press and hold Option-Command while you drag a rect-
angle around the portion of your chart you want to copy
to another application.

When you release the mouse button, the contents of the
rectangular area you defined are copied to the Clipboard as a

PICT image.

Switch to the document in the other application where
you want to paste the chart image.

Click or position the insertion point where you want to
paste the PICT image.

Choose Paste from the Edit menu.
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Glossary

Annotation

Assistant

Assistant style
Automatic sizing

Book of charts

Branch

Branch symbol

Terms shown in italics are defined elsewhere in the Glossary.

Miscellaneous text entered into your chart for the purposes of label-
ing, clarifying, or explaining the elements in your chart.

A box that provides administrative assistance, advice, or even manage-
rial assistance to its manager (sometimes referred to as “staff” boxes).
Some assistants, such as secretaries, provide administrative assistance
only. Other assistants may actually operate in the place of their
managers when the manager isn’t present. Different assistant styles
are available to show the particular type of relationship between the
assistant and its manager. See “Changing assistant styles,” page 113.

A way to represent the assistant-manager relationship graphically.
Assistant styles are available from the Styles menu.

The feature which ensures that the boxes in your chart have uniform
sizes.

A set of charts which, as a whole, present the entire organization or a
substantial portion of it.

The individual charts in a book of charts are stored and maintained as
separate Macintosh documents.

See “Creating books of charts,” page 148, for more information.

A box and all the boxes that report to it.

A little box appearing in the lower right corner of manager boxes. It
indicates that the box has subordinate boxes. You can click the
branch symbol to show or hide the branch. See “Showing/Hiding
branches,” page 150, for more information.
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Chart A graphic representation of an organization; the type of document
that Org Plus creates.

Chart page area The area occupied by the chart. This area consists of a single page or
a number of pages placed side by side to produce a larger rectangular
area. For example:

wrrrrrsres
rrrrrrrrr

\\\\\\ N T N

rrrrrrrrraye

Candystripes show the borders between two adjacent pages.

Org Plus automatically adds and subtracts pages to the chart’s page
area as needed to contain the chart. It preserves the basic page
orientation specified at the Page Setup dialog box.

Co-managers One or more boxes that share responsibility for a group of subordi-
nates. The highlighted boxes in the figure below are co-managers.

You can show the co-manager relationship with the co-manager style
in the Styles menu. See “Creating co-managers,” page 114.

Connecting lines The lines that connect the various boxes in the chart.

Co-workers Boxes with the same manager. Co-workers form a group.

Dotted-line relationship A special reporting relationship between a single box in one group to
its own manager or to the manager of a separate group. A dotted line
usually indicates that the manager has some measure of authority over
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Group

Group style

Label setup

Level

the subordinate, but the exact nature of that authority isn’t usually
indicated in the chart. You can draw dotted-line relationships with
the Connecting Line tool. See “Using the Connecting Line tool,”
page 158 for more information.

All the boxes reporting to the same manager, excluding assistant
boxes. The group is the basic building block of all Org Plus charts. It
consists of co-workers.

The particular arrangement of boxes in a group. Separate groups can
have different group styles. Group styles are located in the Styles
menu. See “Changing group styles,” page 111.

The labels for the information you enter into the boxes in your chart,
and the way those labels are arranged. Different boxes can have
different label setups. See “Changing the label setup” on page 96 for
more information.

The topmost box in your chart is at level 1. The boxes directly
reporting to it are at level 2. The boxes reporting to them are at level
3, and so on. The black boxes in Figure G-1 are at level 4.

Figure G-1. Levels in a chart

Org Plus supports up to 50 levels in a chart.
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Manager A box that has other boxes — its subordinates — reporting to it.

Page lines Lines that show you the location of margins, title areas, and page
borders.
PICT A standard file format for graphic images. Org Plus can copy PICT

images from the Clipboard. It can also paste any visible portion of
your chart to the Clipboard in PICT format. See “Pasting pictures into
your chart,” page 165, and “Copying and pasting between applica-
tions,” page 228.

Stationery A special type of chart containing a basic chart design. Stationery is
like a pad of preprinted charts with empty boxes. When you open a
stationery chart, you “tear off” a standard chart from the pad.

Subgroup A grouping of boxes within a larger group. In the figure below, a, b,
and ¢ belong to the same subgroup; d, e, and f belong to a separate
subgroup. All belong to the same group because they have the same

manager.
| | | ]
[sa ] [b][c] [d]le][f]
Subordinate A box that reports to a manager box.
Topmost box The topmost box in the chart. The head honcho. The big cheese.
Wrapping Allowing a phrase or sentence to split — or “wrap” — from one line

to the next, as opposed to requiring it to fit on a single line. This
paragraph is wrapped across three lines.
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Continuous boxes 1

Eliminate space between boxes to create "continu-
ous box" effects.

I}
m|

Spacing (in inches)

Apply to: O All groups @ Selected groups

’—‘ -@ Distance to manager: 5 - E i

-g] Distance to connecting line: %

[ I l l -g] Horizontal spacing: % %

) Uertical spacing between co-workers: =~ 3 :
Select the group, then choose Spacing from the Boxes [ors 16

9 9 0 i i | hart
menu. Set horizontal spacing to 0.00" at the Spacing [0.60 ] vistance between groups (applies to whole chart

dialog box. See “Changing the distance between RIS

boxes,” page 119, for more information.

Continuous boxes 2

Group styles:

st ai,ajl_;ig

1. Select the connecting line and set it to 2 points (see :&/,
“Changing line thickness and style,” page 132) 5% E g
Bunes E E g

Box Border 4

Box Shadow » ‘EEP/\\L/’A

Sales Regi
¥ : o : . :‘{":{ IEI 2. Select the group and choose the two
ine
ue IaD': ne column group style shown above (see
A / “ : »
Hide Box Changing group styles,” page 111)
8ing 8 4 8
Hide Branch Ipt —— Horthwest | Hortheast
4 pt

Spaclng 80| Spt — Southwest | Southeast Sl Spacing (in inches)
5 v 6Pt e—

llllto lllldth Apply to: O All groups @ Selected groups

Auto Height )

Manual Size... -@] Distance to manager:

@] Distance to connecting line:

3. Select the group and choose Spacing from e8] @ iontalseacing £§ ﬁE
the Boxes menu. Set Horizontal and Vertical
Spacing to 0.00// . See “Cbanging tbe distance -@ Vertical spacing between co-workers: ;’E
between boxes, ”page ]]9, for more informa— -@ Distance between groups (applies to whole chart)
tion. ool
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]
Ll

Manual Sizing (in inches)

Apply to: O All groups @ Selected groups

Height: @
Width: ®

B

o

Extra wide manager boxes
|

i e

1. Select the topmost boxes, then choose Manual Size from the Boxes menu. Set the size for the
topmost boxes at the Manual Sizing dialog box (see “Giving a box a fixed size,” pages 124-125)

Modified co-manager style

The Co-manager style is usually drawn
as shown in Figure B below. You can
make it look like Figure C as follows:

2. Choose the Co-manager
style from the Styles menu

1. Select the co-manager boxes

Group styles:

k| s [ ste | 2=
dza| =@ | g | S
L~ L

NN
SR

Figure A

==
[ || | | | |

L
Figure B
| I |
I I O N
Figure C k

Co- style: chooohn ||

3. Select all four subordinates, choose Spacing
from the Boxes menu, and set the Distance to
manager to 0.00" (see “Changing the distance
between boxes,” page 119)

T
Ll

spacing (in inches) ——————|

Apply to: O ANl groups @ Selected groups

L @ Distance to manager: e’ .
@ Distance to connecting line: _*

[§] Horizontal spacing: g%g or: 5&

[g] Uertical spacing between co-workers: 3 3
]§] Distance between groups (applies to whole chart)
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Figure A Figure B Figure C Modified list style

Becei Seuberling Becei Seuberling Becei Seuberling
Vice President Vice President Vice President To stack names below q box ‘
ey P P Erp—— (Figure C), select Becci's subordi-
. i & nates and give them the list group
Seot Kamins style (Figure A). Select the
G. Van Huisen connecting lines (Figure B) and
: Carol Halter give them a line thickness of
— Seot Kamins - Eeot Kamins Faul Stannard None. Select Becci's subordinates,
o= ¢ VanKuieen =, 3. Van Huisen Hugo Faz choose Spacing from the Boxes
(— CarolXalter - Larol Halter Debbie Hall menu, and set the indicated
— fulSammad - aiSsannan distances to 0.00".
— HUSO Paz :;{ugo Paz

L Debbie Hall @ DL Debbic Hall

Iy

[JI==———————— Spacing (in inches) gl

k Apply to: O ANl groups @ Selected groups
Group styles: g] Distance to manager:
EAEHETIES Gones @ Distance to connecting line: %
d=a| 4| 8 | 8 bonShetew 5
SE % E Line Thigknose 5
Line Style
e s 7] -
Hide Box
LD |j 0 Hide Branch
Assistant styles: Spnclng
E 3? =F=| ¥ Auto Width % %
7=| =7 |=v=| @ Momuel S26... N
Co-manager style: $

Group stules: Dual assistant styles

Figure C

] ] ) ]

Figure B

st | S | St
I I  m— dza| <= | 8 | S
=== TE;J;TI g g | E =
e | | g
ololslol ——"1——+
E‘A\%—y ] ] ) ) ]
T =pe

Co-manager style: c@ﬁ@-

You can create either Figure A or Figure B using Assistant styles. To create Figure C, however, you must
use the 2-column sidearm group style and the sidearm right assistant style, as shown. That's because a
manager's assistants can be drawn in one assistant style only.
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Modified assistant style

Group styles:
Figure A shows an assistant style which doesn't appear in the st | o | St f%
Styles menu. The trick is to make B an assistant to A.
Assistant A is drawn in the Sidearm Right style; Assistant B is =42 | 5 |
drawn in the Top Right style. See “Changing assistant styles,” Sh, % E g
page 113, for more information. — : t j
Assistant styles:
s = -3-| %
| A ] B FTo | ST |TTE R
Co-manager style: -$
Figure A
Multiple topmost boxes [ | | ] | |

A chart can bave as multilple topmost boxes, as
shown in Figure D.

Figure D
1. Create multiple co- 2. Select the topmost group 3. Select the topmost lines and
workers to the topmost and apply the co-manager choose None from the Line Thick-
position (see “Creating and style to them (Figure B) ness submenu (Figure C)

deleting boxes,” page 79)

Figure A Figure B Figure C
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Employees listed by function

The effect shown in Figure A can be created by creating two manager boxes containing the depart-
ment name only, both of them reporting to Chris Phillips, then applying the indicated boxed group
style to their subordinates. See “Creating and deleting boxes,” page 79, and “Changing the label

setup,” page 96.

Styles
Group styles:

==

o | S o o8 | o8

=
E
t
]

Assistant styles:

=Fe
==

.y
.
e
sfEsie
0
[
7=

o |- mu—a—llﬂﬂjflﬂﬂ_g]%

4 |t

Co-manager style: %
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Figure A
=0 Label Setup =|

You can type additional
labels in any dotted area, or
cut & paste to move them.

Labels in chart:
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INDEX

A

Abbreviating names, 143
to save space, 136
About Org Plus command, 180
Actual Size command, 93-94, 201
Adding
annotations, 161, 47
boxes, 80-83
labels (in Tutorial), 43-44
subordinates, 79-82
Adjusting connecting lines, 159
Administrative assistants. See Assistant
Advisory-level positions. See Assistant
Aligning
text, 128
titles, 162-163
All Boxes command, 187
Angle brackets, 100
Annotations
creating, 163-164
defined, 161, 229
miscellaneous text, 163-164
standard title areas, 162-163, 47
in Tutorial, 47-49
Apple menu, 180
Art of charting, 207-209
ASCII, 224
Assistants
converting from, 82
converting to, 82
creating, 79, 81
defined, 113, 229
example of creating, 81
in Tutorial, 25-26
types of, 113
Assistant box tool, 25, 179
Assistant styles, 2, 113, 190
Attach boxes, 26, 116
Attach chart
cutting and pasting between charts, 145-147

Auto Height command, 123, 198
Auto Width command, 123, 197
Automatic

box sizing, 123

formatting, 2

restoring, 126
Automatic sizing

defined, 229

changing, 123-125

restoring, 126

B

Batch printing, 166
Blank rows. See Creating additional label areas
Board of directors, 238
Bold. See also Text
example of, 130
in Tutorial, 46
Book of charts, 148
defined, 229

Border
box, 132, 194-195
chart, 155

Boss. See Topmost box
Box Border command, 132, 194
Box Shadow command, 132, 195
Box tools. See Tools
Boxes
adding, 79-82
around text annotation areas, 164
around the chart, 155
assistant, 229, 79
border of, 132
change style in Tutorial, 40-42
converting from one type to another, 82
creating, 79-82
delete, 84
distance between, 119-122
dragging, 115-116
drawing manually, 155-156

Index
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example of creating, 1, 81

height of, 123-126, 198

hidden, 149-150

justifying text in, 128

lines in, 106

making larger, 123-125

making smaller, 124-125

margins, 107

maximum number of, 219

minimum size of, 124-125

moving
between charts, 145-148
within a chart, 115-118
without subordinates, 116

multiple names in. See Group styles

new, 80-83

rearranging, 110-114

replacing contents of, 118

selecting all, 92

selecting multiple, 89

shadows of, 132

showing, 149-151

size of, 123-126

style, 194-195

text in, 84-86, 127-131

topmost, 232, 24

in Tutorial, 25-31
assistant, 25
co-worker, 28
creating, 25-30
deleting, 34
enlarging, 59
moving, 54-57
subordinate, 26-30

types of, 194-195

width of, 123-126, 197

Branch

defined, 229

hiding, 150-151

moving, 115-116

selecting, 187

showing, 150-151

symbol, 150-151
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C

Capacity. See Limits
Center (text) command, 128, 192
Center Left/Right command, 118, 203
Center Up/Down command, 118, 203
Centering
charts, 118
titles, 162-163
CEO. See Topmost box
Chairman. See Topmost box
Change Label dialog box, 107
Changing
assistant styles, 113
box borders and shadows, 132
in Tutorial, 40-42
box sizes, 123-126
boxes. See Moving boxes
connecting line thickness and style, 132
distance between boxes, 119-122
fonts, 128
group styles, 64-65, 111, 30-32
label setup, 58-59, 96-109, 130-131
in Tutorial, 43-46, 58-59
labels, 107-108
line length, 120
line thickness & style, 132
margins of chart, 172-173
margins within a box, 107
page orientation, 66
people’s name formats, 129
preset options, 169-170
subgroup styles, 112
text 128, 130-131
in Tutorial, 31-33, 40-42, 46, 64-65
Chart
annotating, 161-164
in Tutorial, 47-49
centering on the page, 118
combining, 145-148
creating books of, 148
creating from scratch, 74-75
creating with stationery, 78-79
defined, 229
editing text in, 85
height. See Viewing your chart



making more compact, 132-144
by changing box sizes, 123-126
making narrower, 134-136
making shorter, 137-138
margins, 172-173
maximum reduction of size, 141-142
moving, 118
moving around in, 93-95
moving boxes between, 145-148
multiple, 145-148
number of pages in, 139
opening, 181, (in tutorial) 38-39
pad of charts. See Stationery
page area, 230
preview, 93-96
printing, 166
reducing size of, 132-144
(in Tutorial), 63-70
samples, 12-13
saving a, 183
starting, 74-79
stationery, 78-79
titles, 162
trading off between width and height, 132-144
updating (in Tutorial), 51-70
width. See Viewing your chart
window, 177-178
Chart level
defined, 231
maximum in a chart, 219
selecting boxes at the same level, 91-92
Chart-making tips, 207-209
Chart page area, 152
Chart titles, 162-163
Clear command, 187
Clipboard
cut and paste between applications, 165, 228
cut and paste between charts, 145
cut and paste to move boxes, 115
Close command, 183
Colleague. See Co-worker
Co-manager style, 114
Co-managers, 114, 190
defined, 230
Combining separate pieces of information, 100

Combining subgroups, 112-113
Command, choosing from a submenu, 41
Command-H (for “Help”), 14
Command-? (for “help pointer”), 15
Commands

50% of Actual, 201

Actual Size, 201

Auto Height, 198

Auto Width, 197

Box Border, 194

Box Shadow, 195

Center, 192

Center Left/Right, 203

Center Up/Down, 203

Clear, 187

Close, 183

Copy, 186

Copy Setup, 186-187

Cut, 186

Font, 191

Label Setup, 188-189

in Tutorial, 43

Left, 192

Line Style, 196

Line Thickness, 195

Make Fit, 139-141

in Tutorial, 67-70

Manual Size, 198

Name, 193

New, 181

Open, 182

Other, 192

Page Setup, 185

Paste, 187

Points. See Text sizes

Preferences, 189

Print, 185

Quit, 185

Revert to Saved, 184

Right, 192

Save, 183

Save As, 183

Save Stationery, 184

Select, 187

Select Levels, 188
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Show/Hide
Box, 196
Branch, 196
Draw Tools, 203
Edit Panel, 202
Page Lines, 202
Symbols, 203
Size-Window, 201
in Tutorial, 30
Spacing, 197
Style, 191
Undo, 186
Untitled (as name of chart), 199
Word Wrap, 193
Company logo, 4, 165, 228
Computer requirements, 7-8, 219
Concatenating text. See Merging
Condense chart. See Fitting chart on one page
Connecting Line tool, 158
Connecting lines
adjusting, 159-160
changing length of, 120
drawing, 158-160
defined, 230
showing/hiding, 151
thickness and style, 132
Converting boxes from one type-to another, 82
Copy command, 186
Copy machine
reducing chart image on, 142
Copy protection, 9
Copy Setup command, 186-187
Copying
between applications, 228
between charts, 145-146
label setup to other boxes, 109
Org Plus diskettes, 9, 11
Corners of boxes
text on. See Changing Label Setup
Co-worker
box tool (in Tutorial), 28
creating, 80
defined, 230
Co-worker After tool, 178
Co-worker Before tool, 178

Creating
additional label areas, 100-101
any type of box, 80-81
assistant box
in Tutorial, 25
books of charts, 148
boxes, 79, 21
alternative ways, 83
in Tutorial, 25-31
multiple at the same time, 81-82
chart, 74-78, 1, 22
faster and easier, 211-213
from scratch, 74-75
tips and suggestions, 207-209
in Tutorial, 21-72
using a predefined label setup, 75-76
using stationery, 78-79
with your own label setup, 76-77
co-managers, 114, 190
co-worker boxes (in Tutorial), 28
custom group style, 149
departments. See Subgroup
dividing lines, 106
label areas, 100
label setup, 76-77
labels, 100
lines, 195-196, 21
stationery, 167-168
subgroups, 111-112
in Tutorial, 61-63
subordinate boxes (in Tutorial), 26-30
text areas for annotations, 163-164
titles, 49, 162-163
workgroups. See Group
Cursor keys. See Keyboard and mouse shortcuts
Custom group styles, 149
Custom touches, 4
Customer assistance. See Help
Customizing Org Plus, 167-173
Cut and paste
between charts, 145-148
boxes, 117, 56
labels. See Moving Labels
Cut command, 186



D

Deleting
boxes, 80, 84
in Tutorial, 22, 34
label areas, 102
labels, 77, 107-108
lines, 22
Diagonal line tool, 157
Dialog box
Change Label, 107
Label Setup, 98
Make Fit, 139
Make Fit Options, 142
Match Information, 146
New Chart, 75, 23
Personalized Copy, 17
Preferences, 170-171
Select Levels, 91
Spacing, 119
Startup, 74, 18, 23
Disk
copying Org Plus from, 9-13
what should be on Org Plus, 12
Disk drive, 10
Distance
between boxes, 119-122
between group and manager
increase to save space, 135
Divider buttons, 106-107, 45
Dotted line relationship
defined, 230
Dragging
boxes, 115-116
changing distances between boxes by, 120-
122
groups down, 135
margins, 172-173
in Tutorial, 54-56
multiple labels, 147
Drawing. See also Tools
boxes manually, 155-156
displaying the drawing tools, 154
lines manually, 156-160

E

Edit menu, 186-189
Edit panel, 212-213, 86-87
Editing
existing information, 85
information not shown in the chart, 86
labels, 107
people’s names, 86
shortcuts, 85
text, 85
Employee. See Boxes
Enlarging
boxes, 124-125, 100-101
in Tutorial, 59
text, 128
Entering
new information, 84, 24
people’s names, 86, 108-109
in Tutorial, 47, 59-60
Erasing. See Deleting
Examples of organization charts, 12-13
Exchanging data
with Org Plus for IBM, 221-224
with other applications as text files, 224-227
Exiting Org Plus, 185, 36
Export data from Org Plus
as a text document, 227
to Org Plus for IBM, 223
with the clipboard, 228

F

50% of Actual command, 93-94, 201
Field names. See Label Setup
File menu, 181-185
Fired employee. See Deleting boxes
Fitting chart on one page, 132-144
Fixed box size, 124 -125
Floppy disks
installation on, 10
Font command, 191
Fonts
effect on chart size, 138
changing style and size, 128, 144
selecting, 128
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Footnotes. See Annotations
Formatting people’s names, 108, 129

G

Geneva 9, 10, and 12 point fonts, 21, 69
Getting
charts. See Opening charts
help, 14
on-line help, 14
started, 7
Group styles
changing, 31, 111
defined, 231
effect on the size of your chart, 134, 137
for subgroups, 111
selecting, 111
Groups
adding co-workers to, 30
adding to chart, 79-84
creating, 79-84
defined, 231
moving to or between, 93-95
offsetting, 134-135
rearranging, 110-111
selecting, 90, 92, 187
in Tutorial, 31-33, 64-65
Guidelines for chart making, 207-209

H

Hairline
box borders, 132
defined, 132
lines, 195
Hard disk
installing on, 9
Hardware requirements, 7-8, 219
Height
of boxes, 123-126
of chart. See Viewing your chart
Help
Banner Blue Technical Support, 7
customer assistance, 15
Hot line, 7
menu, 14-15

messages, 15
on-line help, 14, 204
installing on floppy disk, 12
using, 14-15

Help Topics command, 14, 204
Hidden boxes, 149-150
Hidden information in your chart, 86
Hide Box command, 149, 196
Hide Branch command, 150, 196
Hide Draw Tools command, 203
Hide Edit Panel command, 202
Hide Label, 104
Hide Page Lines command, 152, 202
Hide Symbols command, 203
Hiding

boxes, 149-150

branches, 150-151

connecting lines, 151

draw tools, 154

edit panel, 212, 86-87

labels, 104

page lines, 152

symbols, 203

I

IBM documents with Org Plus, 221-224
Importing data into Org Plus

as a text document, 224-227

from Org Plus for IBM, 221-224

with the clipboard, 228
Information

editing, 85

entering, 84

in Tutorial, 47, 59-60

Seeing and editing hidden, 86
Inserting. See also Adding

boxes, 80-83

managers, 82
Installing Org Plus

on hard disk, 9-10

on 800K disks, 8, 10-12
Introduction to Org Plus, 1
Italics. See also Text

example of, 130



J

Joining. See Merging
Justifying text. See Aligning Text

K

Keyboard shortcuts, 92, 95, 215-218
creating boxes, 215
entering information, 215
file operations, 218
making dialog box selections, 217
modifier keys with the mouse, 218
selecting/editing boxes, 217
viewing your chart, 216

L

Label area buttons, 101
Label areas, 43-44, 98, 100-101
deleting, 102
Label list, 98
Label Setup
changing, 96-109, 130-131
copying, 109
create your own, 76-77
defined, 231, 96, 43, 75
in Tutorial, 43-46, 58-59
use a predefined, 75
with multiple columns or rows, 101
Label Setup command, 188-189
Label Setup dialog box, 98, 43
Labels
adding, 100, 96, 44, 76-77
creating, 100, 96, 76-77
customizing, 107-108, 130-131
deleting, 108, 77
dragging multiple, 147
moving, 102-103
moving hidden labels back into setup, 104
predefined, 75-76
removing from label setup, 104
renaming, 108
showing/hiding, 104, 109
in Tutorial, 43-44
Landscape. See Page Setup command
Laser printer margins, 173

Learning Org Plus, 21-72
Left (justify text) command, 128, 192
Legend, 4, 163-164
Length
of chart (height). See Viewing your chart
of information items, 219
of lines, 119-120
Level
defined, 231
selecting, 91
Levels
chart. See Chart level
maximum number of, 219
Limits, program, 219
Line Style command, 132, 192
Line Thickness command, 132, 151, 195
Lines
connecting, 120
custom drawn, 156-160
dividing a box, 106-107
drawing, 79, 81 156-160
in a box, 106-107
none, 151
page, 152
showing/hiding, 151
showing/hiding page, 152
thickness and style, 132
Logo, 165

M

Macintosh Plus, 7
Macintosh SE, 7
Macintosh II, 7
Magnifier, 94
in Tutorial, 40
Make Fit command, 132, 139-141, 67-70, 199-200
in Tutorial, 67-70
using, 139-144
Make Fit dialog box, 139
Make Fit options, 142-144
Make Fit Options dialog box, 142
Making
boxes as small as possible, 124
boxes equal height, 123
boxes equal width, 123
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boxes narrower, 124

boxes shorter, 124

chart compact, 132-144

chart fit on one page (in Tutorial), 63-72

chart narrower, 134-136

chart shorter, 137-138
Manager. See also Topmost box

defined, 231

inserting, 82

selecting, 187

two or more for one department, 114

two or more topmost, 114
Manager box tool, 179
Manual Size command, 124-125, 198
Manual (User’s Guide) summary, 5
Margins, changing

in a box, 107

in a chart, 144, 172-173, 31, 68
Match information, 146-148
Match Information dialog box, 146
Matching

labels between charts, 146-148
Maximum

box size, 219

boxes per chart, 219

boxes per group, 219

characters per box, 219

characters per items of information, 219

chart size, 219

charts open at one time, 219

number of labels, 219

number of levels, 219

reduction of chart size, 141
Memory requirements, 219
Menu commands. See Commands
Menus

Apple, 180

Boxes, 194-198

Charts, 199-203

Edit, 186-189

File, 181-185

Help, 204

Styles, 190

Text, 191-193
Merging
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subgroups, 112-113
text values, 100
Minimum
box size, 124-125, 219
margins, 144, 68
requirements for using Org Plus, 7, 219
Moving
around chart, 95, 93
between groups, 93-95
boxes
within a chart, 115-118
between charts, 145-148
branches, 115-116
employees. See Moving boxes
hidden labels back into setup, 104
information between Org Plus and other
programs, 221-228
keyboard shortcuts for, 215-218
labels, 102-103
left, right, up, or down, 95
positions. See Moving boxes
scattered boxes under a single manager, 117
text, 129
the chart, 118
in Tutorial, 54-57
Multiple
charts, 145-148
columns or rows in label setups, 101
topmost managers, 114

N

Name command, 108, 193
Name label, 108, 24
Names
abbreviating, 143
entering, 86
formatting, 108-109, 129
New Chart dialog box, 75
New command, 181
New Labels Setup dialog box, 76
None box border, 194
None box shadow, 195
None line thickness, 195

Notes. See Annotations



(§) Paste command, 187

On-line help, 14-15, 12, 180, 204 Pasting pictures into your chart, 165
Peer. See Co-worker

See also Help i

Open command, 182 People’s names

Opening entermg, 86
charts, 182, 38-39 formatting, 10§, 129
Org Plus for IBM documents, 221-222 Percent of actual size, 94, 30

Perpendicular line tool, 156-157,

stationery, 168 )
Personalize Org Plus, 17

text documents, 224-227

Operating limitations, 219 PICT in?ages
Org Plus defined, 232
help, 12-13 copying to clipboard, 228
Help & Learning disk, 10, 12 pasting into Org Plus, 165, 228
icons, 12-13 Portrait orientation. See Page Setup command

Position. See Boxes

installing, 7-1 .
: Predefined label setup, 75

limits, 219

Program disk, 9, 10, 11 Preferences CQmmand, 189
Readme, 12-13 Preferencgs dialog box, 170-171
starting, 17 Preset options

changing, 169-171

Preferences dialog box, 170-171
President. See Topmost box
Preview chart, 152
Print command, 185

version 1.0, 12-13

working copy of, 9
Organization chart

examples, 12-13
Orientation

changing (in Tutorial), 66 Printing ”
Other (text sizes) command, 192 §harts, 1 . o
Overlap printing, 170-171 rom the finder, 1
labels, 109

Overlapping boxes, 15
BIER Bt g landscape. See Page Setup command

multiple charts, 166

P orientation. See Page Setup command
8 p
Package contents, 8 overlap between pages, 170-171
Page border line, 30 . page lines never print, 152
Page b.reaks. See Page lines portrait. See Page Setup command
Page lines preview chart before, 152, 203
defined, 232
non-printing, 152 Q

showing/hiding, 152
Page orientation

changing (in Tutorial), 66
Page Setup command, 185

Queuing documents. See Printing, multiple charts
Quit command, 185

to reduce chart size, 141-142 R
Page Setup dialog box, 185 RAM. See Memory
Paper Readme, 13
setting size. See Page Setup command Rearranging. See also Moving boxes
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boxes, 110-114

information. See Label Setup
Rectangle tool

using, 155-156
Reduce/Enlarge tool, 94, 179

in Tutorial, 40
Reducing

boxes, 124

chart image on a copy machine, 142

chart image on a printer

chart size, 132-144

in Tutorial, 63-70

text size, 144
Registration card, 8
Removing

box, line, or other unwanted object, 89

dividing lines, 106

labels from setup, 104

positions. See Deleting boxes
Renaming labels, 107-108
Reorganization. See Moving boxes

See also Deleting boxes
Replacing box contents, 118
Requirements for Org Plus, 7-8
Retrieving charts. See Opening charts
Revert to Saved command, 184
Right (justify text) command, 128, 192

S

Sample charts, 12-13
Save As command, 183-184
Save command, 183
Save space, 132-144
by changing box sizes, 123-126
Save Stationery command, 184
Saving
as Org Plus for IBM, 223-224
as stationery, 184
as text document, 227
your chart, 183
Secretaries. See Assistant
Seeing any box in your chart, 94
Seeing your chart at different sizes, 93
Select command, 187
Select Levels command, 91-92, 188

250 Index

Select Levels dialog box, 91
Selecting
a box, 149
a branch, 90
a group, 90
a single object, 89
all boxes, 88, 92
all boxes at the same level, 91
all objects of the same type, 90
keyboard shortcuts for, 92
Make Fit options, 142-144
multiple objects, 89
Selection Arrow tool, 178
Shadows for boxes, 132
Shift click (defined), 88
Shifting horizontal groups-save space, 134-135
Shortcuts
creating boxes, 215
editing, 85
entering information, 215, 212
file operations, 218
keyboard and mouse, 215-218
making charts faster and easier, 211-213
making dialog box selections, 217
modifier keys with the mouse, 218
moving around in your chart, 95
selecting/editing boxes, 92, 217
viewing your chart, 216
Show Box command, 196
Show Branch command, 150-151, 196
Show Draw Tools command, 154, 203
Show Edit Panel command, 202, 212
Show Label command, 104
Show Page Lines command, 152, 202
Show Symbols command, 203
Showing
boxes, 149-150
branches, 150-151
connecting lines, 151
draw tools, 154
edit panel, 212, 86-87, 202
labels, 104, 109
page lines, 152
symbols, 203
Shrinking. See Fitting chart on one page



Siblings. See Co-worker
Sideways printing. See Page Setup command
Size
limits, 219
of annotation areas, 163-164
of boxes, 123-126
minimum, 124
of chart. See Viewing your chart
of paper. See Page Setup command
of text, 128, 144
in Tutorial, 48, 68
Size to Window command, 93-94, 201
in Tutorial, 30
Skills required, 7
for tutorial, 21
Skip a level. See Hidden boxes
Sophisticated charting, 207-209
Spacing command, 119-120, 197
Spacing dialog box, 119
Special effects
through manual drawing, 153-160
through showing and hiding, 149-152
Specifications, 219
Splitting text across lines, 128-129
Staff Level. See Assistant
Starting
a chart, 74-77, (in Tutorial) 22-24
Org Plus, 17-18
stationery, 78-79
Startup dialog box, 18, 74
Stationery
books of charts, 148
creating, 167-168
defined, 232
folder, 13
multiple charts, 148
opening, 168
saving as, 183-184
using, 78-79
Status area, 177-178
Style command, 191
Styles, changing. See Changing
Styles menu, 190
Subgroup
changing styles, 112

creating, 111-112
defined, 232
merging, 112-113
in Tutorial, 61-63
Submenus
Box Border, 194
Box Shadow, 195
Font, 191
Line Thickness, 195
Line Style, 196
making choices from, 41
Name, 193
Select, 187
Style, 191
Subordinate box tool, 178, 179
in Tutorial, 26-30
Subordinates
adding. See Adding boxes
defined, 232
maximum number of, 219
of cut boxes automatically promoted, 117
selecting, 187
Summary of manual, 5
Symbol
branch, 150-151
show command, 203
System requirements, 219, 7-8

T

Teach Text, 12-13
Technical support, 15, 7
Telephone at Banner Blue, 7
Template. See Stationery
Terminate employee. See Deleting boxes
Text
abbreviating. See Abbreviating names
alignment, 128
bold, 128
changing, 128, 131
documents, 224-227
editing, 85
entering, 84-85
labels. See Label Setup
menu, 193, 46
moving, 102
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on corners of box. See Label Setup
size in Tutorial, 48, 68
sizes, 191-192
style in Tutorial, 46
wrapping across lines, 128-129, 143
Text tool, 178
Time saving measures, 211-213
Tips on making charts, 207-209
Titles and Title areas, 162-163, 24
Tool palette, 178-179
Tools
Assistant box, 179
Connecting line, 158-160
Co-worker After box, 179
Co-worker Before box, 179
Diagonal line, 157
drawing, 154-160
Manager box, 179
Perpendicular line, 156-157
Rectangle, 155-156
Reduce/Enlarge, 94
Selection Arrow, 178
Subordinate box, 179
Text, 178
Topmost box, 91, 232
Trading off between chart width and height, 132
Tree diagram, 1
Troubleshooting, 15
Tutorial
adding label to setup, 43-44
annotating the chart, 47-49
change box style, 40-42
changing label setup, 43-46, 58-59
changing page orientation, 66
choosing text size, 48, 68
choosing text style, 46
creating a chart, 21-72
creating assistant boxes, 25-26
creating boxes, 25-30
creating co-worker boxes, 28
creating subgroups, 61-63
creating subordinate boxes, 26-27, 29
delete boxes, 34
enlarging boxes, 59
entering information, 47, 59-60
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magnify the chart, 40
Make Fit command, 67-70
moving boxes, 54-57
reducing chart size, 63-70
Size to Window command, 30
updating a chart, 51-71

Two 800K drive system
installing on, 10-13
starting, 17-18

Two or more managers for one department.
See Co-managers

U

Underlining. See Changing text ]
Undo command, 186
Untitled command (as name of chart), 199
Updates, 8
Updating, 3
in Tutorial, 51-71
Upgrades, 8
Using
Connecting line tool, 158-160
Diagonal line tool, 157
Magnifier, 94
Make Fit command, 139-144
Perpendicular line tool, 156-157
Rectangle tool, 155-156
Reduce/Enlarge tool, 94
Spacing dialog box, 119-120
Stationery, 78-79
Using Org Plus, 73
Using Org Plus with other applications, 221-228
copying/pasting between applications, 228
opening Org Plus for IBM files, 221-222
opening text documents (importing), 224-227
saving as Org Plus for IBM file, 223-224
saving as text documents, 227

\%
Viewing your chart, 93-95, 216

W

Width
of boxes, 123-126



of chart. See Viewing your chart
Window, Chart, 177-178
Word Wrap command, 128-129, 193
Work group. See Group
Working copy of Org Plus, 9
Wrapping text across lines, 128-129, 143, 232
Write protect tabs, 9

Z
Zoom box, 196

Index
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Org Plus™ for Macintosh' makes professional
organization charts automatically.

r &€ File Edit Styles Text Boxes Chart Help
ED%

If you make organization charts with a draw or presen-
tation program, you know there must be a better way.
Now, Org Plus is your solution for quick, professional
organization charts.

Fast chart creation—no drawing required

Simply select a box tool at the top of the window and
click on the chart to add boxes. Org Plus automatically
draws and spaces the boxes and precisely lays out the
connecting lines. Then type in names, titles, and other
information. Org Plus automatically expands or shrinks
boxes to fit. Choose from over 50 different chart, box,
and line styles to get exactly the look you want.

Compact charts show lots of information
You also want your chart to be as compact as possible—
preferably on one page. Org Plus makes it easy. 1. Select the boxes you want to reformat.
Change the arrangement of your chart with a couple
mouse clicks. Or, use the unique Make Fit command to
apply a number of space-saving features automatically.
Just tell Org Plus how big you want the chart to be.
Updating charts is a snap
Even simple updates can cause a chain reaction that
drastically changes the entire chart. For example,
merely choosing a larger font may require all boxes to
grow in size and change location. Org Plus maintains a
uniform box size and even spacing automatically, no
matter what changes you make! The time savings are
tremendous. Professional appearance is guaranteed.
Easily update charts to keep pace with changing
organizations. With a few mouse clicks, you can add,
insert, delete, or move boxes —even entire departments.
Org Plus does the redrawing for you. And you always
see exactly what the chart will look like when printed!

Personalize, customize your charts

Add your company logo, type notations anywhere

in your chart, or change the way Org Plus draws some-
thing. A complete set of drawing tools lets you get any
special effects you can’t get automatically.

Easy to use and FREE support .
On-line help. Simple step-by-step instructions. 3. Org Plus redraws your chart automatically.
Extensive word index plus a unique picture index. Free 2K

: y 4. Fityour charton
technical support by phone and FAX. a dosired number of

Org Plus is ideal for cqmpanies that use both.Apple prages with the Make Dl Names: & Minimum margins
and IBM hardware. It easily exchanges information Fit command, Org Plus || 2% 2z _=]

with the #1 selling IBM PC organization chart maker, automatically applies | =yt e

Down by 3

Org Plus Advanced. a number of space- upby 1

. U
saving features. Upby s

i System Requirements
Macintosh Plus (with 2 drives), SE, and Macintosh II series computers.
Requires System v4.1 and Finder v6.0. MultiFinder compatible.

© Copyright 1990 Banner Blue Software Incorporated. All rights reserved. Macintosh is

FOI' Maci nto Sh e aregistered trademark of Apple Computer, Inc. Manufactured in the U.S. 3

Banner Blue, PO. Box 7865, Fremont, CA 94537 415-794-6850

Allen Manufacturing
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Group styles:

ﬁ 2. Choose the style you &
want from the Styles
menu.
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